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1—Safety information 
Connect the power cord to a properly grounded electrical outlet that is near the product and easily 
accessible. 

Do not place or use this product near water or wet locations. 

 CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or 
performance of procedures other than those specified herein may result in hazardous radiation exposure. 

This product uses a printing process that heats the print media, and the heat may cause the media to 
release emissions. You must understand the section in your operating instructions that discusses the 
guidelines for selecting print media to avoid the possibility of harmful emissions. 

 CAUTION—POTENTIAL INJURY:  The lithium battery in this product is not intended to be 
replaced. There is a danger of explosion if a lithium battery is incorrectly replaced. Do not recharge, 
disassemble, or incinerate a lithium battery. Discard used lithium batteries according to the 
manufacturer's instructions and local regulations. 

 CAUTION—POTENTIAL INJURY:  Before moving the printer, follow these guidelines to avoid 
personal injury or printer damage: 

• Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet. 

• Disconnect all cords and cables from the printer before moving it. 

• If an optional tray is installed, then remove it from the printer. To remove the optional tray, slide the 
latch on the right side of the tray toward the front of the tray until it clicks into place. 

• Use the handholds located on both sides of the printer to lift it. 

• Make sure your fingers are not under the printer when you set it down. 

• Before setting up the printer, make sure there is adequate clearance around it. 

Use only the power cord provided with this product or the manufacturer's authorized replacement. 

 CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from 
a hot component, allow the surface to cool before touching. 

 CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional 
hardware or memory devices sometime after setting up the printer, then turn the printer off, and unplug 
the power cord from the electrical outlet before continuing. If you have any other devices attached to the 
printer, then turn them off as well, and unplug any cables going into the printer. 

 CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and 
telephone system connections) are properly installed in their marked plug-in ports. 

This product is designed, tested, and approved to meet strict global safety standards with the use of 
specific manufacturer's components. The safety features of some parts may not always be obvious. The 
manufacturer is not responsible for the use of other replacement parts. 
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 CAUTION—POTENTIAL INJURY:  Do not cut, twist, bind, crush, or place heavy objects on the 
power cord. Do not subject the power cord to abrasion or stress. Do not pinch the power cord between 
objects such as furniture and walls. If any of these things happen, a risk of fire or electrical shock results. 
Inspect the power cord regularly for signs of such problems. Remove the power cord from the electrical 
outlet before inspecting it. 

Refer service or repairs, other than those described in the user documentation, to a service 
representative. 

 CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the 
printer, unplug the power cord from the electrical outlet and disconnect all cables from the printer before 
proceeding. 

 CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray 
separately. Keep all other trays closed until needed. 

 CAUTION—SHOCK HAZARD: Do not set up this product or make any electrical or cabling 
connections, such as the fax feature, power cord, or telephone, during a lightning storm. 

SAVE THESE INSTRUCTIONS. 
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■ Warning and Caution Symbols 

The labels and symbols used in this manual and on the printer help prevent injury to the 
operator and others around the printer as well as damage to property. Those labels and 
symbols have the following meanings: 

 WARNING 
Ignoring this warning could cause serious injury or even death. 

 CAUTION
 

Ignoring this caution could cause injury or damage to property. 

 

●Meaning of Symbols 

 
 indicates a danger against which you should take precaution. 

The symbol shown to the left warns against possible electrical shock. 

 
 indicates a prohibited course of action. 

The symbol shown to the left warns against dismantling the device.  

 

 
 indicates an imperative course of action. 

The symbol shown to the left indicates that you must unplug the device. 
 

 WARNING 

 
• Do not attempt to remove any of the covers and panels attached to the printer. Some printers 

have a high-voltage part or a laser beam source inside that could cause an electrical shock or 
blindness. 

• Do not modify the printer, as a fire, electrical shock, or breakdown could result. If the printer 
employs a laser, the laser beam source could cause blindness. 

 
• Use only the power cord supplied in the package. If a power cord is not supplied, use only the 

power cord and plug that are specified in the user documentation. Failure to use this cord could 
result in a fire or electrical shock. 

• Use the power cord supplied in the package only with this printer; NEVER use it for another 
product. Failure to observe this precaution could result in a fire or electrical shock.   

• Use only a power source of the specified voltage. Failure to do that could result in a fire or 
electrical shock. 

 
• Do not use a multiple outlet adapter to connect any other products. Exceeding the rating of a 

power outlet could result in a fire or electrical shock. 
• Do not use an extension cord, as this could cause a fire or electrical shock. Contact your 

authorized service provider if an extension cord is required. 
• Do not scratch, rub, place a heavy object on, heat, twist, bend, pull on, or damage the power 

cord. Use of a damaged power cord (exposed core wire, broken wire, etc.) could result in a fire 
or breakdown. Should any of the described conditions have occurred, immediately turn off and 
unplug the printer, and then call your authorized service provider. 

 Do not unplug and plug in the power cord with wet hands, as an electrical shock could result. 

 
Plug the power cord all the way into the power outlet. Failure to do this could result in a fire or 
electrical shock. 
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WARNING 

 
Connect the power cord to an electrical outlet that is equipped with a grounding terminal. 

 

Do not place metal clips, any other small metallic objects, or a container containing liquid on 
the printer. Liquid and metallic objects dropped inside the printer could result in a fire, electrical 
shock, or breakdown. 
Should liquid, a piece of metal, or any other foreign matter fall inside the printer, immediately 
turn off and unplug the printer, and then call your authorized service provider. 

 
• Do not use your printer if it becomes excessively hot, emits smoke or an unusual odor, or 

makes an unusual noise. Immediately turn off and unplug the printer, and then call your 
authorized service provider. If you continue using the printer, a fire or electrical shock could 
result. 

• Do not use this printer if it has been dropped or the cover has been damaged. Immediately turn 
off and unplug the printer, and then call your authorized service provider. If you continue using 
the printer, a fire or electrical shock could result. 

 

Do not burn toner cartridges or toner. The hot toner may scatter and cause burns or other 
damage. 

 

CAUTION 

 

• Do not expose the printer to dust, soot, or steam, or place it near a kitchen table, bath, or 
humidifier. A fire, electrical shock, or breakdown could result. 

• Do not place the printer on an unstable or tilted table, or in a location subject to a lot of 
vibration and shock. The printer could fall, causing personal injury or mechanical breakdown. 

 

After installing this product, place it on a sturdy base. It the printer moves or falls, it may cause 
personal injury. 

 

Certain areas inside the printer may become very hot and cause burns. 
When checking the inside of the printer for malfunctions such as media jams, do not touch the 
locations (around the fusing unit, etc.) labeled “Caution HOT.” 

 

• Do not obstruct the printer’s ventilation grilles. Heat could accumulate inside the printer, 
resulting in a fire or malfunction. 

• Do not use flammable sprays, liquids, or gases near the printer, as a fire could result. 

 

• Do not pull on the power cord when unplugging it. Pulling on the power cord could damage it, 
resulting in a fire or electrical shock. 

• Do not place any objects around the power plug, as it may be difficult to unplug when an 
emergency occurs. 

 

• Do not store toner cartridges and PC drum units near computer disks or watches that are 
susceptible to magnetism, as they could cause them to malfunction. 

• Do not leave toner cartridges or PC drum units within reach of children. Ingesting toner could 
be harmful to your health. 

 

• Whenever moving the printer, be sure to disconnect the power cord and other cables. Failure 
to do this could damage the cord or cable, resulting in a fire, electrical shock, or breakdown. 

• Unplug the printer if you are not going to use it for a long period of time. 

 
• When moving the printer, always hold it as specified in the user documentation. If the printer 

falls, it may cause severe personal injury and/or be damaged. 
• Use the printer only in a well-ventilated location. Operating the printer in a poorly ventilated 

room for an extended period of time could be harmful to your health. Ventilate the room at 
regular intervals. 

• Remove the power cord from the outlet more than once a year and clean between the plug 
terminals. Dust that accumulates between the plug terminals may cause a fire. 
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2—Learning about the printer 

Finding information about the printer 

What are you looking for? Find it here 

Initial setup instructions: 

• Connecting the printer 

• Installing the printer software 

Setup documentation—The setup documentation 
came with the printer. 

Additional setup and instructions for using the printer: 

• Selecting and storing paper and specialty media 

• Loading paper 

• Configuring printer settings 

• Viewing and printing documents and photos 

• Setting up and using the printer software 

• Configuring the printer on a network 

• Caring for and maintaining the printer 

• Troubleshooting and solving problems 

User's Guide and Quick Reference Guide—The 
guides are available on the Printer Driver and 
Documentations CD. 

Instructions for: 

• Connecting the printer to an Ethernet network 

• Troubleshooting printer connection problems 

Networking Guide—Insert the Printer Driver and 
Documentations CD, and then click Documentation 
on the CD menu. On the left navigation pane, click 
User's Guide and other publications, and then 
click Networking Guide. 

The latest supplemental information, updates, and technical 
support: 

• Documentation 

• Driver downloads 

KONICA MINOLTA Support Web site— 
http://www.konicaminolta.com 

Note: Record the following information (located on 
the store receipt and at the back of the printer), and 
have it ready when you contact technical support so 
that they may serve you faster: 

• Machine Type number 

• Serial number 

• Date purchased 

• Store where purchased 

Warranty information Warranty information varies by country or region. 

http://www.konicaminolta.com/
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Selecting a location for the printer 

When selecting a location for the printer, leave enough room to open trays, covers, and doors. If you plan 
to install any options, then leave enough room for them also. It is important to: 

• Set up the printer near a properly grounded and easily accessible electrical outlet. 

• Make sure airflow in the room meets the latest revision of the ASHRAE 62 standard or the CEN 
Technical Committee 156 standard. 

• Provide a flat, sturdy, and stable surface. 

• Keep the printer: 

- Clean, dry, and free of dust. 

- Away from stray staples and paper clips. 

- Away from the direct airflow of air conditioners, heaters, or ventilators. 

- Free from direct sunlight and humidity extremes. 

• Observe the recommended temperatures and avoid fluctuations. 

Ambient temperature 15.6 to 32.2°C (60 to 90°F) 

Storage temperature -20 to 40°C (-4 to 104°F) 
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1 Right side 110 mm (4.33 in.) 

2 Front 305 mm (12 in.) 

3 Left side 65 mm (2.56 in.) 

4 Rear 100 mm (3.94 in.) 

5 Top 305 mm (12 in.) 
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3—Additional printer setup 

Installing internal options 

 CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional 
hardware or memory devices sometime after setting up the printer, then turn the printer off, and unplug 
the power cord from the electrical outlet before continuing. If you have other devices attached to the 
printer, then turn them off as well, and unplug any cables going into the printer. 

Warning—Potential Damage: Controller board electronic components are easily damaged by static 
electricity. Touch a metal surface on the printer before touching any controller board electronic 
components or connectors. 

Available internal options 

• DDR3 DIMM 

• Flash memory 

- Fonts 

- Firmware 

• Forms Barcode 

• IPDS 

Accessing the controller board 

Access the controller board to install internal options. 

See Accessing the controller board. 
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Installing an optional card 

 CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional 
hardware or memory devices sometime after setting up the printer, then turn the printer off, and unplug 
the power cord from the electrical outlet before continuing. If you have other devices attached to the 
printer, then turn them off as well, and unplug any cables going into the printer. 

Warning—Potential Damage: Controller board electronic components are easily damaged by static 
electricity. Touch a metal surface on the printer before touching any controller board electronic 
components or connectors. 

1. Access the controller board. 

See Accessing the controller board. 

2. Unpack the optional card. 

Warning—Potential Damage: Avoid touching the connection points along the edge of the card. 

3. Holding the card by its sides, align the plastic pins (1) on the card with the holes (2) on the controller 
board. 
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4. Push the card firmly into place as shown in the illustration. 

 

Warning—Potential Damage: Improper installation of the card may cause damage to the card and 
the controller board. 

Note: The entire length of the connector on the card must touch and be flushed against the controller 
board. 

5. Close the controller board access door. 

Note: When the printer software and any hardware options are installed, you may need to manually add 
the options in the printer driver to make them available for print jobs. 
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Installing a memory card 

 CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional 
hardware or memory devices sometime after setting up the printer, then turn the printer off, and unplug 
the power cord from the electrical outlet before continuing. If you have any other devices attached to the 
printer, then turn them off as well, and unplug any cables going into the printer. 

Warning—Potential Damage: Controller board electronic components are easily damaged by static 
electricity. Touch something metal on the printer before touching any controller board electronic 
components or connectors. 

An optional memory card can be purchased separately and attached to the controller board. 

1. Access the controller board. 

See Accessing the controller board. 

2. Unpack the memory card. 

Warning—Potential Damage: Do not touch the connection points along the edge of the card. Doing 
so may cause damage. 

3. Align the notch (1) on the memory card with the ridge (2) on the connector. 
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4. Push the memory card straight into the connector and forward into the controller board wall until it 
clicks into place. 

 

5. Close the controller board access door. 

Note: When the printer software and any hardware options are installed, you may need to manually add 
the options in the printer driver to make them available for print jobs. 
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Installing hardware options 

Installing optional trays 

 CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional 
hardware or memory devices sometime after setting up the printer, then turn the printer off, and unplug 
the power cord from the electrical outlet before continuing. If you have any other devices attached to the 
printer, then turn them off as well, and unplug any cables going into the printer. 

1. Turn off the printer using the power switch, and then unplug the power cord from the electrical outlet. 

      

 

  

 

  

2. Unpack the tray, and then remove all packing materials. 

3. Pull the tray completely out of the base. 

 

4. Remove any packing material from inside the tray. 

5. Insert the tray into the base. 

6. Place the tray near the printer. 



User's Guide 

 
- 23 - 

7. Align the printer with the tray, and then lower the printer into place. 

Note: Optional trays lock together when stacked. 

 

8. Connect the power cord to the printer, then to a properly grounded electrical outlet, and then turn on 
the printer. 

      

 

  

 

  

Note: When the printer software and any hardware options are installed, you may need to manually 
add the options in the printer driver to make them available for print jobs. 

To uninstall the optional trays, slide the latch on the right side of the printer toward the front of the printer 
until it clicks into place, and then remove stacked trays one at a time from the top to the bottom. 
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Setting up the printer software 

Installing the printer driver 

For Windows users 

1. Insert the Printer Driver and Documentations CD in the CD/DVD drive of your PC. 

2. Follow the instructions on the screen. 

3. The PostScript driver may not be installed to your PC which runs Windows Vista if it is connected to 
the printer via a USB cable. 
In that case, select USB port in the “Add a printer” wizard to install the printer driver. 

4. Click Install, and then follow the instructions on the computer screen. 

For Macintosh users 

1. Insert the Printer Driver and Documentations CD in the CD drive of your Macintosh. 

2. Double-click the CD icon on the desktop, the Drivers folder, and the Mac folder. 

→ Mac OS X v10.3/v10.4: double-click bizhub_4700PSeries_103104.pkg 

→ Mac OS X v10.5: in the english (other) folder, double-click bizhub_4700PSeries_105.pkg 

→ Mac OS X v10.6/v10.7/v10.8: in the english (other) folder, double-click 
bizhub_4700PSeries_106.pkg 

3. The installer for the printer driver starts up. 

Note: 

For OS X 10.6/10.7/10.8, the driver folder varies depending on the paper size. 
Select the appropriate driver folder for your environment. 

• To use inch-based paper size (8 1/2 x 11 in letter size): Select a file in the english folder. 

• To use metric-based paper size (A4 and the like): Select a file in the other folder. 

Note: 

Double-click the package file appropriate for the application and version of operating system being used. 

• bizhub_4700PSeries_103104.pkg (for Mac OS X v10.3/v10.4) 

• bizhub_4700PSeries_105.pkg (for Mac OS X v10.5) 

• bizhub_4700PSeries_106.pkg (for Mac OS X v10.6/v10.7/v10.8) 
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4. Add the printer. 

a. (For Mac OS X v10.3/v10.4/v10.5/v10.6) 

Apple menu > System preferences > Print & Fax > + 

(For Mac OS X v10.7/v10.8) 

Apple menu > System preferences > Print & Scan > + 

b. Select your printer. 

c. Click Add. 

Networking 

Notes: 

• Purchase a wireless network adapter first before setting up the printer on a wireless network. For 
information on installing the wireless network adapter, see the instruction sheet that came with the 
adapter. 

• A Service Set Identifier (SSID) is a name assigned to a wireless network. Wired Equivalent Privacy 
(WEP), Wi-Fi Protected Access (WPA), WPA2, and 802.1X - RADIUS are types of security used on a 
network. 

Preparing to set up the printer on an Ethernet network 

To configure your printer to connect to an Ethernet network, organize the following information before you 
begin: 

Note: If your network automatically assigns IP addresses to computers and printers, continue on to 
installing the printer. 

• A valid, unique IP address for the printer to use on the network 

• The network gateway 

• The network mask 

• A nickname for the printer (optional) 

Note: A printer nickname can make it easier for you to identify your printer on the network. You can 
choose to use the default printer nickname, or assign a name that is easier for you to remember. 

You will need an Ethernet cable to connect the printer to the network and an available port where the 
printer can physically connect to the network. Use a new network cable when possible to avoid potential 
problems caused by a damaged cable. 
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Installing the printer on an Ethernet network 

For Windows users 

1. Insert the Printer Driver and Documentations CD in the CD/DVD drive of your PC. 

2. Follow the instructions on the screen. 

3. A device is detected and it is displayed on a device list. Choose a device to install and click Next. 

4. Choose the component to install and click Next. 

5. Installation was completed. 

For Macintosh users 

1. Allow the network DHCP server to assign an IP address to the printer. 

2. Obtain the printer IP address either: 

- From the printer control panel 

- From the TCP/IP section in the Network/Ports menu 

- By printing a network setup page or menu settings page, and then finding the TCP/IP section 

Note: You will need the IP address if you are configuring access for computers on a different 
subnet than the printer. 

3. Install the printer driver on the computer. 

a. Insert the Printer Driver and Documentations CD in the CD drive of your Macintosh. 

b. Double-click the CD icon on the desktop, the Drivers folder, the Mac folder. 

→ Mac OS X v10.3/v10.4: double-click bizhub_4700PSeries_103104.pkg 

→ Mac OS X v10.5: in the english (other) folder, double-click bizhub_4700PSeries_105.pkg 

→ Mac OS X v10.6/v10.7/v10.8: in the english (other) folder, double-click 
bizhub_4700PSeries_106.pkg 

c. The installer for the printer driver starts up. 

Note: 

For OS X 10.6/10.7/10.8, the driver folder varies depending on the paper size. 
Select the appropriate driver folder for your environment. 

• To use inch-based paper size (8 1/2 x 11 in letter size): Select a file in the english folder. 

• To use metric-based paper size (A4 and the like): Select a file in the other folder. 
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Note: 

Double-click the package file appropriate for the application and version of operating system being 
used. 

• bizhub_4700PSeries_103104.pkg (for Mac OS X v10.3/v10.4) 

• bizhub_4700PSeries_105.pkg (for Mac OS X v10.5) 

• bizhub_4700PSeries_106.pkg (for Mac OS X v10.6/v10.7/v10.8) 

4. Add the printer. 

a. (For Mac OS X v10.3/v10.4/v10.5/v10.6) 

Apple menu > System preferences > Print & Fax > + 

(For Mac OS X v10.7/v10.8) 

Apple menu > System preferences > Print & Scan > + 

b. Select your printer. 

c. Click Add. 

For Linux users 

Adding the Printer Using Printer configuration 

1. Connect the machine to a computer or the network. 

2. Insert the Printer Driver and Documentations CD in the CD/DVD drive of your computer. 

3. From the System menu, select Administration > Printing. 

4. Click New Printer. 

5. Enter the Printer name, Description, and Location > Forward. 

6. From the left pane of the dialog box, select the port for the machine to be installed. 

7. Click Forward. 

8. Select Provide PPD file. 

9. Click the folder icon. 

10.  Select the PPD file. 

11. Click Open > Forward > Apply. 
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Adding the Printer on the CUPS Administration Web page 

1. Connect the machine to a computer or the network. 

2. Start up the Web browser. 

3. Enter the URL “http://localhost:631”. 

4. Click Add Printer. 

5. Enter the Printer name, Location, and Description > Continue. 

6. Select a Device Port from the Device list > Continue. 

7. For a USB connection, skip to step 9.  
Enter the device URI in the following form: “socket://<Printer IP or Printer Hostname>:port” 

8. Click Continue. 

9. Select KONICA MINOLTA > Continue. 

10. Select KONICA MINOLTA bizhub 4700PSeries PPD (xx) > Add Printer. 

11. Enter the user name and password for using root privileges > OK. 

Preparing to set up the printer on a wireless network 

Notes: 

• Make sure your wireless network adapter is installed in your printer and working properly. 

• Make sure your access point (wireless router) is turned on and is working properly. 

Make sure you have the following information before setting up the printer on a wireless network: 

• SSID—The SSID is also referred to as the network name. 

• Wireless Mode (or Network Mode)—The mode is either infrastructure or ad hoc. 

• Channel (for ad hoc networks)—The channel defaults to automatic for infrastructure networks. 

Some ad hoc networks will also require the automatic setting. Check with your system support person 
if you are not sure which channel to select. 

• Security Method—There are three basic options for Security Method: 

- WEP key 

If your network uses more than one WEP key, then enter up to four in the provided spaces. 
Select the key currently in use on the network by selecting the default WEP transmit key. 

or 

- WPA or WPA2 preshared key or passphrase 

WPA includes encryption as an additional layer of security. The choices are AES or TKIP. 
Encryption must be set for the same type on the router and on the printer, or the printer will not be 
able to communicate on the network. 
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- 802.1X–RADIUS 

If you are installing the printer on an 802.1X network, then you may need the following: 

• Authentication type 

• Inner authentication type 

• 802.1X user name and password 

• Certificates 

- No security 

If your wireless network does not use any type of security, then you will not have any security 
information. 

Note: Using an unsecured wireless network is not recommended. 

Notes: 

- If you do not know the SSID of the network that your computer is connected to, then launch the 
wireless utility of the computer network adapter, and then look for the network name. If you 
cannot find the SSID or the security information for your network, then see the documentation 
that came with the access point, or contact your system support person. 

- To find the WPA/WPA2 preshared key/passphrase for the wireless network, see the 
documentation that came with the access point, see the Web page associated with the access 
point, or consult your system support person. 

Connecting the printer to a wireless network using the Wi-Fi Protected Setup 

Before connecting the printer to a wireless network, make sure that: 

• The access point (wireless router) is Wi-Fi Protected Setup (WPS) certified or WPS-compatible. For 
more information, see the documentation that came with your access point. 

• A wireless network adapter is installed in your printer and is working properly. For more information, 
see the instruction sheet that came with the wireless network adapter. 

Using the Push Button Configuration Method 

1. Depending on your printer model, navigate to either of the following: 

-  >Settings >  >Networks/Ports >  >Network [x] >  >Network [x] Setup >  

>Wireless >  >Wi-Fi Protected Setup >  >Start Push Button Method >  

2. Follow the instructions on the printer display. 
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Using the Personal Identification Number (PIN) Method 

1. Depending on your printer model, navigate to either of the following: 

-  >Settings >  >Networks/Ports >  >Network [x] >  >Network [x] Setup >  

>Wireless >  >Wi-Fi Protected Setup >  >Start PIN Method >  

2. Copy the eight-digit WPS PIN. 

3. Open a Web browser, and then type the IP address of your access point in the address field. 

Notes: 

- The IP address appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are accessing a proxy server, then temporarily disable it to load the Web page correctly. 

4. Access the WPS settings. For more information, see the documentation that came with your access 
point. 

5. Enter the eight-digit PIN, and then save the setting. 

Connecting the printer to a wireless network using the Embedded Web Server 

Before you begin, make sure that: 

• Your printer is connected temporarily to an Ethernet network. 

• A wireless network adapter is installed in your printer and working properly. For more information, see 
the instruction sheet that came with your wireless network adapter. 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click Settings >Network/Ports >Wireless. 

3. Modify the settings to match the settings of your access point (wireless router). 

Note: Make sure to enter the correct SSID. 

4. Click Submit. 

5. Turn off the printer, and then disconnect the Ethernet cable. Then wait for at least five seconds, and 
then turn the printer back on. 

6. To verify if your printer is connected to the network, print a network setup page. Then in the Network 
Card [x] section, see if the status is “Connected”. 

For more information, see the “Verifying printer setup” section of the User’s Guide. 
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Verifying printer setup 

When all hardware and software options are installed and the printer is turned on, verify that the printer is 
set up correctly by printing the following: 

• Menu settings page—Use this page to verify that all printer options are installed correctly. A list of 
installed options appears toward the bottom of the page. If an option you installed is not listed, then it 
is not installed correctly. Remove the option, and then install it again. For more information, see 
Printing a menu settings page. 

• Network setup page—If your printer has Ethernet or wireless capability and is attached to a network, 
then print a network setup page to verify the network connection. This page also provides important 
information that aids network printing configuration. For more information, see Printing a network 
setup page. 
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4—Using bizhub 4000P/4700P 

Learning about the printer 

Printer configurations 

 CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray 
separately. Keep all other trays closed until needed. 

bizhub 4000P 

 

1 Printer control panel 

2 Paper stop 

3 Standard bin 

4 Front door release button 

5 Controller board access door 

6 100-sheet multipurpose feeder 

7 Standard 250-sheet tray 

8 Optional 250- or 550-sheet trays 

9 Front door 
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bizhub 4700P 

 

1 Printer control panel 

2 Paper stop 

3 Standard bin 

4 Front door release button 

5 Controller board access door 

6 100-sheet multipurpose feeder 

7 Standard 550-sheet tray 

8 Optional 250- or 550-sheet trays 

9 Front door 

  

Using the printer control panel 
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  Use the To 

1 Display View the printer status and messages. 

Set up and operate the printer. 

2 Left arrow button Scroll to the left. 

3 Select button Select menu options. 

Save settings. 

4 Up arrow button Scroll up. 

5 Right arrow button Scroll to the right. 

6 Keypad Enter numbers, letters, or symbols. 

7 Sleep button Enable Sleep mode or Hibernate mode. 

The following actions wake the printer from Sleep mode: 

• A hard reset or a long press of the Sleep button wakes the 
printer from Hibernate mode. 

• Pressing any hard button 

• Opening a tray or the front door 

• Sending a print job from the computer 

• Performing a power-on reset using the main power switch 

• Attaching a device in the USB port 

8 USB port Connect a flash drive to the printer. 

Notes: 

• Only the front USB port supports flash drives. 

• bizhub 4700P Only. 

9 Stop or cancel button Stop all printer activities. 

10 Back button Return to the previous screen. 

11 Down arrow button Scroll down. 

12 Home button Go to the home screen. 

13 Indicator light Check the status of the printer. 
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Understanding the colors of the indicator and Sleep button lights 

The colors of the indicator and Sleep button lights on the printer control panel signify a certain printer 
status or condition. 

Indicator light color and its corresponding printer status 

Indicator light Printer status 

Off The printer is off or in Hibernate mode. 

Blinking green The printer is warming up, processing data, or printing. 

Solid green The printer is on, but idle. 

Blinking red The printer requires user intervention. 

  

Sleep button light color and its corresponding printer status 

Sleep button light Printer status 

Off The printer is idle or in Ready state. 

Solid amber The printer is in Sleep mode. 

Blinking amber The printer is waking from or entering Hibernate mode. 

Blinking amber for 0.1 second, then goes 
completely off for 1.9 seconds in pulsing 
pattern 

The printer is in Hibernate mode. 

  

Attaching cables 

Connect the printer to the computer using a USB or to the network using an Ethernet cable. 

Make sure to match the following: 

• The USB symbol on the cable with the USB symbol on the printer 

• The appropriate Ethernet cable with the Ethernet port 
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Warning—Potential Damage: Do not touch the USB cable, any network adapter, or the printer in the 
area shown while actively printing. Loss of data or a malfunction can occur. 

 

  Use the  To 

1 USB port Attach an optional wireless network adapter. 

2 USB printer port Connect the printer to a computer. 

3 Ethernet port Connect the printer to an Ethernet network. 

4 Power switch Turn on or turn off the printer. 

5 Printer power cord socket Connect the printer to an electrical outlet. 

6 Security slot Attach a lock that will secure the printer in place. 

  

Accessing the controller board 

 CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional 
hardware or memory devices sometime after setting up the printer, then turn the printer off, and unplug 
the power cord from the electrical outlet before continuing. If you have any other devices attached to the 
printer, then turn them off as well, and unplug any cables going into the printer. 
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1. Open the controller board access door. 

 

2. Use the following illustration to locate the appropriate connector. 

Warning—Potential Damage: Controller board electronic components are easily damaged by static 
electricity. Touch a metal surface on the printer before touching any controller board electronic 
components or connectors. 

 

1 Memory card connector 

2 Option card connector 
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Loading paper and specialty media 

The selection and handling of paper and specialty media can affect how reliably documents print. For 
more information, see Avoiding jams and Storing paper. 

Setting the paper size and type 

1. From the printer control panel, navigate to: 

 >Settings >  >Paper Menu >  >Paper Size/Type >  

2. Press the up or down arrow button to select the tray or feeder, and then press . 

3. Press the up or down arrow button to select the paper size, and then press . 

4. Press the up or down arrow button to select the paper type, and then press  to change the 
settings. 

Configuring Universal paper settings 

The Universal paper size is a user-defined setting that lets you print on paper sizes that are not preset in 
the printer menus. 

Notes: 

• The smallest Universal paper size is 76.2 x 127 mm (3 x 5 inches), and is supported only from the 
multipurpose feeder. 

• The largest Universal paper size is 215.9 x 355.6 mm (8.5  x 14 inches), and is supported from all 
paper sources. 

1. From the printer control panel, navigate to: 

 >Settings >  >Paper Menu >  >Universal Setup >  >Units of Measure >  > 

select a unit of measure >  

2. Select Portrait Width or Portrait Height, and then press . 

3. Press the left or right arrow button to change the setting, and then press . 

Using the standard bin and paper stop 

The standard bin holds up to 150 (for bizhub 4000P) or 250 (for bizhub 4700P) sheets of 20-lb paper. It 
collects prints facedown. The standard bin includes a paper stop that keeps paper from sliding out the 
front of the bin as it stacks. 
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To open the paper stop, pull it so that it flips forward. 

 

Note: Close the paper stop when moving the printer to another location. 

bizhub 4000P Loading trays 

 CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray 
separately. Keep all other trays closed until needed. 

1. Pull the tray completely out. 

Note: Do not remove trays while a job prints or while Busy appears on the printer display. Doing so 
may cause a jam. 
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2. Squeeze, and then slide the width guide tab to the correct position for the size of the paper you are 
loading. 
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3. Unlock the length guide. Squeeze, and then slide the length guide tab to the correct position for the 
size of the paper you are loading. 

 

Notes: 

- For some paper sizes like letter, legal, and A4, squeeze and slide the length guide tab backward 
to accommodate their length. 

- When loading legal-size paper, the length guide extends beyond the base leaving the paper 
exposed to dust. To protect the paper from dust, you can purchase a dust cover separately. 

- If you are loading A6-size paper in the standard tray, then squeeze and slide the length guide tab 
toward the center of the tray to the A6-size position. 

- Make sure the width and length guides are aligned with the paper size indicators on the bottom of 
the tray. 
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4. Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. 
Straighten the edges on a level surface. 

 

5. Load the paper stack. 

Note: Make sure the paper is below the maximum fill indicator located on the side of the width guide. 

 

Notes: 

- Load with the printable side facedown when using recycled or preprinted paper. 

- Load prepunched paper with the holes on the top edge toward the front of the tray. 

- Load letterhead facedown, with the top edge of the sheet toward the front of the tray. For two-
sided printing, load letterhead faceup with the bottom edge of the sheet toward the front of the 
tray. 
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6. Insert the tray. 

 

7. From the Embedded Web Server or your computer, set the paper size and type in the Paper menu to 
match the paper loaded in the tray. 

Notes: 

- If the printer is not connected to a network, then access the Paper menu using Printer Settings, 
depending on your operating system. 

- Set the correct paper size and type to avoid paper jams and print quality problems. 

bizhub 4700P Loading trays 

 CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray 
separately. Keep all other trays closed until needed. 

1. Pull the tray completely out. 

Note: Do not remove trays while a job prints or while Busy appears on the printer display. Doing so 
may cause a jam. 
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2. Squeeze, and then slide the width guide tab to the correct position for the size of the paper you are 
loading. 

 

3. Unlock the length guide. Squeeze, and then slide the length guide tab to the correct position for the 
size of the paper you are loading. 

 

Notes: 

- For some paper sizes like letter, legal, and A4, squeeze and slide the length guide tab backward 
to accommodate their length. 
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- When loading legal-size paper, the length guide extends beyond the base leaving the paper 
exposed to dust. To protect the paper from dust, you can purchase a dust cover separately. 

- If you are loading A6-size paper in the standard tray, then squeeze and then slide the length 
guide tab toward the center of the tray to the A6-size position. 

- Make sure the width and length guides are aligned with the paper size indicators on the bottom of 
the tray. 

 

4. Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. 
Straighten the edges on a level surface. 
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5. Load the paper stack. 

 

Notes: 

- Load with the printable side facedown when using recycled or preprinted paper. 

- Load prepunched paper with the holes on the top edge toward the front of the tray. 

- Load letterhead facedown, with the top edge of the sheet toward the front of the tray. For two-
sided printing, load letterhead faceup with the bottom edge of the sheet toward the front of the 
tray. 

- Make sure the paper is below the maximum paper fill indicator located on the side of the width 
guide. 
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6. Insert the tray. 

 

7. From the printer control panel, set the paper size and type in the Paper menu to match the paper 
loaded in the tray. 

Note: Set the correct paper size and type to avoid paper jams and print quality problems. 
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Loading the multipurpose feeder 

Use the multipurpose feeder when printing on different paper sizes and types or specialty media, such as 
card stock, transparencies, paper labels, and envelopes. You can also use it for single-page print jobs on 
letterhead. 

1. Open the multipurpose feeder. 

 

a. Pull the multipurpose feeder extender. 

 

b. Pull the extender gently so that the multipurpose feeder is fully extended and open. 
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2. Squeeze the tab on the left width guide, and then move the guides for the paper you are loading. 

 

3. Prepare the paper or specialty media for loading. 

- Flex sheets of paper back and forth to loosen them, and then fan them. Do not fold or crease the 
paper. Straighten the edges on a level surface. 

 

- Hold transparencies by the edges. Flex the stack of transparencies back and forth to loosen them, 
and then fan them. Straighten the edges on a level surface. 

Note: Avoid touching the printable side of the transparencies. Be careful not to scratch them. 

 

- Flex the stack of envelopes back and forth to loosen them, and then fan them. Straighten the 
edges on a level surface. 
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4. Load the paper or specialty media. 

Note: Make sure the paper or specialty media is below the maximum paper fill indicator located on 
the paper guides. Overfilling may cause paper jams. 

 

- Load paper, transparencies, and card stock with the recommended printable side faceup and the 
top edge entering the printer first. For more information on loading transparencies, see the 
packaging that the transparencies came in. 

                  

 

- Load letterhead faceup with the top edge entering the printer first. For two-sided (duplex) printing, 
load letterhead facedown with the bottom edge entering the printer first. 
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- Load envelopes with the flap on the left side facedown. 

 

Warning—Potential Damage: Never use envelopes with stamps, clasps, snaps, windows, 
coated linings, or self-stick adhesives. These envelopes may severely damage the printer. 

5. From the printer control panel, set the paper size and type in the Paper menu to match the paper or 
specialty media loaded in the multipurpose feeder. 

Linking and unlinking trays 

Linking and unlinking trays 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address on the printer control panel in the TCP/IP section under the 
Network/Ports menu. The IP address appears as four sets of numbers separated by periods, 
such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click Settings >Paper Menu. 

3. Change the paper size and type settings for the trays you are linking. 

- To link trays, make sure the paper size and type for the tray match that of the other tray. 

- To unlink trays, make sure the paper size or type for the tray does not match that of the other tray. 

4. Click Submit. 

Note: You can also change the paper size and type settings using the printer control panel. For more 
information, see Setting the paper size and type. 

Warning—Potential Damage: Paper loaded in the tray should match the paper type name assigned in 
the printer. The temperature of the fuser varies according to the specified paper type. Printing issues may 
occur if settings are not properly configured. 
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Creating a custom name for a paper type 

Using the Embedded Web Server 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click Settings >Paper Menu >Custom Names. 

3. Select a custom name, and then type a new custom paper type name. 

4. Click Submit. 

5. Click Custom Types, and then verify if the new custom paper type name has replaced the custom 
name. 

Using the printer control panel 

1. From the printer control panel, navigate to: 

 >Settings >  >Paper Menu >  >Custom Names 

2. Select a custom name, and then type a new custom paper type name. 

3. Press . 

4. Press Custom Types, and then verify if the new custom paper type name has replaced the custom 
name. 

Assigning a custom paper type 

Using the Embedded Web Server 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click Settings >Paper Menu >Custom Types. 

3. Select a custom paper type name, and then select a paper type. 

Note: Paper is the factory default paper type for all user-defined custom names. 

4. Click Submit. 
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Using the printer control panel 

1. From the printer control panel, navigate to: 

 >Settings >  >Paper Menu >  >Custom Types 

2. Select a custom paper type name, and then select a paper type. 

Note: Paper is the factory default paper type for all user-defined custom names. 

3. Press . 

Printing 

Printing a document 

Printing a document 

1. From the Paper menu on the printer control panel, set the paper type and size to match the paper 
loaded. 

2. Send the print job: 

For Windows users 

a. With a document open, click File >Print. 

b. Click Properties, Preferences, Options, or Setup. 

c. Adjust the settings, if necessary. 

d. Click OK >Print. 

For Macintosh users 

a. Customize the settings in the Page Setup dialog if necessary: 

1. With a document open, choose File >Page Setup. 

2. Choose a paper size or create a custom size to match the paper loaded. 

3. Click OK. 

b. Customize the settings in the Page Setup dialog if necessary: 

1. With a document open, choose File >Print. 

If necessary, click the disclosure triangle to see more options. 

2. From the Print dialog and pop-up menus adjust the settings if necessary. 

Note: To print on a specific paper type, adjust the paper type setting to match the paper 
loaded, or select the appropriate tray or feeder. 

3. Click Print. 
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Adjusting toner darkness 

Using the Embedded Web Server 

1. Open a Web browser, and then type the IP address of the printer in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click Settings >Print Settings >Quality Menu >Toner Darkness. 

3. Adjust the toner darkness, and then click Submit. 

Using the printer control panel 

1. From the printer control panel, navigate to: 

 >Settings >  >Print Settings >  >Quality Menu >  >Toner Darkness 

2. Adjust the toner darkness, and then press . 

Printing from a flash drive (For bizhub 4700P only) 

Printing from a flash drive 

Notes: 

• Before printing an encrypted PDF file, you will be prompted to enter the file password from the printer 
control panel. 

• You cannot print files for which you do not have printing permissions. 
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1. Insert a flash drive into the USB port. 

 

Notes: 

- A flash drive icon appears on the printer control panel and in the held jobs icon when a flash drive 
is installed. 

- If you insert the flash drive when the printer requires attention, such as when a jam has occurred, 
then the printer ignores the flash drive. 

- If you insert the flash drive while the printer is processing other print jobs, then Busy appears. 
After these print jobs are processed, you may need to view the held jobs list to print documents 
from the flash drive. 

Warning—Potential Damage: Do not touch the printer or the flash drive in the area shown while 
actively printing, reading, or writing from the memory device. Loss of data can occur. 

 

2. From the printer control panel, select the document you want to print. 
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3. Press the left or right arrow button to specify the number of copies for printing, and then press . 

Notes: 

- Do not remove the flash drive from the USB port until the document has finished printing. 

- If you leave the flash drive in the printer after leaving the initial USB menu screen, then access 
held jobs from the printer control panel to print files from the flash drive. 

Supported flash drives and file types 

Flash drive File type 

Notes: 

• Hi-speed USB flash drives must support the full-speed standard. Low-speed USB 
devices are not supported. 

• USB flash drives must support the File Allocation Table (FAT) system. Devices 
formatted with New Technology File System (NTFS) or any other file system are not 
supported. 

Documents: 

• .pdf (Version 1.7 
or earlier) 

• .xps 

• .html 

Images: 

• .dcx 

• .gif 

• .JPEG or .jpg 

• .bmp 

• .pcx 

• .TIFF or .tif 

• .png 

  

Printing confidential and other held jobs 

Storing print jobs in the printer 

1. From the printer control panel, navigate to: 

 >Settings> >Security >Confidential Print 
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2. Select a print job type. 

Use To 

Confidential Job Expiration Hold print jobs in the computer until you enter the PIN from the printer 
control panel. 

Note: The PIN is set from the computer. It must be four digits, using the 
numbers 0–9. 

Max Invalid PIN Limit the number of times an invalid PIN can be entered. 

Note: When the limit is reached, the print jobs for that user name and 
PIN are deleted. 

Repeat Job Expiration Print and store print jobs in the printer memory. 

Reserve Job Expiration Store print jobs for printing at a later time. 

Note: The print jobs are held until deleted from the Held Jobs menu. 

Verify Job Expiration Print one copy of a print job and hold the remaining copies. It lets you 
examine if the first copy is satisfactory. 

Note: The print job is automatically deleted from the printer memory 
once all copies are printed. 

Notes: 

• Confidential, Verify, Reserve, and Repeat print jobs may be deleted if the printer requires extra memory to 
process additional held jobs.  

• You can set the printer to store print jobs in the printer memory until you start the print job from the printer 
control panel.  

• All print jobs that can be initiated by the user at the printer are called held jobs.  

  

3. Press . 

Printing confidential and other held jobs 

Note: Confidential and Verify print jobs are automatically deleted from memory after printing. Repeat and 
Reserve jobs are held in the printer until you choose to delete them. 

For Windows users 

1. With a document open, click File >Print. 

2. Click Properties, Preferences, or Job Retention. 

3. Select Print Job Type from Job Retention. 
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4. Select the print job type (Confidential, Repeat, Reserve, or Verify), and then assign a user name. For 
a confidential print job, also enter a four-digit PIN. 

5. Click OK or Print. 

6. From the printer control panel, release the print job. 

- For confidential print jobs, navigate to: 

Held jobs > select your user name >Confidential Jobs > enter the PIN > select the print job > 
specify the number of copies >Print 

- For other print jobs, navigate to: 

Held jobs > select your user name > select the print job > specify the number of copies >Print 

For Macintosh users 

1. With a document open, choose File >Print. 

If necessary, click the disclosure triangle to see more options. 

2. From the print options or Copies & Pages pop-up menu, choose Job Routing. 

3. Select the print job type (Confidential, Repeat, Reserve, or Verify), and then assign a user name. For 
a confidential print job, also enter a four-digit PIN. 

4. Click OK or Print. 

5. From the printer control panel, release the print job: 

- For confidential print jobs, navigate to: 

Held jobs > select your user name >Confidential Jobs > enter the PIN > select the print job > 
specify the number of copies >Print 

- For other print jobs, navigate to: 

Held jobs > select your user name > select the print job > specify the number of copies >Print 

Printing information pages 

Printing a font sample list 

1. From the printer control panel, navigate to: 

 >Settings >  >Reports >  >Print Fonts 

2. Press the up or down arrow button to select the font setting. 

3. Press . 

Note: The PPDS fonts appear only when the PPDS data stream is activated. 
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Printing a directory list 

From the printer control panel, navigate to: 

 >Settings >Reports >  >Print Directory >  

Note: The Print Directory menu item appears only when an optional flash memory is installed. 

Canceling a print job 

Canceling a print job from the printer control panel 

From the printer control panel, press  > . 

Canceling a print job from the computer 

For Windows users 

1. Open the printers folder. 

a. Click , or click Start and then click Run. 

b. In the Start Search or Run dialog, type control printers. 

c. Press Enter, or click OK. 

2. Double-click the printer icon. 

3. Select the print job you want to cancel. 

4. Click Delete. 

For Macintosh users 

1. From the Apple Menu, navigate to either of the following: 

- System Preferences >Print & Scan > select a printer >Open Print Queue 

- System Preferences >Print & Fax > select a printer >Open Print Queue 

2. From the printer window, select the print job you want to cancel, and then click Delete. 
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Managing the printer 

Finding advanced networking and administrator information 

This chapter covers basic administrative support tasks using the Embedded Web Server. For more 
advanced system support tasks, see the Networking Guide on the Printer Driver and Documentations CD. 

Checking the virtual display 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Check the virtual display that appears at the top left corner of the screen. 

The virtual display works as an actual display would work on a printer control panel. 

Configuring supply notifications from the Embedded Web Server 

You can determine how you would like to be notified when supplies run nearly low, low, very low, or reach 
their end-of-life by setting the selectable alerts. 

Notes: 

• Selectable alerts can be set on the toner cartridge, imaging unit, and maintenance kit. 

• All selectable alerts can be set for nearly low, low, and very low supply conditions. Not all selectable 
alerts can be set for the end-of-life supply condition. E-mail selectable alert is available for all supply 
conditions. 

• The percentage of estimated remaining supply that prompts the alert can be set on some supplies for 
some supply conditions. 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click Settings >Print Settings >Supply Notifications. 
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3. From the drop-down menu for each supply, select one of the following notification options: 

Notification Description 

Off The normal printer behavior for all supplies occurs. 

E-mail Only The printer generates an e-mail when the supply condition is reached. The status of 
the supply will appear on the menus page and status page. 

Warning The printer displays the warning message and generates an email about the status of 
the supply. The printer does not stop when the supply condition is reached. 

Continuable Stop
1
 The printer stops processing jobs when the supply condition is reached, and the user 

needs to press a button to continue printing. 

Non Continuable 

Stop
1,2

 

The printer stops when the supply condition is reached. The supply must be replaced 
to continue printing. 

1
 The printer generates an e-mail about the status of the supply when supply notification is enabled. 

2
 The printer stops when some supplies become empty to prevent damage. 

  

4. Click Submit. 

Modifying confidential print settings 

Note: This feature is available only in network printers or printers connected to print servers. 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click Settings >Other Settings tab >Security >Confidential Print Setup. 

3. Modify the settings: 

- Set a maximum number of PIN entry attempts. When a user exceeds a specific number of PIN 
entry attempts, all of the jobs for that user are deleted. 

- Set an expiration time for confidential print jobs. When a user has not printed the jobs within the 
specified time, all of the jobs for that user are deleted. 

4. Save the modified settings. 



User's Guide 

 
- 62 - 

Copying printer settings to other printers 

Note: This feature is available only in network printers. 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click the Copy Printer Settings. 

3. To change the language, select a language from the drop-down menu, and then click Click here to 
submit language. 

4. Click Printer Settings. 

5. Type the IP addresses of the source and target printers in their appropriate fields. 

Note: If you want to add or remove a target printer, then click Add Target IP or Remove Target IP.  

6. Click Copy Printer Settings. 

Creating a printer control panel PIN 

The Panel PIN Protect menu lets you restrict access to the menus from the printer control panel. To 
restrict access to the menus, create a Personal Identification Number (PIN), and then assign the PIN to 
each menu. 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click Settings >Security >Panel PIN Protect. 

3. From the Create User PIN or Create Admin PIN sections, enter your PIN. 

Note: Your can enter up to 16 digits for your PIN. 

4. Click Modify. 

5. From any menu in the Administrative Menus, Management, or Function Access sections, select User 
PIN Protected or Admin PIN Protected or Admin PIN and User PIN Protected. 

Note: Using an Admin PIN, you can still access a menu assigned with a User PIN. 
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6. Click Submit. 

If you try to access a PIN-protected menu from the printer control panel, the printer will require you to 
enter the PIN. 

Note: After you enter the last digit of the PIN, make sure to press  on the printer control panel for 
more than three seconds. 

Printing a menu settings page 

Print a menu settings page to view the current menu settings and to verify if the printer options are 
installed correctly. 

From the printer control panel, navigate to: 

 >Settings >  >Reports >  >Menu Settings Page >  

Note: If you have not changed any menu settings, then the menu settings page lists all the factory default 
settings. Settings saved from the menus replace the factory default settings as user default settings. A 
user default setting remains in effect until you access the menu again, select another value, and save it. 

Printing a network setup page 

If the printer is attached to a network, then print a network setup page to verify the network connection. 
This page also provides important information that aids network printing configuration. 

1. From the printer control panel, navigate to: 

 >Settings >  >Reports >  >Network Setup Page >  

Note: If an optional internal print server is installed, then Print Network [x] Setup Page 
appears. 

2. Check the first section of the network setup page, and confirm that the status is Connected. 

If the status is Not Connected, then the LAN drop may not be active, or the network cable may be 
malfunctioning. Consult your system support person for a solution, and then print another network 
setup page. 

Checking the status of parts and supplies 

A message appears on the printer display when a replacement supply item is needed or when 
maintenance is required.  

Checking the status of parts and supplies on the printer control panel 

From the printer control panel, navigate to: 

 >Status/Supplies > View Supplies >  
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Checking the status of parts and supplies from the Embedded Web Server 

Note: Make sure the computer and printer are connected to the same network. 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click Device Status >More Details. 

Saving energy 

Using Eco-mode 

Use Eco-Mode to quickly select one or more ways to reduce your printer's environmental impact. 

1. From the printer control panel, navigate to: 

 >Settings >  >Settings >  >General Settings >  >Eco-Mode >  > select the 
setting you want 

Use To 

Off  Use the factory default settings for all settings associated with Eco-Mode. This setting supports 
the performance specifications for your printer. 

Energy Reduce energy use, especially when the printer is idle. 

• Printer engine motors do not start until a job is ready to print. You may notice a short delay 
before the first page is printed. 

• The printer enters Sleep mode after one minute of inactivity. 

Energy/Paper  Use all the settings associated with Energy and Paper modes. 

Plain Paper • Enable the automatic two-sided (duplex) feature. 

• Turn off print log features. 

  

2. Press . 
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Reducing printer noise 

Use Quiet mode to reduce the printer noise. 

1. From the printer control panel, navigate to: 

 >Settings >  >Settings >  >General Settings >  >Quiet Mode >  

2. Select a setting you want. 

Use To 

On Reduce printer noise. 

Notes: 

• Print jobs will process at a reduced speed. 

• Printer engine motors do not start until a 
document is ready to print. There is a short delay 
before the first page is printed. 

Off Use factory default settings. 

Note: This setting supports the performance 
specifications of the printer. 

  

3. Press . 

Adjusting Sleep mode 

To save energy, decrease the number of minutes before the printer enters Sleep mode. Select from 1 to 
120. The factory default setting is 30 minutes. 

Note: The printer still accepts print jobs when in Sleep mode. 

Using the Embedded Web Server 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Navigate to: 

Settings >General Settings >Timeouts 

3. In the Sleep Mode field, enter the number of minutes you want the printer to wait before it enters 
Sleep mode. 
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4. Click Submit. 

Using the printer control panel 

1. From the printer control panel, navigate to: 

 >Settings >  >Settings >  >General Settings >  >Timeouts >  >Sleep Mode 

>  

2. In the Sleep Mode field, select the number of minutes you want the printer to wait before it enters 
Sleep mode. 

3. Press . 

Using Hibernate mode 

Hibernate is an ultra-low-power operating mode. When operating in Hibernate mode, all other systems 
and devices are powered down safely. 

Notes: 

• Make sure to wake the printer from Hibernate mode before sending a print job. A hard reset or a long 
press of the Sleep button wakes the printer from Hibernate mode. 

• The Hibernate mode can be scheduled. For more information, see Using Schedule Power Modes. 

• If the printer is in Hibernate mode, the Embedded Web Server is disabled. 

Using the Embedded Web Server 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If your are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click Settings >General Settings >Sleep Button Settings. 

3. From the “Press Sleep Button” or “Press and Hold Sleep Button” drop-down menu, select Hibernate. 

4. Click Submit. 

Using the printer control panel 

1. From the printer control panel, navigate to: 

 >Settings >  >Settings >  >General Settings >  

2. Press the arrow buttons until Press Sleep Button or Press and Hold Sleep Button 

appears, and then press . 
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3. Press the arrow buttons until Hibernate appears, and then press . 

Notes: 

• When Press Sleep Button is set to Hibernate, a short press of the Sleep button sets the printer to 
Hibernate mode. 

• When Press and Hold Sleep Button is set to Hibernate, a long press of the Sleep button sets the 
printer to Hibernate mode. 

Setting Hibernate Timeout 

Hibernate Timeout lets you set the amount of time the printer waits after a print job is processed before it 
goes into a reduced power state. 

Using the Embedded Web Server 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click Settings >General Settings >Timeouts. 

3. From the Hibernate Timeout menu, select the number of hours, days, weeks, or months you want for 
the printer to wait before it goes into a reduced power state. 

4. Click Submit. 

Using the printer control panel 

1. From the printer control panel, navigate to: 

 >Settings >  >Settings >  >General Settings >  >Timeouts >  >Hibernate 

Timeout >  

2. Select the amount of time the printer waits after a print job is processed before it enters Hibernate 
mode. 

3. Press . 

Using Schedule Power Modes 

Schedule Power Modes lets you schedule when the printer goes into a reduced power state or into the 
Ready state. 

Note: This feature is available only in network printers or printers connected to print servers. 
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Using the Embedded Web Server 

1. Open a Web browser, and then type the printer IP address in the address field. 

Notes: 

- View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address 
appears as four sets of numbers separated by periods, such as 123.123.123.123. 

- If you are using a proxy server, then temporarily disable it to load the Web page correctly. 

2. Click Settings >General Settings >Schedule Power Modes. 

3. From the Action menu, select the power mode. 

4. From the Time Source menu, select the time. 

5. From the Day(s) menu, select the day or days. 

6. Click Add. 

Restoring factory default settings 

If you want to keep a list of the current menu settings for reference, then print a menu settings page 
before restoring the factory default settings. For more information, see Printing a menu settings page. 

If you want a more comprehensive method of restoring the printer factory default settings, then perform 
the Wipe All Settings option. For more information, see Erasing non-volatile memory. 

Warning—Potential Damage: Restoring factory defaults returns most printer settings to the original 
factory default settings. Exceptions include the display language, custom sizes and messages, and 
network/port menu settings. All downloads stored in the RAM are deleted. Downloads stored in the flash 
memory are not affected. 

From the printer control panel, navigate to: 

 >Settings >  >Settings >  >General Settings >  >Factory Defaults >  >Restore 

Now >  
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Securing the printer 

Using the security lock feature 

The printer is equipped with a security lock feature. Attach a security lock compatible with most laptop 
computers in the location shown to secure the printer in place. 

 

Statement of Volatility 

Your printer contains various types of memory that can store device and network settings, and user data. 

Type of memory Description 

Volatile memory Your printer uses standard random access memory 
(RAM) to temporarily buffer user data during simple print 
jobs. 

Non-volatile memory Your printer may use two forms of non-volatile memory: 
EEPROM and NAND (flash memory). Both types are 
used to store operating system, device settings, and 
network information. 

  

Erase the content of any installed printer memory in the following circumstances: 

• The printer is being decommissioned. 

• The printer is being moved to a different department or location. 

• The printer is being serviced by someone from outside your organization. 

• The printer is being removed from your premises for service. 

• The printer is being sold to another organization. 



User's Guide 

 
- 70 - 

Erasing volatile memory 

The volatile memory (RAM) installed in your printer requires a power source to retain information. To 
erase the buffered data, turn off the printer. 

Erasing non-volatile memory 

Erase individual settings, device and network settings, security settings, and embedded solutions by 
following these steps: 

1. Turn off the printer. 

2. Hold down 2 and 6 on the keypad while turning the printer on. Release the buttons only when the 
screen with the progress bar appears. 

The printer performs a power-on sequence, and then the Configuration menu appears. When the 
printer is fully turned on, a list of functions appears on the printer display. 

3. Press the up or down arrow button until Wipe All Settings appears. 

The printer will restart several times during this process. 

Note: Wipe All Settings securely removes device settings, solutions, jobs, and passwords from the 
printer memory. 

4. Navigate to: 

Back >Exit Config Menu 

The printer will perform a power-on reset, and then return to normal operating mode. 
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5—Paper and specialty media guide 

Using specialty media 

Tips on using card stock 

Card stock is heavy, single-ply specialty media. Many of its variable characteristics, such as moisture 
content, thickness, and texture, can significantly impact print quality. Print samples on the card stock 
being considered for use before buying large quantities. 

When printing on card stock: 

• Make sure the Paper Type is Card Stock. 

• Select the appropriate Paper Texture setting. 

• Be aware that preprinting, perforation, and creasing may significantly affect the print quality and 
cause jams or other paper handling problems. 

• Check with the manufacturer or vendor to ensure that the card stock can withstand temperatures up 
to 240°C (464°F) without releasing hazardous emissions. 

• Do not use preprinted card stock manufactured with chemicals that may contaminate the printer. 
Preprinting introduces semi-liquid and volatile components into the printer. 

• Use grain short card stock when possible. 

Tips on using envelopes 

Print samples on the envelopes being considered for use before buying large quantities. 

• Use envelopes designed specifically for laser printers. Check with the manufacturer or vendor to 
ensure that the envelopes can withstand temperatures up to 230°C (446°F) without sealing, wrinkling, 
curling excessively, or releasing hazardous emissions. 

• For best performance, use envelopes made from 90-g/m2 (24-lb bond) paper or 25% cotton. All-
cotton envelopes must not exceed 70-g/m2 (20-lb bond) weight. 

• Use only new envelopes from undamaged packages. 

• To optimize performance and minimize jams, do not use envelopes that: 

- Have excessive curl or twist 

- Are stuck together or damaged in any way 

- Have windows, holes, perforations, cutouts, or embossing 

- Have metal clasps, string ties, or folding bars 

- Have an interlocking design 

- Have postage stamps attached 
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- Have any exposed adhesive when the flap is in the sealed or closed position 

- Have bent corners 

- Have rough, cockle, or laid finishes 

• Adjust the width guides to fit the width of the envelopes. 

Note: A combination of high humidity (over 60%) and high printing temperature may wrinkle or seal 
envelopes. 

Tips on using labels 

Print samples on the labels being considered for use before buying large quantities. 

Note: Use only paper label sheets. Vinyl, pharmacy, and two-sided labels are not supported. 

When printing on labels: 

• Use labels designed specifically for laser printers. Check with the manufacturer or vendor to verify 
that: 

- The labels can withstand temperatures up to 240°C (464°F) without sealing, excessive curling, 
wrinkling, or releasing hazardous emissions. 

- Label adhesives, face sheet (printable stock), and topcoats can withstand up to 25-psi (172-kPa) 
pressure without delaminating, oozing around the edges, or releasing hazardous fumes. 

• Do not use labels with slick backing material. 

• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. 
Partial sheets also contaminate the printer and the cartridge with adhesive, and could void the printer 
and toner cartridge warranties. 

• Do not use labels with exposed adhesive. 

• Do not print within 1 mm (0.04 inch) of the edge of the label, of the perforations, or between die-cuts 
of the label. 

• Make sure the adhesive backing does not reach to the edge of the sheet. Zone coating of the 
adhesive should be at least 1 mm (0.04 inch) away from edges. Adhesive material contaminates the 
printer and could void the warranty. 

• If zone coating of the adhesive is not possible, then remove a 2-mm (0.06-inch) strip on the leading 
and driver edge, and then use a non-oozing adhesive. 

• Portrait orientation is recommended, especially when printing bar codes. 

Tips on using letterhead 

• Use letterhead designed specifically for laser printers. 

• Print samples on the letterhead being considered for use before buying large quantities. 

• Before loading letterhead, flex, fan, and straighten the stack to prevent sheets from sticking together. 
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• Page orientation is important when printing on letterhead. For information on how to load letterhead, 
see: 

- bizhub 4000P Loading trays 

- bizhub 4700P Loading trays 

- Loading the multipurpose feeder 

Tips on using transparencies 

• Print a test page on the transparencies being considered for use before buying large quantities. 

• Feed transparencies from the standard tray, or the multipurpose feeder. 

• Use transparencies designed specifically for laser printers. Transparencies must be able to withstand 
temperatures up to 185°C (365°F) without melting, discoloring, offsetting, or releasing hazardous 
emissions. 

Note: If the transparency weight is set to Heavy and the transparency texture is set to Rough in the 
Paper menu, then transparencies can be printed at a temperature up to 195°C (383°F). 

• Avoid getting fingerprints on the transparencies to prevent print quality problems. 

• Before loading transparencies, flex, fan, and straighten the stack to prevent sheets from sticking 
together. 

Paper guidelines 

Selecting the correct paper or specialty media reduces printing problems. For the best print quality, try a 
sample of the paper or specialty media before buying large quantities. 

Paper characteristics 

The following paper characteristics affect print quality and reliability. Consider these characteristics when 
evaluating new paper stock. 

Weight 

The standard printer trays can automatically feed paper weights up to 120-g/m2 (32-lb) bond grain long 
paper. The optional trays can automatically feed paper weights up to 120-g/m2 (32-lb) bond grain long 
paper. The multipurpose feeder can automatically feed paper weights up to 163-g/m2 (43-lb) bond grain 
long paper. Paper lighter than 60 g/m2 (16 lb) might not be stiff enough to feed properly, causing jams. 
For best performance, use 75-g/m2 (20-lb) bond grain long paper. For paper smaller than 182 x 257 mm 
(7.2 x 10.1 inches), it is recommended to use 90 g/m2 (24 lb) or heavier paper. 

Note: Two-sided printing is supported only for 60–90-g/m2 (16–24-lb) bond paper. 
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Curl 

Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl 
can occur after the paper passes through the printer, where it is exposed to high temperatures. Storing 
paper unwrapped in hot, humid, cold, or dry conditions, even in the trays, can contribute to paper curling 
prior to printing and can cause feeding problems. 

Smoothness 

Paper smoothness directly affects print quality. If paper is too rough, toner cannot fuse to it properly. If 
paper is too smooth, it can cause paper feeding or print quality issues. Always use paper between 100 
and 300 Sheffield points; smoothness between 150–250 Sheffield points produces the best print quality. 

Moisture content 

The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper 
correctly. Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to 
moisture changes that can degrade its performance. 

Condition paper before printing by storing it in its original wrapper in the same environment as the printer 
for 24–48 hours before printing. Extend the time to several days if the storage or transportation 
environment is very different from the printer environment. Thick paper may also require a longer 
conditioning period. 

Grain direction 

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the 
length of the paper, or grain short, running the width of the paper. 

For 60–90-g/m2 (16–24-lb) bond paper, grain long paper is recommended. 

Fiber content 

Most high-quality xerographic paper is made from 100% chemically treated pulped wood. This content 
provides the paper with a high degree of stability resulting in fewer paper feeding problems and better 
print quality. Paper containing fibers such as cotton can negatively affect paper handling. 

Unacceptable paper 

The following paper types are not recommended for use with the printer: 

• Chemically-treated papers used to make copies without carbon paper, also known as carbonless 
papers, carbonless copy paper (CCP), or no carbon required (NCR) paper 

• Preprinted papers with chemicals that may contaminate the printer 

• Preprinted papers that can be affected by the temperature in the printer fuser 
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• Preprinted papers that require a registration (the precise print location on the page) greater or lesser 
than +/-2.5 mm (+/-0.10 inch), such as optical character recognition (OCR) forms 

In some cases, registration can be adjusted with a software application to successfully print on these 
forms: 

• Coated papers (erasable bond), synthetic papers, thermal papers 

• Rough-edged, rough or heavily textured surface papers, or curled papers 

• Recycled papers that fail EN12281:2002 (European) 

• Paper weighing less than 60 g/m2 (16 lb) 

• Multiple-part forms or documents 

Selecting paper 

Using the appropriate paper prevents jams and helps ensure trouble-free printing. 

To help avoid paper jams and poor print quality: 

• Always use new, undamaged paper. 

• Before loading paper, know the recommended printable side of the paper. This information is usually 
indicated on the paper package. 

• Do not use paper that has been cut or trimmed by hand. 

• Do not mix paper sizes, types, or weights in the same tray; mixing results in jams. 

• Do not use coated papers unless they are specifically designed for electrophotographic printing. 

Selecting preprinted forms and letterhead 

Use these guidelines when selecting preprinted forms and letterhead: 

• Use grain long for 60 to 90 g/m2 (16 to 24 lb) weight paper. 

• Use only forms and letterhead printed using an offset lithographic or engraved printing process. 

• Avoid papers with rough or heavily textured surfaces. 

Use papers printed with heat-resistant inks designed for use in xerographic copiers. The ink must be able 
to withstand temperatures up to 230°C (446°F) without melting or releasing hazardous emissions. Use 
inks that are not affected by the resin in toner. Inks that are oxidation-set or oil-based generally meet 
these requirements; latex inks might not. When in doubt, contact the paper supplier. 

Preprinted papers such as letterhead must be able to withstand temperatures up to 230°C (446°F) 
without melting or releasing hazardous emissions. 
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Storing paper 

Use these paper storage guidelines to help avoid jams and uneven print quality: 

• For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40 
percent. Most label manufacturers recommend printing in a temperature range of 18–24°C (65–75°F) 
with relative humidity between 40 and 60 percent. 

• Store paper in cartons, on a pallet or shelf, rather than on the floor. 

• Store individual packages on a flat surface. 

• Do not store anything on top of individual paper packages. 

• Take paper out of the carton or wrapper only when you are ready to load it in the printer. The carton 
and wrapper help keep the paper clean, dry, and flat. 

Supported paper sizes, types, and weights 

Supported paper sizes 

Note: For an unlisted paper size, select the closest larger listed size. For information on card stock and 
labels, see the Card Stock & Label Guide. 

Paper size Standard tray Optional 250- or 
550-sheet tray 

Multipurpose feeder Duplex mode 

A4 

210 x 297 mm (8.3 x 11.7 in.) 

    

A5 

148 x 210 mm (5.8 x 8.3 in.) 

 
3
  

X 

A6 

105 x 148 mm (4.1 x 5.8 in.) 

   
X 

JIS B5 

182 x 257 mm (7.2 x 10.1 in.) 

   
X 

Letter 

216 x 279 mm (8.5 x 11 in.) 

    

Legal 

216 x 356 mm (8.5 x 14 in.) 
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Paper size Standard tray Optional 250- or 
550-sheet tray 

Multipurpose feeder Duplex mode 

Executive 

184 x 267 mm (7.3 x 10.5 in.) 

   
X 

Oficio (Mexico)
1
 

216 x 340 mm (8.5 x 13.5 in.) 

    

Folio 

216 x 330 mm (8.5 x 13 in.) 

    

Statement 

140 x 216 mm (5.5 x 8.5 in.) 

   
X 

Universal
2
 

76.2 x 127 mm (3 x 5 in.) up 
to 216 x 356 mm 
(8.5 x 14 in.) 

    

7 3/4 Envelope (Monarch) 

98 x 191 mm (3.9 x 7.5 in.) 

X X 
 

X 

9 Envelope 

98 x 225 mm (3.9 x 8.9 in.) 

X X 
 

X 

10 Envelope 

105 x 241 mm (4.1 x 9.5 in.) 

X X 
 

X 

DL Envelope 

110 x 220 mm (4.3 x 8.7 in.) 

X X 
 

X 

C5 Envelope 

162 x 229 mm (6.4 x 9 in.) 

X X 
 

X 

B5 Envelope 

176 x 250 mm (6.9 x 9.8 in.) 

X X 
 

X 



User's Guide 

 
- 78 - 

Paper size Standard tray Optional 250- or 
550-sheet tray 

Multipurpose feeder Duplex mode 

Other Envelope 

229 x 356 mm (9 x 14 in.) 

X X 
 

X 

1
 This size setting formats the page for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software 

application. 

2
 Universal is supported only in the standard tray if the paper size is at least 105 x 148 mm (4.1 x 5.8 in.). Universal is 

supported only in the optional 250- or 550-sheet tray if the paper size is at least 148 x 210 mm (5.8 x 8.3 in.). 
Universal is only supported in duplex mode if the width is at least 210 mm (8.3 in.) and length is at least 279 mm 
(11 in.). The smallest supported Universal size is only supported in the multipurpose feeder. 

3
 Only long edge feeding is non-supported. 

  

Supported paper types and weights 

The standard tray supports 60–120-g/m2 (16–32-lb) paper weights. The optional tray supports 60–120-
g/m2 (16–32-lb) paper weights. The multipurpose feeder supports 60–163-g/m2 (16–43-lb) paper weights. 

Paper type 250- or 550-sheet tray Multipurpose feeder Duplex mode 

Plain paper 
   

Card stock X 
 

X 

Transparencies 
  

X 

Recycled 
   

Glossy paper X X X 

Paper labels
1
    

Vinyl labels X X X 

Bond
2
    

Envelope X 
 

X 

Rough envelope X 
 

X 

Letterhead 
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Paper type 250- or 550-sheet tray Multipurpose feeder Duplex mode 

Preprinted 
   

Colored Paper 
   

Light Paper 
   

Heavy Paper
2
    

Rough/Cotton X X X 

1
 One-sided paper labels designed for laser printers are supported for occasional use. It is recommended to print 20 

or fewer pages of paper labels per month. Vinyl, pharmacy, and two-sided labels are not supported. 

2
 Bond and Heavy Paper are supported in duplex mode up to 90-g/m

2
 (24-lb) paper weight. 
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6—Understanding the printer menus 

Menus list 

Paper Menu Reports Network/Ports 

Default Source 

Paper Size/Type 

Configure MP 

Substitute Size 

Paper Texture 

Paper Weight 

Paper Loading 

Custom Types 

Universal Setup 

Menu Settings Page 

Device Statistics 

Network Setup Page
1
 

Print Fonts 

Asset Report 

Active NIC 

Standard Network
2
 

Reports 

Network Card 

TCP/IP 

IPv6 

Wireless 

AppleTalk 

Standard USB 

SMTP Setup 

      

  

Security Settings 

Confidential Print 

Security Audit Log 

Set Date and Time 

General Settings 

Flash Drive Menu
3
 

Print Settings 

1
 Depending on the printer setup, this menu item appears as Network Setup Page. 

2
 Depending on the printer setup, this menu item appears as Standard Network. 

3
 This feature is available only for bizhub 4700P. 
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Paper menu 

Default Source menu 

Use To 

Default Source 

Tray [x] 

MP Feeder 

Manual Paper 

Manual Envelope 

Set a default paper source for all print jobs. 

Notes: 

• Tray 1 (standard tray) is the factory default setting. 

• From the Paper menu, set Configure MP to "Cassette" for MP Feeder 
to appear as a menu setting. 

• If two trays contain paper of the same size and type, and the trays 
have the same settings, then the trays are automatically linked. When 
one tray is empty, the print job continues using the linked tray. 
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Paper Size/Type menu 

Use To 

Tray [x] Size 

A4 

A5 

A6 

JIS-B5 

Letter 

Legal 

Executive 

Oficio (Mexico) 

Folio 

Statement 

Universal 

Specify the paper size loaded in each tray. 

Notes: 

• A4 is the factory default setting. 

• If two trays contain paper of the same size and type, and the trays 
have the same settings, then the trays are automatically linked. 
When one tray is empty, the print job continues using the linked tray. 

• The A6 paper size is supported only in Tray 1 and the multipurpose 
feeder. 

Tray [x] Type 

Plain Paper 

Transparency 

Recycled 

Labels 

Bond 

Letterhead 

Preprinted 

Colored Paper 

Light Paper 

Heavy Paper 

Rough/Cotton 

Custom Type [x] 

Specify the type of paper loaded in each tray. 

Notes: 

• Plain Paper is the factory default setting for Tray 1. 
Custom Type [x] is the factory default setting for all other trays. 

• If available, a user-defined name will appear instead of Custom 
Type [x]. 

• Use this menu to configure automatic tray linking. 
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Use To 

MP Feeder Size 

A4 

A5 

A6 

JIS B5 

Letter 

Legal 

Executive 

Oficio (Mexico) 

Folio 

Statement 

Universal 

7 3/4 Envelope 

9 Envelope 

10 Envelope 

DL Envelope 

C5 Envelope 

B5 Envelope 

Other Envelope 

Specify the paper size loaded in the multipurpose feeder. 

Notes: 

• A4 is the factory default setting. 

• From the Paper menu, set Configure MP to “Cassette” for MP 
Feeder Size to appear as a menu. 

• The multipurpose feeder does not automatically detect paper size. 
Make sure to set the paper size value. 

MP Feeder Type 

Plain Paper 

Card Stock 

Transparency 

Recycled 

Labels 

Bond 

Envelope 

Rough Envelope 

Letterhead 

Preprinted 

Colored Paper 

Light Paper 

Heavy Paper 

Rough/Cotton 

Custom Type [x] 

Specify the type of paper loaded in the multipurpose feeder. 

Notes: 

• Plain Paper is the factory default setting. 

• From the Paper menu, set Configure MP to “Cassette” for MP 
Feeder Type to appear as a menu. 
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Use To 

Manual Paper Size 

A4 

A5 

A6 

JIS B5 

Letter 

Legal 

Executive 

Oficio (Mexico) 

Folio 

Statement 

Universal 

Specify the paper size being manually loaded. 

Note: A4 is the factory default setting. 

Manual Paper Type 

Plain Paper 

Card Stock 

Transparency 

Recycled 

Labels 

Bond 

Letterhead 

Preprinted 

Colored Paper 

Light Paper 

Heavy Paper 

Rough/Cotton 

Custom Type [x] 

Specify the paper type being manually loaded. 

Notes: 

• Plain Paper is the factory default setting. 

• From the Paper menu, set Configure MP to “Manual” for Manual 
Paper Type to appear as a menu. 

Manual Envelope Size 

7 3/4 Envelope 

9 Envelope 

10 Envelope 

DL Envelope 

C5 Envelope 

B5 Envelope 

Other Envelope 

Specify the envelope size being manually loaded. 

Note: DL Envelope is the factory default setting. 
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Use To 

Manual Envelope Type 

Envelope 

Rough Envelope 

Custom Type [x] 

Specify the envelope type being manually loaded. 

Note: Envelope is the factory default setting. 

Note: Only installed trays and feeders are listed in this menu. 

  

Configure MP menu 

Use To 

Configure MP 

Cassette 

Manual 

First 

Determine when the printer selects paper from the multipurpose feeder. 

Notes: 

• Cassette is the factory default setting. Cassette configures the 
multipurpose feeder as the automatic paper source. 

• Manual sets the multipurpose feeder only for manual-feed print jobs. 

• First configures the multipurpose feeder as the primary paper source. 

  

Substitute Size menu 

Use To 

Substitute Size 

Off 

Statement/A5 

Letter/A4 

All Listed 

Substitute a specified paper size if the requested paper size is not 
available. 

Notes: 

• All Listed is the factory default setting. All available substitutions are 
allowed. 

• Off indicates that no size substitutions are allowed. 

• Setting a size substitution lets the print job continue without Change 
Paper appearing. 
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Paper Texture menu 

Use To 

Plain Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the plain paper loaded. 

Note: Normal is the factory default setting. 

Card Stock Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the card stock loaded. 

Notes: 

• Normal is the factory default setting. 

• The options appear only if card stock is supported. 

Transparency Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the transparencies loaded. 

Note: Normal is the factory default setting. 

Recycled Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the recycled paper loaded. 

Note: Normal is the factory default setting. 

Labels Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the labels loaded. 

Note: Normal is the factory default setting. 

Bond Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the bond paper loaded. 

Note: Rough is the factory default setting. 

Envelope Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the envelopes loaded. 

Note: Normal is the factory default setting. 

Rough Envelope Texture 

Rough 

Specify the relative texture of the rough envelopes loaded. 
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Use To 

Letterhead Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the letterhead loaded. 

Note: Normal is the factory default setting. 

Preprinted Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the preprinted paper loaded. 

Note: Normal is the factory default setting. 

Colored Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the colored paper loaded. 

Note: Normal is the factory default setting. 

Light Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the paper loaded. 

Note: Normal is the factory default setting. 

Heavy Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the paper loaded. 

Note: Normal is the factory default setting. 

Rough/Cotton Texture 

Rough 

Specify the relative texture of the cotton paper loaded. 

Custom [x] Texture 

Smooth 

Normal 

Rough 

Specify the relative texture of the custom paper loaded. 

Notes: 

• Normal is the factory default setting. 

• The options appear only if the custom type is supported. 
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Paper Weight menu 

Use To 

Plain Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the plain paper loaded. 

Note: Normal is the factory default setting. 

Card Stock Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the card stock loaded. 

Note: Normal is the factory default setting. 

Transparency Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the transparencies loaded. 

Note: Normal is the factory default setting. 

Recycled Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the recycled paper loaded. 

Note: Normal is the factory default setting. 

Labels Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the labels loaded. 

Note: Normal is the factory default setting. 

Bond Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the bond paper loaded. 

Note: Normal is the factory default setting. 

Envelope Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the envelope loaded. 

Note: Normal is the factory default setting. 
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Use To 

Rough Envelope Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the rough envelope loaded. 

Note: Normal is the factory default setting. 

Letterhead Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the letterhead loaded. 

Note: Normal is the factory default setting. 

Preprinted Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the preprinted paper loaded. 

Note: Normal is the factory default setting. 

Colored Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the colored paper loaded. 

Note: Normal is the factory default setting. 

Light Weight 

Light 

Specify that the weight of the paper loaded is light. 

Heavy Weight 

Heavy 

Specify that the weight of the paper loaded is heavy. 

Rough/Cotton Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the cotton or rough paper loaded. 

Note: Heavy is the factory default setting. 

Custom [x] Weight 

Light 

Normal 

Heavy 

Specify the relative weight of the custom paper loaded. 

Notes: 

• Normal is the factory default setting. 

• The options appear only when the custom type is supported. 
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Paper Loading menu 

Use  To 

Recycled Loading 

Duplex 

Off 

Determine and set two-sided printing for all print jobs that specify 
Recycled as the paper type. 

Bond Loading 

Duplex 

Off 

Determine and set two-sided printing for all print jobs that specify 
Bond as the paper type. 

Letterhead Loading 

Duplex 

Off 

Determine and set two-sided printing for all print jobs that specify 
Letterhead as the paper type. 

Preprinted Loading 

Duplex 

Off 

Determine and set two-sided printing for all print jobs that specify 
Preprinted as the paper type. 

Colored Loading 

Duplex 

Off 

Determine and set two-sided printing for all print jobs that specify 
Colored as the paper type. 

Light Loading 

Duplex 

Off 

Determine and set two-sided printing for all print jobs that specify 
Light as the paper type. 

Heavy Loading 

Duplex 

Off 

Determine and set two-sided printing for all print jobs that specify 
Heavy as the paper type. 

Custom [x] Loading 

Duplex 

Off 

Determine and set two-sided printing for all print jobs that specify 
Custom [x] as the paper type. 

Note: Custom [x] Loading is available only if the custom type is 
supported. 

Notes: 

• Duplex sets two-sided printing as the default for all print jobs unless one-sided printing is set from Printing 
Preferences or Print dialog. 

• If Duplex is selected, then all print jobs are sent through the duplex unit, including one-sided jobs. 

• Off is the factory default setting for all the menus. 
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Custom Types menu 

Use To 

Custom Type [x] 

Paper 

Card Stock 

Transparency 

Rough/Cotton 

Labels 

Envelope 

Associate a paper or specialty media type with a factory default Custom 
Type [x] name or a user-defined custom name created in the Embedded 
Web Server. The user-defined name appears instead of Custom Type [x]. 

Notes: 

• Paper is the factory default setting for Custom Type [x]. 

• The custom media type must be supported in the selected tray or 
feeder in order to print from that source. 

Recycled 

Paper 

Card Stock 

Transparency 

Rough/Cotton 

Labels 

Envelope 

Cotton 

Specify a paper type when the Recycled setting is selected in other 
menus. 

Notes: 

• Paper is the factory default setting. 

• The Recycled paper type must be supported in the selected tray or 
feeder in order to print from that source. 
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Universal Setup menu 

Use To 

Units of Measure 

Inches 

Millimeters 

Identify the units of measure. 

Notes: 

• Inches is the US default setting. 

• Millimeters is the Non-US default setting. 

Portrait Width 

3–8.5 inches 

76–216 mm 

Set the portrait width. 

Notes: 

• If the width exceeds the maximum, then the printer uses the 
maximum width allowed. 

• 8.5 inches is the US default setting. You can increase the width in 
0.01-inch increments. 

• 216 mm is the Non-US default setting. You can increase the 
width in 1-mm increments. 

Portrait Height 

3–14.17 inches 

76–360 mm 

Set the portrait height. 

Notes: 

• If the height exceeds the maximum, then the printer uses the 
maximum height allowed. 

• 14 inches is the US default setting. You can increase the height 
in 0.01-inch increments. 

• 356 mm is the Non-US default setting. You can increase the 
height in 1-mm increments. 
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Reports menu 

Reports menu 

Use To 

Menu Settings Page Print a report containing information about the paper loaded in trays, 
installed memory, total page count, alarms, timeouts, printer control panel 
language, TCP/IP address, status of supplies, status of the network 
connection, and other information. 

Device Statistics Print a report containing printer statistics such as supply information and 
details about printed pages. 

Network Setup Page Print a report containing information about the network printer settings, such 
as the TCP/IP address information. 

Note: This menu item appears only in network printers or in printers 
connected to print servers. 

Print Fonts 

PCL Fonts 

PostScript Fonts 

Print a report of all the fonts available for the printer language currently set 
in the printer. 

Note: A separate list is available for PCL and PostScript emulations. 

Asset Report Print a report containing printer asset information, such as serial number 
and model name. 
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Network/Ports menu 

Active NIC menu 

Use To 

Active NIC 

Auto 

[list of available network cards] 

Notes: 

• Auto is the factory default setting. 

• This menu item appears only when an optional network card is installed. 

Standard Network menus 

Note: Only active ports appear in this menu. All inactive ports are omitted. 

Use To 

PCL SmartSwitch 

On 

Off 

Set the printer to automatically switch to PCL emulation when a print job 
requires it, regardless of the default printer language. 

Notes: 

• On is the factory default setting. 

• When Off is used, the printer does not examine incoming data. The printer 
uses PostScript emulation if PS SmartSwitch is set to On. It uses the 
default printer language specified in the Setup menu if PS SmartSwitch is 
set to Off. 

PS SmartSwitch 

On 

Off 

Set the printer to automatically switch to PS emulation when a print job requires 
it, regardless of the default printer language. 

Notes: 

• On is the factory default setting. 

• When Off is used, the printer does not examine incoming data. The printer 
uses PCL emulation if PCL SmartSwitch is set to On. It uses the default 
printer language specified in the Setup menu if PCL SmartSwitch is set to 
Off. 

NPA Mode 

Off 

Auto 

Set the printer to perform the special processing required for bidirectional 
communication following the conventions defined by the NPA protocol. 

Notes: 

• Auto is the factory default setting. 

• Changing this setting from the printer control panel and then exiting the 
menus causes the printer to restart. The menu selection is then updated. 
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Use To 

Network Buffer 

Auto 

3KB to [maximum size 
allowed] 

Set the size of the network input buffer. 

Notes: 

• Auto is the factory default setting. 

• The value can be changed in 1-KB increments. 

• The maximum size allowed depends on the amount of memory in the 
printer, the size of the other link buffers, and whether Resource Save is set 
to On or Off. 

• To increase the maximum size range for the Network Buffer, disable or 
reduce the size of the USB buffers. 

• Changing this setting from the printer control panel and then exiting the 
menus causes the printer to restart. The menu selection is then updated. 

Mac Binary PS 

On 

Off 

Auto 

Set the printer to process Macintosh binary PostScript print jobs. 

Notes: 

• Auto is the factory default setting. 

• Off filters print jobs using the standard protocol. 

• On processes raw binary PostScript print jobs. 

STD NET SETUP 

Reports 

Network Card 

TCP/IP 

IPv6 

Wireless 

AppleTalk 

Display and set the printer network settings. 

Note: The Wireless menu appears only when the printer is connected to a 
wireless network. 

  

Reports menu 

To access the menu, navigate to any of the following: 

• Network/Ports menu >Networks/Ports >Standard Network >STD NET SETUP >Reports 

Use To 

Print Setup 
Page 

Print a report containing information about the network printer settings, such as the TCP/IP 
address. 
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Network Card menu 

To access the menu, navigate to either of the following: 

• Network/Ports >Standard Network >STD NET SETUP >Network Card 

Use To 

View Card Status 

Connected 

Disconnected 

View the connection status of the network card. 

View Card Speed View the speed of an active network card. 

Network Address 

UAA 

LAA 

View the network addresses. 

Job Timeout 

0–255 seconds 

Set the amount of time it takes for a network print job to be canceled. 

Notes: 

• 90 seconds is the factory default setting. 

• A setting value of 0 disables the timeout. 

• If a value of 1–9 is selected, then the setting is saved as 10. 

Banner Page 

Off 

On 

Set the Banner Page. 

Note: Off is the factory default setting. 

  

TCP/IP menu 

To access the menu, navigate to any of the following: 

• Network/Ports >Standard Network >STD NET SETUP >TCP/IP 

Note: This menu is available only in network printers or printers connected to print servers. 
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Use To 

Set Hostname Set the Hostname. 

IP Address View or change the current TCP/IP address. 

Note: Manually setting the IP address sets the Enable DHCP and Enable Auto IP 
settings to Off. It also sets Enable BOOTP and Enable RARP to Off on systems 
that support BOOTP and RARP. 

Netmask View or change the current TCP/IP netmask. 

Gateway View or change the current TCP/IP gateway. 

Enable DHCP 

On 

Off 

Specify the DHCP address and parameter assignment. 

Note: On is the factory default setting. 

Enable AutoIP 

Yes 

No 

Specify the Zero Configuration Networking setting. 

Note: Yes is the factory default setting. 

Enable FTP/TFTP 

Yes 

No 

Enable the built-in FTP server, which lets you send files to the printer using File 
Transfer Protocol. 

Note: Yes is the factory default setting. 

Enable HTTP Server 

Yes 

No 

Enable the built-in Web server (Embedded Web Server). When enabled, the 
printer can be monitored and managed remotely using a Web browser. 

Note: Yes is the factory default setting. 

WINS Server Address View or change the current WINS server address. 

Enable DDNS 

Yes 

No 

View or change the current DDNS setting. 

Note: Yes is the factory default setting. 

Enable mDNS 

Yes 

No 

View or change the current mDNS setting. 

Note: Yes is the factory default setting. 

DNS Server Address View or change the current DNS server address. 

Backup DNS Server Address View or change the backup DNS server addresses. 

Backup DNS Server Address 2 
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Use To 

Backup DNS Server Address 3 

Enable HTTPS 

Yes 

No 

View or change the current HTTPS setting. 

Note: Yes is the factory default setting. 

  

IPv6 menu 

To access the menu, navigate to any of the following: 

• Network/Ports >Standard Network >STD NET SETUP >IPv6 

Note: This menu is available only in network printers or printers connected to print servers. 

Use To 

Enable IPv6 

On 

Off 

Enable Internet Protocol Version Six (IPv6) in the printer. 

IPv6 uses bigger numbers to create IP addresses. 

Note: On is the factory default setting. 

Auto Configuration 

On 

Off 

Specify whether or not the network adapter accepts the automatic 
IPv6 address configuration entries provided by a router. 

Note: On is the factory default setting. 

Set Hostname
*
 Set the Hostname. 

View Address
*
 View the current IPv6 addresses. 

View Router Address
*
 View the current router address. 

Enable DHCPv6 

On 

Off 

Enable DHCPv6 in the printer. 

Note: On is the factory default setting. 

*
 These settings can be changed only from the Embedded Web Server. 
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Wireless menu 

Note: This menu is available only in printer models connected to a wireless network. 

To access the menu, navigate to any of the following: 

• Network/Ports >Standard Network >STD NET SETUP >Wireless 

Use To 

Wi-Fi Protected Setup (WPS) 

Start Push Button Method 

Start PIN Method 

Establish a wireless network and enable network security. 

Notes: 

• Start Push Button Method connects the printer to a wireless 
network by pressing buttons on both the printer and the access 
point (wireless router) within a given period of time. 

• Start PIN Method connects the printer to a wireless network by 
using a PIN on the printer and entering it into the wireless 
settings of the access point. 

Enable/Disable WPS Auto-detection 

Enable 

Disable 

Automatically detect the connection method that an access point with 
WPS uses—Start Push Button Method or Start PIN Method. 

Notes: 

• Disable is the factory default setting. 

• bizhub 4700P only 

Network Mode 

Infrastructure 

Ad hoc 

Specify the network mode. 

Notes: 

• Ad hoc is the factory default setting. This configures wireless 
connection directly between the printer and a computer. 

• Infrastructure lets the printer access a network using an access 
point. 

• Ad hoc is the factory default setting. 

Compatibility 

802.11b/g 

802.11b/g/n 

Specify the wireless standard for the wireless network. 

Note: The 802.11b/g/n is the factory default setting. 

Choose Network Select an available network for the printer to use. 

View Signal Quality View the quality of the wireless connection. 

View Security Mode View the encryption method for the wireless network. 
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AppleTalk menu 

Note: This menu is available only in printer models connected to a wired network or when an optional 
network card is installed. 

To access the menu, navigate to any of the following: 

• Network/Ports >Standard Network >STD NET SETUP >AppleTalk 

Use To 

Activate 

Yes 

No 

Enable or disable AppleTalk support. 

Note: Yes is the factory default setting. 

View Name Show the assigned AppleTalk name. 

Note: The name can be changed only from the Embedded Web Server. 

View Address Show the assigned AppleTalk address. 

Note: The address can be changed only from the Embedded Web Server. 

Set Zone 

[list of zones available on the 
network] 

Provide a list of AppleTalk zones available on the network. 

Note: The factory default setting is the default zone for the network. If no 
default zone exists, then the zone marked with an asterisk (*) is the default 
setting. 
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Standard USB menu 

Use To 

PCL SmartSwitch 

On 

Off 

Set the printer to automatically switch to PCL emulation when a print job 
received through a USB port requires it, regardless of the default printer 
language. 

Notes: 

• On is the factory default setting. 

• When set to Off, the printer does not examine incoming data. The printer 
uses PostScript emulation if the PS SmartSwitch is set to On. It uses the 
default printer language specified in the Setup menu if the PS SmartSwitch 
is set to Off. 

PS SmartSwitch 

On 

Off 

Set the printer to automatically switch to PS emulation when a print job received 
through a USB port requires it, regardless of the default printer language. 

Notes: 

• On is the factory default setting. 

• When set to Off, the printer does not examine incoming data. The printer 
uses PCL emulation if the PCL SmartSwitch is set to On. It uses the default 
printer language specified in the Setup menu if the PCL SmartSwitch is set 
to Off. 

NPA Mode 

On 

Off 

Auto 

Set the printer to perform the special processing required for bidirectional 
communication following the conventions defined by the NPA protocol. 

Notes: 

• Auto is the factory default setting. Auto sets the printer to examine data, 
determine the format, and then process it appropriately. 

• The printer automatically restarts when changing the setting from the printer 
control panel. The menu selection is then updated. 

USB Buffer 

Disabled 

Auto 

3K to [maximum size 
allowed] 

Set the size of the USB input buffer. 

Notes: 

• Auto is the factory default setting. 

• The USB buffer size value can be changed in 1-K increments. 

• The maximum size allowed depends on the amount of memory in the 
printer, the size of the other link buffers, and whether Resource Save is set 
to On or Off. 

• To increase the maximum size range for the USB Buffer, disable or reduce 
the size of the network buffers. 

• The printer automatically restarts when the setting is changed from the 
printer control panel. The menu selection is then updated. 



User's Guide 

 
- 102 - 

Use To 

Mac Binary PS 

On 

Off 

Auto 

Set the printer to process Macintosh binary PostScript print jobs. 

Notes: 

• Auto is the factory default setting. 

• On processes raw binary PostScript print jobs. 

• Off filters print jobs using the standard protocol. 

ENA Address 

yyy.yyy.yyy.yyy 

Set the network address information for an external print server. 

Note: This menu is available only when the printer is attached to an external 
print server through the USB port. 

ENA Netmask 

yyy.yyy.yyy.yyy 

Set the netmask information for an external print server. 

Note: This menu is available only when the printer is attached to an external 
print server through the USB port. 

ENA Gateway 

yyy.yyy.yyy.yyy 

Set the gateway information for an external print server. 

Note: This menu is available only when the printer is attached to an external 
print server through the USB port. 

SMTP Setup menu 

Use To 

Primary SMTP Gateway Specify SMTP server gateway and port information. 

Note: 25 is the default SMTP gateway port. 
Primary SMTP Gateway Port 

Secondary SMTP Gateway 

Secondary SMTP Gateway Port 

SMTP Timeout 

5–30 

Specify the amount of time in seconds before the server stops trying 
to send an e-mail. 

Note: 30 seconds is the factory default setting. 

Reply Address Specify a reply address of up to 128 characters in the e-mail sent by 
the printer. 
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Use To 

Use SSL 

Disabled 

Negotiate 

Required 

Set the printer to use SSL for increased security when connecting to 
the SMTP server. 

Notes: 

• Disabled is the factory default setting. 

• When the Negotiate setting is used, the SMTP server determines 
if SSL will be used. 

SMTP Server Authentication 

No authentication required 

Login/Plain 

CRAM-MD5 

Digest-MD5 

NTLM 

Kerberos 5 

Specify the type of user authentication required for printing privileges. 

Note: “No authentication required” is the factory default setting. 

Device-Initiated E-mail 

None 

Use Device SMTP Credentials 

Specify what credentials will be used when communicating to the 
SMTP server. Some SMTP servers require credentials to send an e-
mail. 

Notes: 

• None is the factory default setting for Device-Initiated E-mail. 

• Device Userid and Device Password are used to log in to the 
SMTP server when Use Device SMTP Credentials is selected. 

Device Userid 

Device Password 

Kerberos 5 Realm 

NTLM Domain 
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Security menu 

Confidential Print menu 

Use To 

Confidential Job 
Expiration 

Off 

1 hour 

4 hours 

24 hours 

1 week 

Limit the amount of time a confidential print job stays in the printer before it is deleted. 

Notes: 

• If the “Confidential Job Expiration” setting is changed while confidential print jobs reside in 
the printer RAM, then the expiration time for those print jobs does not change to the new 
default value. 

• If the printer is turned off, then all confidential jobs held in the printer RAM are deleted. 

Repeat Job 
Expiration 

Off  

1 hour 

4 hours 

24 hours 

1 week 

Set a time limit on how long the printer stores print jobs. 

Verify Job 
Expiration 

Off 

1 hour 

4 hours 

24 hours 

1 week 

Set a time limit on how long the printer stores print jobs needing verification. 

Reserve Job 
Expiration 

Off 

1 hour 

4 hours 

24 hours 

1 week 

Set a time limit on how long the printer stores print jobs for printing at a later time. 

Note: Off is the factory default setting. 
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Security Audit Log menu 

Use To 

Export Log Let an authorized user export the audit log. 

Notes: 

• To export the audit log from the printer control panel, connect a flash drive 
to the printer. 

• You can also download the audit log from the Embedded Web Server, and 
then save it on your computer. 

Delete Log 

Delete now 

Do not delete 

Specify whether or not audit logs are deleted. 

Note: Delete now is the factory default setting. 

Configure Log 

Enable Audit 

Yes 

No 

Enable Remote Syslog 

No 

Yes 

Remote Syslog Facility 

0–23 

Severity of events to log 

0–7 

Specify how and whether or not audit logs are created. 

Notes: 

• Enable Audit determines if events are recorded in the secure audit log and 
remote syslog. No is the factory default setting. 

• Enable Remote Syslog determines if logs are sent to a remote server. No is 
the factory default setting. 

• Remote Syslog Facility determines the value used to send logs to the 
remote syslog server. 4 is the factory default setting. 

• If the security audit log is activated, then the severity value of each event is 
recorded. 4 is the factory default setting. 
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Set Date and Time menu 

Use To 

Current Date and Time Show the current date and time settings for the printer. 

Manually Set Date and Time 

[input date/time] 

Enter the date and time. 

Notes: 

• Manually setting the date and time sets Enable NTP to No. 

• The wizard lets you set the date and time in YYYY-MM-DD-HH:MM format. 

Automatically Observe DST 

On 

Off 

Set the printer to use the applicable daylight saving time (DST) start and end 
times associated with the printer Time Zone setting. 

Note: On is the factory default setting. 

Enable NTP 

On 

Off 

Enable Network Time Protocol, which synchronizes the clocks of devices on a 
network. 

Notes: 

• On is the factory default setting. 

• The setting is turned off if you manually set the date and time. 

  



User's Guide 

 
- 107 - 

Settings menu 

General Settings 

General Settings menu 

Use To 

Display Language 

English 

Francais 

Deutsch 

Italiano 

Espanol 

Dansk 

Norsk 

Nederlands 

Svenska 

Portuguese 

Suomi 

Russian 

Polski 

Greek 

Magyar 

Turkce 

Cesky 

Simplified Chinese 

Traditional Chinese 

Korean 

Japanese 

Set the language of the text appearing on the printer display. 

Note: Not all languages are available for all printers. 

Show Supply Estimates 

Show estimates 

Do not show estimates 

Display the estimates of the supplies on the printer control 
panel, Embedded Web Server, menu settings, and the device 
statistics reports. 

Eco-Mode 

Off 

Energy 

Energy/Paper 

Paper 

Set the Eco Mode. 

Note: Off is the factory default setting. 
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Use To 

Quiet Mode 

Off 

On 

Set the Quiet Mode. 

Note: Off is the factory default setting. 

Run Initial setup 

Yes 

No 

Instruct the printer to run the setup wizard. 

Notes: 

• Yes is the factory default setting. 

• After completing the setup wizard by selecting Done at the 
Country select screen, the default becomes No. 

Paper Sizes 

US 

Metric 

Specify the unit of measurement for paper sizes. 

Notes: 

• US is the factory default setting. 

• The initial setting is determined by your country or region 
selection in the initial setup wizard. 

Home screen customization 

Change Language 

Search Held Jobs 

Held Jobs 

USB Drive 

Profiles and Solutions 

Bookmarks 

Jobs by user 

Forms and Favorites 

Eco-Settings 

Showroom 

Change Background 

Change the icons and buttons that appear on the home 
screen. 

For each icon or button, select from the following options: 

Display 

Do not display 

Notes: 

• “Display” is the factory default setting for Search Held 
Jobs, Held Jobs, USB Drive, Forms and Favorites, Eco-
Settings, Showroom, and Change Background. 

• “Do not display” is the factory default setting for Change 
Language, Profiles and Solutions, Bookmarks, and Jobs 
by user. 

• “Bookmarks” appears inside Held Jobs only if Show 
Bookmarks is set to Yes and an active network cable is 
attached. 
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Use To 

Timeouts 

Sleep Mode 

Disabled 

1–180min 

Set the amount of time the printer waits after a job is printed 
before it goes into a reduced power state. 

Notes: 

• “30 min” is the factory default setting. 

• “Disabled” appears only when Energy Conserve is set to 
Off. 

• Lower settings conserve more energy, but may require 
longer warm-up times. 

• Select a high setting if the printer is in constant use. Under 
most circumstances, this keeps the printer ready to print 
with minimum warm-up time. 

Timeouts 

Hibernate Timeout 

Disabled 

1 hour 

2 hours 

3 hours 

6 hours 

1 day 

2 days 

3 days 

1 week 

2 weeks 

1 month 

Set the amount of time the printer waits before it enters 
Hibernate mode. 

Note: “3 hours” is the factory default setting. 

Timeouts 

Screen Timeout 

15–300 sec 

Set the amount of time in seconds the printer waits before 
returning the display to the ready state. 

Note: “30 sec” is the factory default setting. 
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Use To 

Timeouts 

Print Timeout 

Disabled 

1–255 sec 

Set the amount of time in seconds the printer waits to receive 
an end-of-job message before canceling the remainder of the 
print job. 

Notes: 

• “90 sec” is the factory default setting. 

• When the timer expires, any partially printed page still in 
the printer is printed. 

• Print Timeout is available only when using PCL emulation. 
This setting has no effect on PostScript emulation print 
jobs. 

Timeouts 

Wait Timeout 

Disabled 

15–65535 sec 

Set the amount of time in seconds the printer waits for 
additional data before canceling a print job. 

Notes: 

• “40 sec” is the factory default setting. 

•  This setting has no effect on PCL emulation print jobs. 

Error Recovery 

Auto Reboot 

Reboot when idle 

Reboot always 

Reboot never 

Set the Auto Reboot. 

Note: Reboot always is the factory default setting. 

Error Recovery 

Max Auto Reboots 

1–20 

Set the Max Auto Reboot. 

Notes: 

• If the device performs a number of automatic reboots 
equal to this setting’s value within a certain amount of 
time, then the device displays the applicable error instead 
of rebooting again.  

• 5 is the factory default setting. 

Print Recovery 

Auto Continue 

Disabled 

5–255 sec 

Let the printer automatically continue printing from certain 
offline situations when these are not resolved within the 
specified time period. 

Note: Disabled is the factory default setting. 
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Use To 

Print Recovery 

Jam Recovery 

On 

Off 

Auto 

Specify whether the printer reprints jammed pages. 

Notes: 

• Auto is the factory default setting. The printer reprints 
jammed pages unless the memory required to hold the 
pages is needed for other printer tasks. 

• On sets the printer to always reprint jammed pages. 

• Off sets the printer to never reprint jammed pages. 

Print Recovery 

Jam Assist 

On 

Off 

Notes: 

• On is the factory default setting. On sets the printer to 
automatically dump or partially printed pages to the 
standard bin after a jammed page has been cleared. 

• Off requires the user to remove all pages from all possible 
jam locations. 

Print Recovery 

Page Protect 

Off 

On 

Let the printer successfully print a page that may not have 
printed otherwise. 

Notes: 

• Off is the factory default setting. Off prints a partial page 
when there is not enough memory to print the whole page. 

• On sets the printer to process the whole page so that the 
entire page prints. 

Hibernate Timeout on Connection 

Hibernate 

Do Not Hibernate 

Set the printer to hibernate mode even there is an active 
Ethernet connection. 

Notes: 

• Hibernate is the factory default setting for EU. 

• Do Not Hibernate is the factory default setting for non-EU. 

Press Sleep Button 

Do nothing 

Sleep 

Determine how the printer, while in idle state, reacts to a short 
press of the Sleep button. 

Note: Sleep is the factory default setting. 

Press and Hold Sleep Button 

Do nothing 

Sleep 

Determine how the printer, while in idle state, reacts to a long 
press of the Sleep button. 

Note: “Do nothing” is the factory default setting. 
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Use To 

Factory Defaults 

Do Not Restore 

Restore Now 

Return the printer settings to the factory default settings. 

Notes: 

• Do Not Restore is the factory default setting. Do Not 
Restore keeps the user-defined settings. 

• All downloads stored in the RAM are deleted. Downloads 
stored in the flash memory are not affected. 

Custom Home Message 

Off 

IP Address 

Hostname 

Contact Name 

Location 

Zero Configuration Name 

Custom Text [x] 

Select a custom home message that appears as an alternating 
display of the printer status. 

Note: Off is the factory default setting. 

Export Configuration Package Note: A user cannot export the configuration package unless a 
USB thumb drive is attached to the device. 
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Flash Drive (For bizhub 4700P only) 

Flash Drive menu 

Use To 

Copies 

1–999 

Specify a default number of copies for each print job. 

Note: 1 is the factory default setting. 

Paper Source 

Tray [x] 

MP Feeder 

Manual Paper 

Manual Envelope 

Set a default paper source for all print jobs. 

Note: Tray 1 (standard tray) is the factory default setting. 

Collate 

Off (1,1,1,2,2,2) 

On (1,2,1,2,1,2) 

Stack the pages of a print job in sequence when printing multiple copies. 

Note: On is the factory default setting. 

Sides (Duplex) 

1 sided 

2 sided 

Specify whether prints are on one side or on both sides of the paper. 

Note: 1 sided is the factory default setting. 

Duplex Binding 

Long Edge 

Short Edge 

Define binding for duplexed pages in relation to paper orientation. 

Notes: 

• Long Edge is the factory default setting. Long Edge assumes binding along 
the long edge of the page (left edge for portrait and top edge for 
landscape). 

• Short Edge assumes binding along the short edge of the page (top edge for 
portrait and left edge for landscape). 

Paper Saver 

Off 

2-Up 

3-Up 

4-Up 

6-Up 

9-Up 

12-Up 

16-Up 

Specify that multiple-page images be printed on one side of a paper. 

Notes: 

• Off is the factory default setting. 

• The number selected is the number of page images that will print per side. 
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Use To 

Paper Saver Ordering 

Horizontal 

Reverse Horizontal 

Reverse Vertical 

Vertical 

Specify the positioning of multiple-page images. 

Notes: 

• Horizontal is the factory default setting. 

• Positioning depends on the number of page images and whether they are 
in portrait or landscape orientation. 

Paper Saver Orientation 

Auto 

Landscape 

Portrait 

Specify the orientation of a multiple-page document. 

Note: Auto is the factory default setting. The printer chooses between portrait 
and landscape. 

Paper Saver Border 

None 

Solid 

Print a border on each page image. 

Note: None is the factory default setting. 

Separator Sheets 

Off 

Between Copies 

Between Jobs 

Between Pages 

Specify whether blank separator sheets are inserted. 

Notes: 

• Off is the factory default setting. No separator sheets are included in the 
print job. 

• Between Copies inserts a blank sheet between each copy of a print job if 
Collate is set to On. If Collate is set to Off, then a blank page is inserted 
between each set of printed pages, such as after all page 1's and after all 
page 2's. 

• Between Jobs inserts a blank sheet between print jobs. 

• Between Pages inserts a blank sheet between each page of the print job. 
This setting is useful when printing transparencies or inserting blank pages 
in a document for notes. 

Separator Sheet Source 

Tray [x] 

Manual Feeder 

Specify the paper source for separator sheets. 

Notes: 

• Tray 1 (standard tray) is the factory default setting. 

• From the Paper menu, Configure MP must be set to Cassette in order for 
Manual Feeder to appear as a menu setting. 

Blank Pages 

Do Not Print 

Print 

Specify whether blank pages are inserted in a print job. 

Note: Do Not Print is the factory default setting. 
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Print Settings 

Setup menu 

Use To 

Printer Language 

PCL Emulation 

PS Emulation 

PPDS Emulation 

Set the default printer language. 

Notes: 

• PCL Emulation is the factory default setting. 

• PostScript emulation uses a PostScript interpreter for 
processing print jobs. 

• PCL Emulation uses a PCL interpreter for processing print 
jobs. 

• Setting a printer language default does not prevent a 
software program from sending print jobs that use another 
printer language. 

Print Area 

Normal 

Whole Page 

Set the logical and physical printable area. 

Notes: 

• Normal is the factory default setting. When attempting to 
print data in the non-printable area defined by the Normal 
setting, the printer clips the image at the boundary. 

• Whole Page allows the image to be moved into the non-
printable area defined by the Normal setting. This setting 
affects only pages printed using a PCL 5e interpreter and 
has no effect on pages printed using the PCL XL or 
PostScript interpreter. 

Download Target 

Flash 

Set the storage location for downloads. 

Notes: 

• Storing downloads in a flash memory places them in 
permanent storage. Downloads remain in the flash 
memory even when the printer is turned off. 

• This menu item appears only when a flash option is 
installed. 
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Use To 

Resource Save 

On 

Off 

Specify how the printer handles temporary downloads, such as 
fonts and macros stored in the RAM, when the printer receives 
a print job that requires more memory than is available. 

Notes: 

• Off is the factory default setting. Off sets the printer to 
retain downloads only until memory is needed. Downloads 
are deleted in order to process print jobs. 

• On sets the printer to retain downloads during language 
changes and printer resets. If the printer runs out of 
memory, then Memory Full 38 appears on the printer 
display, but downloads are not deleted. 

Finishing menu 

Use To 

Sides (Duplex) 

1 sided 

2 sided 

Specify whether two-sided (duplex) printing is set as the default for all print jobs. 

Notes: 

• “1 sided” is the factory default setting. 

• You can set two-sided printing from the software program. 

For Windows users: 

1. Click File >Print. 

2. Click Properties, Preferences, Options, or Setup. 

For Macintosh users: 

1. Choose File >Print. 

2. Adjust the settings from the print dialog and pop-up menus. 

Duplex Binding 

Long Edge 

Short Edge 

Define the way two-sided pages are bound and printed. 

Notes: 

• Long Edge is the factory default setting. Long Edge binds pages along their 
long edge (left edge for portrait and top edge for landscape). 

• Short Edge binds pages along their short edge (top edge for portrait and 
left edge for landscape). 

Copies 

1–999 

Specify the default number of copies for each print job. 

Note: 1 is the factory default setting. 
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Use To 

Blank Pages 

Do Not Print 

Print 

Specify whether to insert blank pages in a print job. 

Note: Do Not Print is the factory default setting. 

Collate 

(1,1,1) (2,2,2) 

(1,2,3) (1,2,3) 

Stack the pages of a print job in sequence when printing multiple copies. 

Note: “(1,2,3) (1,2,3)” is the factory default setting. 

Separator Sheets 

Off 

Between Copies 

Between Jobs 

Between Pages 

Specify whether to insert blank separator sheets. 

Notes: 

• Off is the factory default setting. 

• Between Copies inserts a blank sheet between each copy of a print job if 
Collate is set to (1,1,1) (2,2,2). If Collate is set to (1,2,3) (1,2,3), then a 
blank page is inserted between each set of printed pages, such as after all 
page 2's and after all page 3's. 

• Between Jobs inserts a blank sheet between print jobs. 

• Between Pages inserts a blank sheet between each page of a print job. 
This setting is useful when printing transparencies or when inserting blank 
pages in a document. 

Separator Source 

Tray [x] 

Multi-Purpose Feeder 

Specify the paper source for separator sheets. 

Note: Tray 1 (standard tray) is the factory default setting. 

Paper Saver 

Off 

2-Up 

3-Up 

4-Up 

6-Up 

9-Up 

12-Up 

16-Up 

Print multiple-page images on one side of a paper. 

Notes: 

• Off is the factory default setting. 

• The number selected is the number of page images that will print per side. 

Paper Saver Ordering 

Horizontal 

Reverse Horizontal 

Reverse Vertical 

Vertical 

Specify the positioning of multiple-page images when using Paper Saver. 

Notes: 

• Horizontal is the factory default setting. 

• Positioning depends on the number of page images and whether they are 
in portrait or landscape orientation. 
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Use To 

Paper Saver Orientation 

Auto 

Landscape 

Portrait 

Specify the orientation of a multiple-page document. 

Note: Auto is the factory default setting. The printer chooses between portrait 
and landscape. 

Paper Saver Border 

None 

Solid 

Print a border when using Paper Saver. 

Note: None is the factory default setting. 

Quality menu 

Use To 

Print Resolution 

300 dpi 

600 dpi 

1200 dpi 

1200 Image Q 

2400 Image Q 

Specify the printed output resolution in dots per inch. 

Note: 600 dpi is the factory default setting. 

Pixel Boost 

Off 

Fonts 

Horizontally 

Vertically 

Both directions 

Isolated 

Enable more pixels to print in clusters for clarity, in order to enhance images 
horizontally or vertically, or to enhance fonts. 

Note: Off is the factory default setting. 

Toner Darkness 

1–10 

Lighten or darken the printed output. 

Notes: 

• 8 is the factory default setting. 

• Selecting a smaller number can help conserve toner. 
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Use To 

Enhance Fine Lines 

On 

Off 

Enable a print mode preferable for files such as architectural drawings, maps, 
electrical circuit diagrams, and flow charts. 

Notes: 

• Off is the factory default setting. 

• To set this option using the Embedded Web Server, type the network printer 
IP address in the Web browser address field. 

Gray Correction 

Auto 

Off 

Automatically adjust the contrast enhancement applied to images. 

Note: Auto is the factory default setting. 

Brightness 

-6 to 6 

Adjust the printed output either by lightening or darkening it. You can conserve 
toner by lightening the output. 

Note: 0 is the factory default setting. 

Contrast 

0–5 

Adjust the contrast of printed objects. 

Note: 0 is the factory default setting. 

Job Accounting menu 
 

Notes: 

• This menu appears only when Upgrade Kit 256MB User Flash (Option:UK-P01) is installed. 

• You can maintain the statistics on Job Account by using PageScope Account Manager. PageScope Account 
Manager (charged) must be installed to be able to maintain the statistics on Job Account, and this machine must 
be specified as the target device. 

• We recommend that you set the administrator password on the Embedded Web Server if you are using the Job 
Accounting menu. 

Use To 

Job Accounting Log 

On 

Off 

Specify whether to record a received print job. 

Note: Off is the factory default setting. 

Accounting Log Frequency 

Daily 

Weekly 

Monthly 

Specify the cycle to update the log file.  

Notes: 

• Monthly is the factory default setting. 

• Weekly begins on Monday at 12:00 AM and ends on Sunday at 11:59 
PM.  

• Monthly begins at 12:00 AM on the first day of the month and ends at 
11:59 PM on the last day of the month. 
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Use To 

Log Action at End of Frequency 

None 

Email Current Log 

Email & Delete Current Log 

Post Current Log 

Post & Delete Current Log 

Specify how the printer operates at the end of the log file update cycle. 

Note: None is the factory default setting. 

Log Near Full Level 

Off 

1-49 

Specify the numeric value by which the printer judges that the log storage 
area is reaching the upper limit. 

Note: The upper limit of the log storage area is 50 MB. 

Log Action at Near Full 

None 

Email Current Log 

Email & Delete Current Log 

Email & Delete Oldest Log 

Post Current Log 

Post & Delete Current Log 

Post & Delete Oldest Log 

Delete Current Log 

Delete Oldest Log 

Delete All But Current 

Delete All Logs 

Specify how the printer operates when the log storage area is reaching the 
upper limit. 

Note: None is the factory default setting. 

Log Action at Full 

None 

Email & Delete Current Log 

Email & Delete Oldest Log 

Post & Delete Current Log 

Post & Delete Oldest Log 

Delete Current Log 

Delete Oldest Log 

Delete All But Current 

Delete All Logs 

Specify how the printer operates when the log storage area has reached the 
upper limit. 

Note: None is the factory default setting. 

URL to Post Logs 

[user-defined string] 

Specify the folder in which to save the job accounting logs. 

Note: This option is available when "Post Current Log", "Post & Delete 
Current Log", or "Post & Delete Oldest Log" is selected in Log Action at 
Near Full/Log Action at Full. 
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Use To 

E-mail Address to Send Logs 

[user-defined string] 

Specify the E-mail address to use to send the job accounting logs. 

Note: This option is available when "E-mail Current Log", "E-mail & Delete 
Current Log", or "E-mail & Delete Oldest Log" is selected in Log Action at 
Near Full/Log Action at Full. 

Log File Prefix 

[user-defined string] 

Change Prefix of the log file. 

Notes: 

• The log file has two naming rules.  
Ongoing log files appear as "jal_[value of Log File Prefix 
setting]_current.csv" . 
Closed log files appear as "jal_[value of Log File Prefix setting]_[time 
stamp in appropriate Date Format for first day of jobs included in the 
log].csv" . 

• Current host name string in TCP/IP menu is the factory default setting. 

Delete Logs 

Select All 

Unselect All 

Delete 

Select the desired log file from the displayed list, and then delete it. 

Note: This option is displayed only when Job Accounting Log is enabled. 

Print/Export Logs 

Print 

Detailed 

User ID Summary 

Account Code Summary 

Export 

Specify processing of the job accounting log file.  

Notes: 

• This option is displayed only when Job Accounting Log is enabled. 

• When you export the logs to a USB flash drive, the access light on the 
flash drive will flash, go off, and flash again. If the USB flash drive is not 
equipped with an access light, wait for about 90 seconds after you 
export the logs before removing the flash drive. 
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Utilities menu 

Use To 

Format Flash 

Yes 

No 

Format the flash memory. 

Warning—Potential Damage: Do not turn off the printer while the flash 
memory is being formatted. 

Notes: 

• Yes deletes all data stored in flash memory. 

• No cancels the format request. 

• Flash memory refers to the memory added by installing a flash memory 
card in the printer. 

• The flash memory option card must not be read/write- or write-protected. 

• This menu item appears only when a non-defective flash memory card is 
installed. 

Activate Hex Trace Assist in isolating the source of a print job problem. 

Notes: 

• When activated, all data sent to the printer is printed in hexadecimal and 
character representation, and control codes are not executed. 

• To exit or deactivate Hex Trace, turn off or reset the printer. 

Coverage Estimator 

Off 

On 

Provide an estimate of the percentage coverage of toner on a page. The 
estimate is printed on a separate page at the end of each print job. 

Note: Off is the factory default setting. 

  

XPS menu 

Use To 

Print Error Pages 

Off 

On 

Print a page containing information on errors, including XML markup errors. 

Note: Off is the factory default setting. 
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PDF menu 

Use To 

Scale to Fit 

Yes 

No 

Scale page content to fit the selected paper size. 

Note: No is the factory default setting. 

Annotations 

Do Not Print 

Print 

Print annotations in a PDF. 

Note: Do Not Print is the factory default setting. 

  

PostScript menu 

Use To 

Print PS Error 

On 

Off 

Print a page containing the PostScript error. 

Note: Off is the factory default setting. 

Lock PS Startup Mode 

On 

Off 

Disable the SysStart file. 

Note: Off is the factory default setting. 

Font Priority 

Resident 

Flash 

Establish the font search order. 

Notes: 

• Resident is the factory default setting. 

• This menu item is available only when a formatted flash memory 
option card is installed and operating properly. 

• Make sure the flash memory option is not read/write-, write-, or 
password-protected. 

• Job Buffer Size must not be set to 100%. 
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PCL Emul menu 

Use To 

Font Source 

Resident 

Download 

Flash 

All 

Specify the set of fonts used by the Font Name menu. 

Notes: 

• “Resident” is the factory default setting. “Resident” shows the factory 
default set of fonts downloaded in the RAM. 

• “Download” shows all the fonts downloaded in the RAM. 

• “Flash” shows all fonts resident in that option. The optional flash 
memory card must be properly formatted and cannot be read/write-, 
write-, or password-protected. 

• “All” shows all fonts available to any option. 

Font Name 

R0 Courier 

Identify a specific font and the option where it is stored. 

Note: R0 Courier is the factory default setting. R0 Courier shows the font 
name, font ID, and the storage location in the printer. The font source 
abbreviation is R for Resident, F for Flash, and D for Download. 

Symbol Set 

10U PC-8 

12U PC-850 

Specify the symbol set for each font name. 

Notes: 

• 10U PC-8 is the US default setting. 12U PC-850 is the Non-US default 
setting. 

• A symbol set is a set of alphabetic and numeric characters, 
punctuation, and special symbols. Symbol sets support the different 
languages or specific program, such as math symbols for scientific 
text. Only the supported symbol sets are shown. 

• Symbol set values are displayed as: “[Font ID][Font Name]” (e.g. “10U 
PC-8”). 

PCL Emulation Settings 

Pitch 

0.08–100 

Specify the font pitch for scalable monospaced fonts. 

Notes: 

• 10 is the factory default setting. 

• Pitch refers to the number of fixed-space characters per inch (cpi). 

• Pitch can be increased or decreased in 0.01-cpi increments. 

• For nonscalable monospaced fonts, the pitch appears on the display 
but it cannot be changed. 
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Use To 

PCL Emulation Settings 

Orientation 

Portrait 

Landscape 

Specify the orientation of text and graphics on the page. 

Notes: 

• Portrait is the factory default setting. Portrait prints text and graphics 
parallel to the short edge of the page. 

• Landscape prints text and graphics parallel to the long edge of the 
page. 

PCL Emulation Settings 

Lines per Page 

1–255 

Specify the number of lines that print on each page. 

Notes: 

• 64 is the default setting. 

• The printer sets the amount of space between each line based on the 
Lines per Page, Paper Size, and Orientation settings. Select the Paper 
Size and Orientation you want before setting Lines per Page. 

PCL Emulation Settings 

A4 Width 

198 mm 

203 mm 

Set the printer to print on A4-size paper. 

Notes: 

• 198 mm is the factory default setting. 

• The 203-mm setting sets the width of the page to allow printing of 
eighty 10-pitch characters. 

PCL Emulation Settings 

Auto CR after LF 

On 

Off 

Specify whether the printer automatically performs a carriage return (CR) 
after a line feed (LF) control command. 

Note: Off is the factory default setting. 

PCL Emulation Settings 

Auto LF after CR 

On 

Off 

Specify whether the printer automatically performs a line feed (LF) after a 
carriage return (CR) control command. 

Note: Off is the factory default setting. 
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Use To 

Tray Renumber 

Assign MP Feeder 

Off 

None 

0–199 

Assign Tray [x] 

Off 

None 

0–199 

Assign Manual Paper 

Off 

None 

0–199 

Assign Manual Env 

Off 

None 

0–199 

Configure the printer to work with printer software or programs that use 
different source assignments for trays and feeders. 

Notes: 

• Off is the factory default setting. 

• None cannot be selected. It is only displayed when it is selected by the 
PCL 5 interpreter. It also ignores the Select Paper Feed command. 

• 0–199 allows a custom setting to be assigned. 

Tray Renumber 

View Factory Defaults 

MPF Default = 8 

Tray1 Default = 1 

Tray2 Default = 4 

Tray3 Default = 5 

Tray4 Default = 20 

Tray5 Default = 21 

Env Default = 6 

MPaper Default = 2 

MEnv Default = 3 

Display the factory default setting assigned to each tray or feeder. 

Tray Renumber 

Restore Defaults 

Yes 

No 

Restore all tray and feeder assignments to their factory default settings. 
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HTML menu 

Use To 

Font Name 

Albertus MT 

Antique Olive 

Apple Chancery 

Arial MT 

Avant Garde 

Bodoni 

Bookman 

Chicago 

Clarendon 

Cooper Black 

Copperplate 

Coronet 

Courier 

Eurostile 

Garamond 

Geneva 

Gill Sans 

Goudy 

Helvetica 

Hoefler Text 

Intl CG Times 

Intl Courier 

Intl Univers 

Joanna MT 

Letter Gothic 

Lubalin Graph 

Marigold 

MonaLisa Recut 

Monaco 

New CenturySbk 

New York 

Optima 

Oxford 

Palatino 

StempelGaramond 

Taffy 

Times 

TimesNewRoman 

Univers 

Zapf Chancery 

NewSansMTCS 

NewSansMTCT 

New SansMTJA 

NewSansMTKO 

Set the default font for HTML documents. 

Note: The Times font is used in HTML documents that do not 
specify a font. 
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Use To 

Font Size 

1–255 pt 

Set the default font size for HTML documents. 

Notes: 

• 12 pt is the factory default setting. 

• Font size can be increased in 1-point increments. 

Scale 

1–400% 

Scale the default font for HTML documents. 

Notes: 

• 100% is the factory default setting. 

• Scaling can be increased in 1% increments. 

Orientation 

Portrait 

Landscape 

Set the page orientation for HTML documents. 

Note: Portrait is the factory default setting. 

Margin Size 

8–255 mm 

Set the page margin for HTML documents. 

Notes: 

• 19 mm is the factory default setting. 

• Margin size can be increased in 1-mm increments. 

Backgrounds 

Do Not Print 

Print 

Specify whether to print backgrounds on HTML documents. 

Note: Print is the factory default setting. 
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Image menu 

Use To 

Auto Fit 

On 

Off 

Select the optimal paper size, scaling, and orientation. 

Note: On is the factory default setting. It overrides scaling and orientation 
settings for some images. 

Invert 

On 

Off 

Invert bitonal monochrome images. 

Notes: 

• Off is the factory default setting. 

• This setting does not apply to GIF or JPEG images. 

Scaling 

Anchor Top Left 

Best Fit 

Anchor Center 

Fit Height/Width 

Fit Height 

Fit Width 

Scale the image to fit the selected paper size. 

Notes: 

• Best Fit is the factory default setting. 

• When Auto Fit is set to On, Scaling is automatically set to Best Fit. 

Orientation 

Portrait 

Landscape 

Reverse Portrait 

Reverse Landscape 

Set the image orientation. 

Note: Portrait is the factory default setting. 
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7—Saving the environment 

Saving paper and toner 

Studies show that as much as 80% of the carbon footprint of a printer is related to paper usage. You can 
significantly reduce your carbon footprint by using recycled paper and the following printing suggestions, 
such as printing on both sides of the paper and printing multiple pages on one side of a single sheet of 
paper. 

Using recycled paper 

As an environmentally conscious company, KONICA MINOLTA supports the use of recycled office paper 
produced specifically for use in laser printers. 

Conserving supplies 

There are a number of ways you can reduce the amount of paper and toner you use when printing. You 
can: 

Use both sides of the paper 

If your printer model supports duplex printing, then you can control whether print appears on one or two 
sides of the paper by selecting 2-sided printing from the Print dialog. 

Place multiple pages on one sheet of paper 

You can print up to 16 consecutive pages of a multiple-page document onto one side of a single sheet of 
paper by selecting a setting from the Multipage printing (N-Up) section of the Print dialog screen. 

Avoid paper jams 

Correctly set the paper type and size to avoid paper jams. For more information, see Avoiding jams. 



User's Guide 

 
- 131 - 

8—Maintaining the printer 
Warning—Potential Damage: Failure to maintain optimum printer performance, or to replace parts and 
supplies, may cause damage to your printer. 

Cleaning the printer 

Cleaning the printer 

Note: You may need to perform this task after every few months. 

Warning—Potential Damage: Damage to the printer caused by improper handling is not covered by the 
printer warranty. 

1. Make sure that the printer is turned off and unplugged from the electrical outlet. 

 CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior 
of the printer, unplug the power cord from the electrical outlet and disconnect all cables from the 
printer before proceeding. 

2. Remove paper from the standard bin and multipurpose feeder. 

3. Remove any dust, lint, and pieces of paper around the printer using a soft brush or vacuum. 

4. Dampen a clean, lint-free cloth with water, and use it to wipe the outside of the printer. 

Warning—Potential Damage: Do not use household cleaners or detergents to prevent damage to 
the exterior of the printer. 

5. Make sure all areas of the printer are dry before sending a new print job. 

Ordering parts and supplies 

Using genuine KONICA MINOLTA parts and supplies 

Your KONICA MINOLTA printer is designed to function best with genuine KONICA MINOLTA supplies 
and parts. Use of third-party supplies or parts may affect the performance, reliability, or life of the printer 
and its imaging components. Use of third-party supplies or parts can affect warranty coverage. Damage 
caused by the use of third-party supplies or parts is not covered by the warranty. All life indicators are 
designed to function with KONICA MINOLTA supplies and parts, and may deliver unpredictable results if 
third-party supplies or parts are used. Imaging component usage beyond the intended life may damage 
your KONICA MINOLTA printer or its associated components. 

Ordering toner cartridges 

Notes: 

• The estimated cartridge yield is based on the ISO/IEC 19752 standard. 

• Extremely low print coverage for extended periods of time may negatively affect actual yield. 
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Part name  Part number 

For the United States, Latin America (120v) and Taiwan 

Toner Cartridge 20K for bizhub 4000P (Use and Return) A63W 01F 

Toner Cartridge 20K for bizhub 4000P A63W 01W 

Toner Cartridge 20K for bizhub 4700P (Use and Return) A63T 01F 

Toner Cartridge 20K for bizhub 4700P A63T 01W 

For Europe 

Toner Cartridge 20K for bizhub 4000P (Use and Return) A63W 01H 

Toner Cartridge 20K for bizhub 4000P  A63W 01W 

Toner Cartridge 20K for bizhub 4700P (Use and Return) A63T 01H 

Toner Cartridge 20K for bizhub 4700P A63T 01W 

For the Asia Pacific, Africa, Middle East, Latin America (220v), Australia and New Zealand 

Toner Cartridge 20K for bizhub 4000P (Use and Return) A63W 01K 

Toner Cartridge 20K for bizhub 4000P A63W 01W 

Toner Cartridge 20K for bizhub 4700P (Use and Return) A63T 01K 

Toner Cartridge 20K for bizhub 4700P A63T 01W 

For China 

Toner Cartridge 20K for bizhub 4000P (Use and Return) A63W 01K 

Toner Cartridge 20K for bizhub 4000P A63W 01R 

Toner Cartridge 20K for bizhub 4700P (Use and Return) A63T 01K 

Toner Cartridge 20K for bizhub 4700P A63T 01R 
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Ordering an imaging unit 

Extremely low print coverage for extended periods of time may cause imaging unit parts to fail prior to 
exhaustion of toner from toner cartridge. 

For more information on replacing the imaging unit, see the instruction sheet that came with the supply. 

Part name Destination Part number 

Imaging unit 60K for bizhub 4000P/4700P (Use and Return) For World wide A63X 03V 

Imaging unit 60K for bizhub 4000P/4700P For World wide A63X 03W 

Estimated number of remaining pages 

The estimated number of remaining pages is based on the recent printing history of the printer. Its 
accuracy may vary significantly and is dependent on many factors, such as actual document content, 
print quality settings, and other printer settings. 

The accuracy of the estimated number of remaining pages may decrease when the actual printing 
consumption is different from the historical printing consumption. Consider the variable level of accuracy 
before purchasing or replacing supplies based on the estimate. Until an adequate print history is obtained 
on the printer, initial estimates assume future supplies consumption based on the International 
Organization for Standardization* test methods and page content. 

* Average continuous black declared cartridge yield in accordance with ISO/IEC 19752. 

Storing supplies 

Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original 
packing until you are ready to use them. 

Do not expose supplies to: 

• Direct sunlight 

• Temperatures above 35°C (95°F) 

• High humidity above 80% 

• Salty air 

• Corrosive gases 

• Heavy dust 
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Replacing supplies 

Replacing the toner cartridge 

1. Press the button on the right side of the printer, and then open the front door. 

 

2. Pull the toner cartridge out using the handle. 

 

3. Unpack the toner cartridge, and then remove all packing materials. 

4. Shake the new cartridge to redistribute the toner. 
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5. Insert the toner cartridge into the printer by aligning the side rails of the cartridge with the arrows on 
the side rails inside the printer. 

Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 
minutes. Extended exposure to light may cause print quality problems. 

 

Note: Dispose of the empty toner cartridge according to your local regulations. Do not burn the 
toner cartridge. 

CAUTION: If you get toner in your eyes, wash it out immediately with cool water and consult a doctor. 

6. Close the front door. 

Replacing the imaging unit 

1. Press the button on the right side of the printer, and then open the front door. 
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2. Pull the toner cartridge out using the handle. 

 

3. Lift the blue handle, and then pull the imaging unit out of the printer. 

 

4. Unpack the new imaging unit, and then shake it. 

 



User's Guide 

 
- 137 - 

5. Remove all packing materials from the imaging unit. 

Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 
minutes. Extended exposure to light may cause print quality problems. 

Warning—Potential Damage: Do not touch the photoconductor drum. Doing so may affect the print 
quality of future print jobs. 

 

6. Insert the imaging unit into the printer by aligning the arrows on the side rails of the imaging unit with 
the arrows on the side rails inside the printer. 

 

7. Insert the toner cartridge into the printer by aligning the side rails of the cartridge with the arrows on 
the side rails inside the printer. 

 

8. Close the front door. 

Note: Dispose of the used imaging unit according to your local regulations. Do not burn the imaging unit. 
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Moving the printer 

Before moving the printer 

 CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid 
personal injury or printer damage: 

• Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet. 

• Disconnect all cords and cables from the printer before moving it. 

• If an optional tray is installed, then remove it from the printer. To remove the optional tray, slide the 
latch on the right side of the tray toward the front of the tray until it clicks into place. 

 

• Use the handholds located on both sides of the printer to lift it. 

• Make sure your fingers are not under the printer when you set it down. 

• Before setting up the printer, make sure there is adequate clearance around it. 

Use only the power cord provided with this product or the manufacturer's authorized replacement. 

Warning—Potential Damage: Damage to the printer caused by improper moving is not covered by the 
printer warranty. 

Moving the printer to another location 

The printer and its hardware options can be safely moved to another location by following these 
precautions: 

• Any cart used to move the printer must have a surface able to support the full footprint of the printer. 

• Any cart used to move the hardware options must have a surface able to support the dimensions of 
the hardware options. 

• Keep the printer in an upright position. 

• Avoid severe jarring movements. 
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Shipping the printer 

When shipping the printer, use the original packaging or call the place of purchase for a relocation kit. 
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9—Clearing jams 
By carefully selecting paper and specialty media and loading it properly, you should be able to avoid most 
jams. If jams occur, then follow the steps outlined in this chapter. 

Warning—Potential Damage: Never use any tool to remove a jam. Doing so could permanently damage 
the fuser. 

Avoiding jams 

Load paper properly 

• Make sure paper lies flat in the tray. 

Correct loading of paper Incorrect loading of paper 

  

  

• Do not remove a tray while the printer is printing. 

• Do not load a tray while the printer is printing. Load it before printing, or wait for a prompt to load it. 

• Do not load too much paper. Make sure the stack height is below the maximum paper fill indicator. 
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• Do not slide the paper into the tray. Load paper as shown in the illustration. 

 

• Make sure the guides in the tray or the multipurpose feeder are properly positioned and are not 
pressing tightly against the paper or envelopes. 

• Push the tray firmly into the printer after loading paper. 

Use recommended paper 

• Use only recommended paper or specialty media. 

• Do not load wrinkled, creased, damp, bent, or curled paper. 

• Flex, fan, and straighten paper before loading it. 

 

• Do not use paper that has been cut or trimmed by hand. 

• Do not mix paper sizes, weights, or types in the same tray. 

• Make sure the paper size and type are set correctly on the Embedded Web Server or the computer. 

Note: Depending on your operating system, access the Paper menu using Printer Settings. 

• Store paper according to manufacturer recommendations. 
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Understanding jam messages and locations 

When a jam occurs, a message indicating the jam location and information to clear the jam appears on 
the printer display. Open the doors, covers, and trays indicated on the display to remove the jam. 

Notes: 

• When Jam Assist is set to On, the printer automatically flushes blank pages or pages with partial 
prints to the standard bin after a jammed page has been cleared. Check your printed output stack for 
discarded pages. 

• When Jam Recovery is set to On or Auto, the printer reprints jammed pages. However, the Auto 
setting does not guarantee that the page will print. 

 

  Area Printer control panel message What to do 

1 Standard bin [x]-page jam, clear standard bin. [20y.xx] Remove the jammed paper. 

2 Rear door [x]-page jam, open rear door. [20y.xx] Open the rear door, and then remove 
the jammed paper. 

3 Tray 1 [x]-page jam, remove tray 1 to clear 
duplex. [23y.xx] 

Pull tray 1 completely out, then push the 
front duplex flap down, and then remove 
the jammed paper. 

Note: You may need to open the rear 
door to clear some 23y.xx paper jams. 

4 Tray [x] [x]-page jam, remove tray [x]. [24y.xx] Pull the indicated tray out, and then 
remove the jammed paper. 

5 Multipurpose 
feeder 

[x]-page jam, clear manual 
feeder. [250.xx] 

Remove all paper from the multipurpose 
feeder, and then remove the jammed 
paper. 

6 Front door [x]-page jam, open front door. [20y.xx] Open the front door, then remove the 
toner cartridge, imaging unit, and 
jammed paper. 
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[x]-page jam, open front door. [20y.xx] 

 CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from 
a hot component, allow the surface to cool before touching it. 

1. Press the button on the right side of the printer, and then open the front door. 

 

2. Pull the toner cartridge out using the handle. 
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3. Lift the blue handle, and then pull the imaging unit out of the printer. 

 

Warning—Potential Damage: Do not touch the shiny blue photoconductor drum under the imaging 
unit. Doing so may affect the quality of future print jobs. 

 

4. Lift the green flap in front of the printer. 

 

5. Place the imaging unit aside on a flat, smooth surface. 

Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 
minutes. Extended exposure to light may cause print quality problems. 



User's Guide 

 
- 145 - 

6. Firmly grasp the jammed paper on each side, and then gently pull it out. 

Note: Make sure all paper fragments are removed. 

 

7. Insert the imaging unit by aligning the arrows on the side rails of the unit with the arrows on the side 
rails inside the printer, and then insert the imaging unit into the printer. 

 

8. Insert the toner cartridge by aligning the side rails of the cartridge with the arrows on the side rails 
inside the printer, and then insert the cartridge into the printer. 

 

9. Close the front door. 

10. From the printer control panel, select Next >  >Clear the jam, press OK > . 
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[x]-page jam, open rear door. [20y.xx] 

1. Open the front door. 

 

2. Gently pull down the rear door. 

 CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury 
from a hot component, allow the surface to cool before touching it. 
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3. Firmly grasp the jammed paper on each side, and then gently pull it out. 

Note: Make sure all paper fragments are removed. 

 

4. Close the rear door. 

5. From the printer control panel, select Next >  >Clear the jam, press OK > . 

[x]-page jam, clear standard bin. [20y.xx] 

1. Firmly grasp the jammed paper on each side, and then gently pull it out. 

Note: Make sure all paper fragments are removed. 

 

2. From the printer control panel, select Next >  >Clear the jam, press OK > . 
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[x]-page jam, remove tray 1 to clear duplex. [23y.xx] 

 CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from 
a hot component, allow the surface to cool before touching it. 

1. Pull the tray completely out of the printer. 

 

2. Locate the blue lever, and then pull it down to release the jam. 
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3. Firmly grasp the jammed paper on each side, and then gently pull it out. 

Note: Make sure all paper fragments are removed. 

 

4. Insert the tray. 

5. From the printer control panel, select Next >  >Clear the jam, press OK > . 

[x]-page jam, open tray [x]. [24y.xx] 

1. Pull the tray completely out of the printer. 

Note: The message on the printer display indicates the tray where the jammed paper is located. 
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2. Firmly grasp the jammed paper on each side, and then gently pull it out. 

Note: Make sure all paper fragments are removed. 

 

3. Insert the tray. 

4. From the printer control panel, select Next >  >Clear the jam, press OK > . 

[x]-page jam, clear manual feeder. [25y.xx] 

1. From the multipurpose feeder, firmly grasp the jammed paper on each side, and then gently pull it out. 

Note: Make sure all paper fragments are removed. 

 

2. Flex the sheets of paper back and forth to loosen them, and then fan them. Do not fold or crease the 
paper. Straighten the edges on a level surface. 
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3. Reload paper into the multipurpose feeder. 

 

Note: Make sure the paper guide lightly rests against the edge of the paper. 

4. From the printer control panel, select Next >  >Clear the jam, press OK > . 
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10—Troubleshooting 

Understanding the printer messages 

Cartridge, imaging unit mismatch [41.xy]  

1. Check if the toner cartridge and imaging unit are both MICR (Magnetic Imaging Content Recording) 
or non-MICR supplies. 

Note: For a list of supported supplies, see the “Ordering supplies” section of the User's Guide. 

2. Change the toner cartridge or imaging unit so that both are non-MICR supplies. 

Cartridge low [88.xy] 

You may need to order a toner cartridge. If necessary, select Continue on the printer control panel to 

clear the message and continue printing. Press  to confirm. 

Cartridge nearly low [88.xy] 

If necessary, select Continue on the printer control panel to clear the message and continue printing. 

Press  to confirm. 

Cartridge very low, [x] estimated pages remain [88.xy] 

You may need to replace the toner cartridge very soon. For more information, see the “Replacing 
supplies” section of the User’s Guide. 

If necessary, select Continue on the printer control panel to clear the message and continue printing. 

Press  to confirm. 

Change [paper source] to [custom type name] load [orientation] 

Try one or more of the following 

• Load the correct paper size and type in the tray, verify the paper size and type settings are specified 
in the Paper menu on the printer control panel, and then select Finished changing paper. Press 

 to confirm. 

• Cancel the print job. 
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Change [paper source] to [custom string] load [paper orientation] 

Try one or more of the following: 

• Load the correct size and type of paper in the tray, then verify that the paper size and type settings 
are specified in the Paper menu on the printer control panel, and then select Finished changing 

paper. Press  to confirm. 

• Cancel the print job. 

Change [paper source] to [paper size] load [orientation] 

Try one or more of the following: 

• Load the correct paper size and type in the tray, verify the paper size and type settings are specified 
in the Paper menu on the printer control panel, and then select Finished changing paper. Press 

 to confirm. 

• Cancel the print job. 

Change [paper source] to [paper type] [paper size] load [orientation] 

Try one or more of the following: 

• Load the correct paper size and type in the tray, verify the paper size and type settings are specified 
in the Paper menu on the printer control panel, and then select Finished changing paper. Press 

 to confirm. 

• Cancel the print job. 

Close front door 

Close the front door of the printer. 

Complex page, some data may not have printed [39] 

Try one or more of the following: 

• From the printer control panel, select Continue to ignore the message and continue printing. Press 

 to confirm. 

• Cancel the current print job. Press  to confirm. 

• Install additional printer memory. 
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Configuration change, some held jobs were not restored [57] 

Held jobs are invalidated because of any of the following possible changes in the printer: 

• The printer firmware has been updated. 

• The tray for the print job is removed. 

• The print job is sent from a flash drive that is no longer attached to the USB port. 

From the printer control panel, select Continue to clear the message. Press  to confirm. 

Defective flash detected [51] 

Try one or more of the following: 

• Replace the defective flash memory card. 

• From the printer control panel, select Continue to ignore the message and continue printing. Press 

 to confirm. 

• Cancel the current print job. 

Error reading USB drive. Remove USB. 

An unsupported USB device is inserted. Remove the USB device, and then insert a supported one. 

Error reading USB hub. Remove hub. 

An unsupported USB hub has been inserted. Remove the USB hub, and then install a supported one. 

Imaging unit low [84.xy] 

You may need to order an imaging unit. If necessary, select Continue on the printer control panel to clear 

the message and continue printing. Press  to confirm. 

Imaging unit nearly low [84.xy] 

If necessary, select Continue on the printer control panel to clear the message and continue printing. 

Press  to confirm. 

Imaging unit very low, [x] estimated pages remain [84.xy] 

You may need to replace the imaging unit very soon. For more information, see the "Replacing supplies" 
section of the User’s Guide. 
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If necessary, select Continue on the printer control panel to clear the message and continue printing. 

Press  to confirm. 

Incorrect paper size, open [paper source] [34] 

Try one or more of the following: 

• Load the correct size of paper in the tray. 

• From the printer control panel, select Continue to clear the message and print using a different tray. 

Press  to confirm. 

• Check the tray length and width guides and make sure the paper is loaded properly in the tray. 

• Make sure the correct paper size and type are specified in the Printing Preferences or in the Print 
dialog. 

• Make sure the paper size and type are specified in the Paper menu on the printer control panel. 

• Make sure that the paper size is correctly set. For example, if MP Feeder Size is set to Universal, 
then make sure the paper is large enough for the data being printed. 

• Cancel the print job. 

Insert Tray [x] 

Insert the indicated tray into the printer. 

Insufficient memory to support Resource Save feature [35] 

Install additional printer memory or select Continue on the printer control panel to disable Resource Save, 

clear the message, and continue printing. Press  to confirm. 

Insufficient memory to collate job [37] 

Try one or more of the following: 

• From the printer control panel, select Continue to print the part of the job already stored and begin 

collating the rest of the print job. Press  to confirm. 

• Cancel the current print job. 

Insufficient memory for Flash Memory Defragment operation [37] 

Try one or more of the following: 

• From the printer control panel, select Continue to stop the defragmentation and continue printing. 

Press  to confirm. 
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• Delete fonts, macros, and other data from the printer memory. 

• Install additional printer memory. 

Insufficient memory, some Held Jobs were deleted [37] 

The printer deleted some held jobs in order to process current jobs. 

Press  to confirm. 

Insufficient memory, some held jobs will not be restored [37] 

Try one or more of the following: 

• From the printer control panel, press  to confirm. 

• Delete other held jobs to free up additional printer memory. 

Load [paper source] with [custom string] [paper orientation] 

Try one or more of the following: 

• Load the tray or feeder with the correct size and type of paper. 

• To use the tray that has the correct size or type of paper, select Finished loading paper on the 

printer control panel. Press  to confirm. 

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that tray. 
If the printer cannot find a tray that has the correct size and type of paper, then it prints from the 
default paper source. 

• Cancel the current job. 

Load [paper source] with [custom type name] [paper orientation] 

Try one or more of the following: 

• Load the tray or feeder with the correct size and type of paper. 

• To use the tray that has the correct size or type of paper, select Finished loading paper on the 

printer control panel. Press  to confirm. 

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that tray. 
If the printer cannot find a tray that has the correct size and type of paper, then it prints from the 
default paper source. 

• Cancel the current job. 
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Load [paper source] with [paper size] [paper orientation] 

Try one or more of the following: 

• Load the tray or feeder with the correct size of paper. 

• To use the tray or feeder that has the correct size of paper, select Finished loading paper on the 

printer control panel. Press  to confirm. 

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that tray. 
If the printer cannot find a tray that has the correct size and type of paper, then it prints from the 
default paper source. 

• Cancel the current job. 

Load [paper source] with [paper type] [paper size] [paper orientation] 

Try one or more of the following: 

• Load the tray or feeder with the correct size and type of paper. 

• To use the tray or feeder that has the correct size and type of paper, select Finished loading paper 

on the printer control panel. Press  to confirm. 

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that tray. 
If the printer cannot find a tray that has the correct size and type of paper, then it prints from the 
default paper source. 

• Cancel the current job. 

Load manual feeder with [custom type name] [paper orientation] 

Try one or more of the following: 

• Load the multipurpose feeder with the correct size and type of paper. 

• Press  to clear the message and continue printing. 

Note: If no paper is loaded in the feeder when Continue or  is selected, then the printer 
manually overrides the request, and then prints from an automatically selected tray. 

• Cancel the current job. 

Load manual feeder with [custom string] [paper orientation] 

Try one or more of the following: 

• Load the feeder with the correct size and type of paper. 
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• Press  to clear the message and continue printing. 

Note: If no paper is loaded in the feeder when  is selected, then the printer automatically 
overrides the request, and then prints from an automatically selected tray. 

• Cancel the current job. 

Load manual feeder with [paper size] [paper orientation] 

Try one or more of the following: 

• Load the multipurpose feeder with the correct size of paper. 

• Press  to clear the message and continue printing. 

Note: If no paper is loaded in the feeder when  is selected, then the printer manually overrides 
the request, and then prints from an automatically selected tray. 

• Cancel the current job. 

Load manual feeder with [paper type] [paper size] [paper orientation] 

Try one or more of the following: 

• Load the multipurpose feeder with the correct size and type of paper. 

• Press  to clear the message and continue printing. 

Note: If no paper is loaded in the feeder when  is selected, then the printer manually overrides 
the request, and then prints from an automatically selected tray. 

• Cancel the current job. 

Maintenance kit low [80.xy] 

You may need to order a maintenance kit. If necessary, select Continue to clear the message and 

continue printing. Press  to confirm. 

Maintenance kit nearly low [80.xy] 

If necessary, select Continue to clear the message and continue printing. Press  to confirm. 

Maintenance kit very low, [x] estimated pages remain [80.xy] 

You may need to replace the maintenance kit very soon.  
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If necessary, select Continue on the printer control panel to clear the message and continue printing. 

Press  to confirm. 

Memory full [38] 

Try one or more of the following: 

• From the printer control panel, select Cancel job to clear the message. Press  to confirm. 

• Install additional printer memory. 

Network [x] software error [54] 

Try one or more of the following: 

• From the printer control panel, select Continue to continue printing. Press  to confirm. 

• Turn off the printer, wait for about 10 seconds, and then turn the printer back on. 

• Update the network firmware in the printer or print server. 

Non-Printer Manufacturer [supply type], see User’s Guide [33.xy] 

Note: The supply type can be toner cartridge or imaging unit. 

The printer has detected a non-Printer Manufacturer supply or part installed in the printer. 

Your KONICA MINOLTA printer is designed to function best with genuine Printer Manufacturer supplies 
and parts. Use of third-party supplies or parts may affect the performance, reliability, or life of the printer 
and its imaging components. 

All life indicators are designed to function with genuine Printer Manufacturer supplies and parts and may 
deliver unpredictable results if third-party supplies or parts are used. Imaging component usage beyond 
the intended life may damage your KONICA MINOLTA printer or associated components. 

Warning—Potential Damage: Use of third-party supplies or parts can affect warranty coverage. Damage 
caused by the use of third-party supplies or parts may not be covered by the warranty. 

To accept any and all of these risks and to proceed with the use of non-genuine supplies or parts in your 
printer. 

Press  and  on the printer control panel simultaneously for 15 seconds to clear the message 
and continue printing. 

If you do not wish to accept these risks, then remove the third-party supply or part from your printer, and 
then install a genuine Printer Manufacturer supply or part. 

Note: For a list of supported supplies, see the “Ordering supplies” section of the User's Guide. 
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Not enough free space in flash memory for resources [52] 

Try one or more of the following: 

• From the printer control panel, select Continue to clear the message and continue printing. Press 

 to confirm. 

• Delete fonts, macros, and other data stored in the flash memory. 

• Upgrade to a larger capacity flash memory card. 

Note: Downloaded fonts and macros that are not previously stored in the flash memory are deleted. 

Printer had to restart. Last job may be incomplete. 

From the printer control panel, press  to confirm. 

Reinstall missing or unresponsive cartridge [31.xy] 

Try one or more of the following: 

• Check if the toner cartridge is missing. If missing, install the toner cartridge. 

For information on installing the cartridge, see the “Replacing supplies” section of the User’s Guide. 

• If the toner cartridge is installed, then remove the unresponsive toner cartridge, and then reinstall it. 

Note: If the message appears after reinstalling the supply, then the cartridge is defective. Replace the 
toner cartridge. 

Reinstall missing or unresponsive imaging unit [31.xy] 

Try one or more of the following: 

• Check if the imaging unit is missing. If missing, install the imaging unit. 

For information on installing the imaging unit, see the “Replacing supplies” section of the User’s 
Guide. 

• If the imaging unit is installed, then remove the unresponsive imaging unit, and then reinstall it. 

Note: If the message appears after reinstalling the supply, then the imaging unit is defective. Replace 
the imaging unit. 

Remove paper from standard output bin 

Remove the paper stack from the standard bin. The printer automatically detects paper removal and 
resumes printing. 

If removing the paper does not clear the message, then press  to confirm. 



User's Guide 

 
- 161 - 

Replace cartridge, 0 estimated pages remain [88.xy] 

Replace the toner cartridge to clear the message and continue printing. For more information, see the 
instruction sheet that came with the supply or see the “Replacing supplies” section of the User’s Guide. 

Note: If you do not have a replacement cartridge, then see the “Ordering supplies” section of the User’s 
Guide. 

Replace cartridge, printer region mismatch [42.xy] 

Install a toner cartridge that matches the region number of the printer. x indicates the value of the printer 
region. y indicates the value of the cartridge region. x and y can have the following values: 

List of printer and toner cartridge regions 

Region number Region 

1 United States, Latin America (120v) and Taiwan 

2 Europe 

3 Asia Pacific 

  

Notes: 

• The x and y values are the .xy of the error code shown on the printer control panel. 

• The x and y values must match for printing to continue. 

Replace imaging unit, 0 estimated pages remain [84.xy] 

Replace the imaging unit to clear the message and continue printing. For more information, see the 
instruction sheet that came with the supply or see the “Replacing supplies” section of the User’s Guide. 

Note: If you do not have a replacement imaging unit, then see the “Ordering supplies” section of the 
User’s Guide. 

Replace maintenance kit, 0 estimated pages remain [80.xy] 

Contact customer support at http://www.konicaminolta.com or your service representative, and then 
report the message. The printer is scheduled for maintenance. 

Replace unsupported cartridge [32.xy] 

Remove the toner cartridge, and then install a supported one to clear the message and continue printing. 
For more information, see the instruction sheet that came with the supply or see the “Replacing supplies” 
section of the User’s Guide. 

http://www.konicaminolta.com/
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Note: If you do not have a replacement cartridge, then see the “Ordering supplies” section of the User’s 
Guide. 

Replace unsupported imaging unit [32.xy] 

Remove the imaging unit, and then install a supported one to clear the message and continue printing. 
For more information, see the instruction sheet that came with the supply or see the “Replacing supplies” 
section of the User’s Guide. 

Note: If you do not have a replacement imaging unit, then see the “Ordering supplies” section of the 
User’s Guide. 

Serial option [x] error [54] 

Try one or more of the following: 

• Make sure that the serial cable is properly connected and is the correct one for the serial port. 

• Make sure that the serial interface parameters (protocol, baud, parity, and data bits) are set correctly 
on the printer and computer. 

• From the printer control panel, select Continue to continue printing. Press  to confirm. 

• Turn off the printer, and then turn it back on. 

SMTP server not set up. Contact system administrator. 

From the printer control panel, select Continue to clear the message. Press  to confirm. 

Note: If the message appears again, then contact your system support person. 

Standard network software error [54] 

Try one or more of the following: 

• From the printer control panel, select Continue to continue printing. Press  to confirm. 

• Turn off the printer and then turn it back on. 

• Update the network firmware in the printer or print server. 

Standard USB port disabled [56] 

From the printer control panel, select Continue to clear the message. Press  to confirm. 

Notes: 

• The printer discards any data received through the USB port. 

• Make sure the USB Buffer menu is not set to Disabled. 
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Too many flash options installed [58] 

1. Turn off the printer. 

2. Unplug the power cord from the electrical outlet. 

3. Remove the extra flash memory. 

4. Connect the power cord to a properly grounded electrical outlet. 

5. Turn the printer back on. 

Too many trays attached [58] 

1. Turn off the printer. 

2. Unplug the power cord from the electrical outlet. 

3. Remove the extra trays. 

4. Connect the power cord to a properly grounded electrical outlet. 

5. Turn the printer back on. 

Unformatted flash detected [53] 

Try one or more of the following: 

• From the printer control, select Continue to stop the defragmentation and continue printing. Press 

 to confirm. 

• Format the flash memory. 

Note: If the error message remains, then the flash memory may be defective and need to be replaced. 

Unsupported option in slot [x] [55] 

1. Turn off the printer. 

2. Unplug the power cord from the electrical outlet. 

3. Remove the unsupported option card from the printer controller board, and then replace it with a 
supported card. 

4. Connect the power cord to a properly grounded electrical outlet. 

5. Turn the printer back on. 

Weblink server not set up. Contact system administrator. 

Select Continue to clear the message. Press  to confirm. 
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Note: If the message appears again, then contact your system support person. 

Solving printer problems 

• Basic printer problems 

• Option problems 

• Paper feed problems 

Basic printer problems 

The printer is not responding 

Action Yes No 

Step 1 

Make sure the printer is turned on. 

  

Is the printer turned on? 

Go to step 2. Turn on the printer. 

Step 2 

Check if the printer is in Sleep mode or 
Hibernate mode. 

  

Is the printer in Sleep mode or Hibernate 
mode? 

Press the Sleep button to wake the 
printer from Sleep mode or Hibernate 
mode. 

Go to step 3. 

Step 3 

Check if one end of the power cord is 
plugged into the printer and the other to a 
properly grounded electrical outlet. 

  

Is the power cord plugged into the printer 
and a properly grounded electrical outlet? 

Go to step 4. Plug one end of the power cord 
into the printer and the other to 
a properly grounded electrical 
outlet. 

Step 4 

Check other electrical equipment plugged 
into the electrical outlet. 

  

Does other electrical equipment work? 

Unplug the other electrical 
equipment, and then turn on the 
printer. If the printer does not work, 
then reconnect the other electrical 
equipment. 

Go to step 5. 
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Action Yes No 

Step 5 

Check if the cables connecting the printer 
and the computer are inserted in the 
correct ports. 

  

Are the cables inserted in the correct 
ports? 

Go to step 6. Make sure to match the 
following: 

• The USB symbol on the 
cable with the USB symbol 
on the printer 

• The appropriate Ethernet 
cable with the Ethernet port 

Step 6 

Make sure the electrical outlet is not 
turned off by a switch or breaker. 

  

Is the electrical outlet turned off by a 
switch or breaker? 

Turn on the switch or reset the 
breaker. 

Go to step 7. 

Step 7 

Check if the printer is plugged into any 
surge protectors, uninterruptible power 
supplies, or extension cords. 

  

Is the printer plugged into any surge 
protectors, uninterruptible power 
supplies, or extension cords? 

Connect the printer power cord 
directly to a properly grounded 
electrical outlet. 

Go to step 8. 

Step 8 

Check if one end of the printer cable is 
plugged into a port on the printer and the 
other to the computer, print server, 
option, or other network device. 

  

Is the printer cable securely attached to 
the printer and the computer, print server, 
option, or other network device? 

Go to step 9. Connect the printer cable 
securely to the printer and the 
computer, print server, option, 
or other network device. 
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Action Yes No 

Step 9 

Make sure to install all hardware options 
properly and remove any packing 
material. 

  

Are all hardware options properly 
installed and all packing material 
removed? 

Go to step 10. Turn off the printer, remove all 
packing materials, then reinstall 
the hardware options, and then 
turn on the printer. 

Step 10 

Check if you have selected the correct 
port settings in the printer driver. 

  

Are the port settings correct? 

Go to step 11. Use correct printer driver 
settings. 

Step 11 

Check the installed printer driver. 

  

Is the correct printer driver installed? 

Go to step 12. Install the correct printer driver. 

Step 12 

Turn off the printer, then wait for about 10 
seconds, and then turn the printer back 
on. 

  

Is the printer working? 

The problem is solved. Contact technical support. 

  

Printer display is blank 

Action Yes No 

Step 1 

Press the Sleep button on the printer control panel. 

  

Does Ready appear on the printer display? 

The problem is 
solved. 

Go to step 2. 



User's Guide 

 
- 167 - 

Action Yes No 

Step 2 

Turn off the printer, then wait for about 10 seconds, and 
then turn the printer back on. 

  

Do Please wait and Ready appear on the printer 
display? 

The problem is 
solved. 

Turn off the printer, and then contact 
technical support. 

  

Option problems 

Cannot detect internal option 

Action Yes No 

Step 1 

Turn off the printer, then wait for about 10 seconds, and then turn 
on the printer. 

  

Does the internal option operate correctly? 

The problem is 
solved. 

Go to step 2. 

Step 2 

Check if the internal option is properly installed in the controller 
board. 

1. Turn off the printer using the power switch, and then unplug 
the power cord from the electrical outlet. 

2. Make sure the internal option is installed in the appropriate 
connector in the controller board. 

3. Connect the power cord to the printer, then to a properly 
grounded electrical outlet, and then turn on the printer. 

  

Is the internal option properly installed in the controller board? 

Go to step 3. Connect the internal option to 
the controller board. 

Step 3 

Print a menu settings page, and then check to see if the internal 
option is listed in the Installed Features list. 

  

Is the internal option listed in the menu settings page? 

Go to step 4. Reinstall the internal option. 
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Action Yes No 

Step 4 

1. Check if the internal option is selected. 

It may be necessary to manually add the internal option in 
the printer driver to make it available for print jobs. 

2. Resend the print job. 

  

Does the internal option operate correctly? 

The problem is 
solved. 

Contact technical support. 

  

Tray problems 

Action Yes No 

Step 1 

1. Open the tray and do one or 
more of the following: 

- Check for paper jams or 
misfeeds. 

- Check if the paper size 
indicators on the paper 
guides are aligned with the 
paper size indicators on the 
tray. 

- If you are printing on 
custom-size paper, then 
make sure that the paper 
guides rest against the 
edges of the paper. 

- Make sure the paper is 
below the maximum paper 
fill indicator. 

- Make sure paper lies flat in 
the tray. 

2. Check if the tray closes 
properly. 

  

Is the tray working? 

The problem is solved. Go to step 2. 
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Action Yes No 

Step 2 

1. Turn off the printer, then wait 
about 10 seconds, and then turn 
the printer back on. 

2. Resend the print job. 

  

Is the tray working? 

The problem is solved. Go to step 3. 

Step 3 

Check if the tray is installed. 

Print a menu settings page, and 
then check if the tray is listed in 
the Installed Options list. 

  

Is the tray listed in the menu settings 
page? 

Go to step 4. Reinstall the tray. For more 
information, see the setup 
documentation that came with the 
tray. 

Step 4 

Check if the tray is available in the 
printer driver. 

Note: If necessary, manually add the 
tray in the printer driver to make it 
available for print jobs. 

  

Is the tray available in the printer 
driver? 

Go to step 5. Manually add the tray in the printer 
driver. 

Step 5 

Check if the option is selected. 

1. From the application you are 
using, select the option. For Mac 
OS X version 9 users, make 
sure the printer is set up in 
Chooser. 

2. Resend the print job. 

  

Is the tray working? 

The problem is solved. Contact technical support. 
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Paper feed problems 

Paper frequently jams 

Action Yes No 

Step 1 

1. Pull out the tray, and then do one or more of the following: 

- Make sure paper lies flat in the tray. 

- Check if the paper size indicators on the paper guides are aligned 
with the paper size indicators on the tray. 

- Check if the paper guides are aligned against the edges of the 
paper. 

- Make sure the paper is below the maximum paper fill indicator. 

- Check if you are printing on a recommended paper size and type. 

2. Insert the tray properly. 

If jam recovery is enabled, then the print jobs will reprint automatically. 

  

Do paper jams still occur frequently? 

Go to step 2. The problem is 
solved. 

Step 2 

1. Load paper from a fresh package. 

Note: Paper absorbs moisture due to high humidity. Store paper in its 
original wrapper until you use it. 

2. Resend the print job. 

  

Do paper jams still occur frequently? 

Go to step 3. The problem is 
solved. 

Step 3 

1. Review the tips on avoiding jams. For more information, see Avoiding 
jams. 

2. Follow the recommendations, and then resend the print job. 

  

Do paper jams still occur frequently? 

Contact technical 
support. 

The problem is 
solved. 
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Paper jam message remains after jam is cleared 

Action Yes No 

1. Do either of the following: 

- Select Next >  >Clear the jam, press OK >  . 

2. Follow the instructions on the printer display. 

  

Does the paper jam message remain? 

Contact technical 
support. 

The problem is 
solved. 

  

Jammed pages are not reprinted 

Action Yes No 

1. Turn on jam recovery. 

a. From the printer control panel, navigate to: 

Settings >General Settings >Print Recovery >Jam 
Recovery 

b. Select On or Auto. 

c. Depending on your printer model, press  or touch 
Submit. 

2.  Resend the pages that did not print. 

  

Were the jammed pages reprinted? 

The problem is 
solved. 

Contact technical 
support. 
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Solving print problems 

Printing problems 

Multiple-language PDF files do not print 

Action Yes No 

Step 1 

1. Check if the print options for the PDF output are set to embed 
all fonts. 

2. Generate a new PDF file, and then resend the print job. 

  

Do the files print? 

The problem is 
solved. 

Go to step 2. 

Step 2 

1. Open the document you want to print in Adobe Acrobat. 

2. Click File >Print >Advanced >Print As Image >OK >OK . 

  

Do the files print? 

The problem is 
solved. 

Contact technical 
support. 

  

Error message about reading the flash drive appears 

Action Yes No 

Step 1 

Check if the flash drive is inserted into the front USB 
slot. 

Note: The flash drive will not work if it is inserted into 
the rear USB slot. 

  

Is the flash drive inserted into the front USB slot? 

Go to step 2. Insert the flash drive 
into the front USB 
slot. 
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Action Yes No 

Step 2 

Check if the printer is busy. 

Note: A green blinking light indicates that the 
printer is busy. 

  

Is there an error message on the display? 

Wait until the printer is ready, then 
view the held jobs list, and then print 
the documents. 

Go to step 3. 

Step 3 

Check for an error message on the display. 

Note: A blinking red light indicates a printer error. 
Since the printer requires attention, the printer 
ignores the flash drive. 

  

Does the printer require attention? 

Clear the message. Go to step 4. 

Step 4 

Check if the flash drive is supported. 

For more information regarding tested and 
approved USB flash memory devices, see 
Supported flash drives and file types. 

  

Is the flash drive supported? 

Go to step 5. Use a supported 
flash drive. 

Step 5 

Check if the USB slot is disabled by the system 
support person. 

  

Is the USB slot disabled? 

Contact your system support person. Contact technical 
support. 
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Print jobs do not print 

Action Yes No 

Step 1 

1. From the document you are trying to print, open the Print dialog and 
check if you have selected the correct printer. 

Note: If the printer is not the default printer, then you must select the 
printer for each document that you want to print. 

2. Resend the print job. 

  

Do the jobs print? 

The problem is 
solved. 

Go to step 2. 

Step 2 

1. Check if the printer is plugged in and turned on, and if Ready appears 
on the printer display. 

2. Resend the print job. 

  

Do the jobs print? 

The problem is 
solved. 

Go to step 3. 

Step 3 

If an error message appears on the printer display, then clear the message. 

Note: The printer continues to print after clearing the message. 

  

Do the jobs print? 

The problem is 
solved. 

Go to step 4. 

Step 4 

1. Check if the ports (USB or Ethernet) are working and if the cables are 
securely connected to the computer and the printer. 

Note: For more information, see the setup documentation that came with 
the printer. 

2. Resend the print job. 

  

Do the jobs print? 

The problem is 
solved. 

Go to step 5. 
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Action Yes No 

Step 5 

1. Turn off the printer, then wait for about 10 seconds, and then turn the 
printer back on. 

2. Resend the print job. 

  

Do the jobs print? 

The problem is 
solved. 

Go to step 6. 

Step 6 

1. Remove, and then reinstall the printer driver. For more information, see 
Installing the printer driver. 

2. Resend the print job. 

  

Do the jobs print? 

The problem is 
solved. 

Contact technical 
support. 

  

Confidential and other held jobs do not print 

Note: Confidential, Verify, Reserve, and Repeat print jobs may be deleted if the printer requires extra 
memory to process additional held jobs. 

Action Yes No 

Step 1 

Open the held jobs folder on the printer display, 
and then verify that your print job is listed. 

  

Is your print job listed in the held jobs folder? 

Go to step 
2. 

Select one of the Print and Hold options, and 
then resend the print job. For more information, 
see Printing confidential and other held jobs. 
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Action Yes No 

Step 2 

The print job may contain a formatting error or 
invalid data. 

• Delete the print job, and then send it again. 

• For PDF files, generate a new PDF, and then 
print it again. 

If you are printing from the Internet, then the 
printer may be reading multiple job titles as 
duplicates and deleting all jobs except the first 
one. 

For Windows users 

1. Open the Print Properties folder. 

2. From the Print and Hold dialog, select the 
“Keep duplicate documents” check box. 

3. Enter a PIN number. 

For Macintosh users 

Save each print job, name each job differently, 
and then send the individual jobs to the printer. 

  

Does the job print? 

The 
problem is 
solved. 

Go to step 3. 

Step 3 

Free up additional printer memory by deleting 
some of the held jobs. 

  

Does the job print? 

The 
problem is 
solved. 

Add additional printer memory. 
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Print job takes longer than expected 

Action Yes No 

Step 1 

Change the environmental settings of the printer. 

1. From the printer control panel, navigate to: 

Settings >General Settings 

2. Select Eco-Mode or Quiet Mode, and then select Off. 

Note: Disabling Eco-Mode or Quiet Mode may increase the consumption 
of energy or supplies, or both. 

  

Did the job print? 

The problem is 
solved. 

Go to step 2. 

Step 2 

Reduce the number and size of fonts, the number and complexity of images, 
and the number of pages in the print job, and then resend the job 

  

Did the job print? 

The problem is 
solved. 

Go to step 3. 

Step 3 

1. Remove held jobs stored in the printer memory. 

2. Resend the print job. 

  

Did the job print? 

The problem is 
solved. 

Go to step 4. 

Step 4 

1. Disable the Page Protect feature. 

From the printer control panel, navigate to: 

Settings >General Settings >Print Recovery >Page Protect >Off  

2. Resend the print job. 

  

Did the job print? 

The problem is 
solved. 

Go to step 5. 
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Action Yes No 

Step 5 

Install additional printer memory, and then resend the print job. 

  

Did the job print? 

The problem is 
solved. 

Contact technical 
support. 

  

Job prints from the wrong tray or on the wrong paper 

Action Yes No 

Step 1 

1. Check if you are printing on paper that is supported by the tray. 

2. Resend the print job. 

  

Did the job print from the correct tray or on the correct paper? 

The problem is 
solved. 

Go to step 2. 

Step 2 

1. From the Paper menu on the printer control panel, set the paper size 
and type to match the paper loaded in the tray. 

2. Resend the print job. 

  

Did the job print from the correct tray or on the correct paper? 

The problem is 
solved. 

Go to step 3. 

Step 3 

1. Depending on your operating system, open Printing Preferences or the 
Print dialog, and then specify the paper type. 

2. Resend the print job. 

  

Did the job print from the correct tray or on the correct paper? 

The problem is 
solved. 

Go to step 4. 
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Action Yes No 

Step 4 

1. Check if the trays are not linked. 

2. Resend the print job. 

  

Did the job print from the correct tray or on the correct paper? 

The problem is 
solved. 

Contact technical 
support. 

  

Incorrect characters print 

Action Yes No 

Step 1 

Make sure the printer is not in Hex Trace mode. 

Note: If Ready Hex appears on the printer display, then turn off the 
printer, and then turn it back on to deactivate Hex Trace mode. 

  

Is the printer in Hex Trace mode? 

Deactivate Hex 
Trace mode. 

Go to step 2. 

Step 2 

1. From the printer control panel, select Standard Network, and then set 
SmartSwitch to On. 

2. Resend the print job. 

  

Do incorrect characters print? 

Contact technical 
support. 

The problem is 
solved. 

  

Tray linking does not work 

Note: The trays and the multipurpose feeder do not automatically detect the paper size. You must set the 
size from the Paper Size/Type menu. 



User's Guide 

 
- 180 - 

Action Yes No 

1. From the printer control panel, set the paper size and type in the Paper 
menu to match the paper loaded in the trays to be linked. 

Note: The paper size and type must match for trays to be linked. 

2. Resend the print job. 

  

Do the trays link correctly? 

The problem is 
solved. 

Contact technical 
support. 

  

Large jobs do not collate 

Action Yes No 

Step 1 

1. From the Finishing menu on the printer control panel, set Collate to (1,2,3) 
(1,2,3). 

2. Resend the print job. 

  

Did the job print and collate correctly? 

The problem 
is solved. 

Go to step 2. 

Step 2 

1. From the printer software, set Collate to (1,2,3) (1,2,3). 

Note: Setting Collate to (1,1,1) (2,2,2) in the software overrides the setting 
in the Finishing menu. 

2. Resend the print job. 

  

Did the job print and collate correctly? 

The problem 
is solved. 

Go to step 3. 

Step 3 

Reduce the complexity of the print job by eliminating the number and size of 
fonts, the number and complexity of images, and the number of pages in the 
job. 

  

Did the job print and collate correctly? 

The problem 
is solved. 

Contact 
technical 
support. 
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Unexpected page breaks occur 

Action Yes No 

Step 1 

Adjust the print timeout settings. 

1. From the printer control panel, navigate to: 

Settings >General Settings >Timeouts >Print Timeout 

2. Select a higher setting and then, depending on your printer model, 

select  or Submit. 

3. Resend the print job. 

  

Did the file print correctly? 

The problem is 
solved. 

Go to step 2. 

Step 2 

1. Check the original file for manual page breaks. 

2. Resend the print job. 

  

Did the file print correctly? 

The problem is 
solved. 

Contact technical 
support. 

  



User's Guide 

 
- 182 - 

Print quality problems 

Characters have jagged or uneven edges 

 

Action Yes No 

Step 1 

1. Print a font sample list to check if the fonts you are using are 
supported by the printer. 

a. From the printer control panel, navigate to: 

Menus >Reports >Print Fonts 

b. Select PCL Fonts or PostScript Fonts. 

2. Resend the print job. 

  

Are you using fonts that are supported by the printer? 

Go to step 2. Select a font that is 
supported by the printer. 

Step 2 

Check if the fonts installed on the computer are supported by the 
printer. 

  

Are the fonts installed on the computer supported by the printer? 

The problem is 
solved. 

Contact technical support. 

  

Clipped pages or images 
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Action Yes No 

Step 1 

1. Move the width and length guides in the tray to the correct 
positions for the paper loaded. 

2. Resend the print job. 

  

Is the page or image clipped? 

Go to step 2. The problem is solved. 

Step 2 

From the printer control panel, set the paper size and type in 
the Paper menu to match the paper loaded in the tray. 

  

Do the paper size and type match the paper loaded in the tray? 

Go to step 3. Do one or more of the following: 

• Specify the paper size from 
the tray settings to match the 
paper loaded in the tray. 

• Change the paper loaded in 
the tray to match the paper 
size specified in the tray 
settings. 

Step 3 

1. Depending on your operating system, specify the paper 
size from Printing Preferences or from the Print dialog. 

2. Resend the print job. 

  

Is the page or image clipped? 

Go to step 4. The problem is solved. 

Step 4 

1. Reinstall the imaging unit. 

a. Remove the toner cartridge. 

b. Remove the imaging unit. 

Warning—Potential Damage: Do not expose the 
imaging unit to direct light for more than 10 minutes. 
Extended exposure to light may cause print quality 
problems. 

c. Install the imaging unit, and then the cartridge. 

2. Resend the print job. 

  

Is the page or image clipped? 

Contact 
technical 
support. 

The problem is solved. 
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Shadow images appear on prints 

 

Action Yes No 

Step 1 

Load paper with the correct paper 
type and weight in the tray. 

  

Is paper with the correct paper type 
and weight loaded in the tray? 

Go to step 2. Load paper with the correct paper 
type and weight in the tray. 

Step 2 

From the printer control panel, set 
the paper type and weight in the 
Paper menu to match the paper 
loaded in the tray. 

  

Is the tray set to the type and weight 
of the paper loaded? 

Go to step 3. Change the paper loaded in the tray 
to match the paper type and weight 
specified in the tray settings. 

Step 3 

1. Depending on your operating 
system, specify the paper type 
and weight from Printing 
Preferences or from the Print 
dialog. 

2. Resend the print job. 

  

Do shadow images still appear on 
prints? 

Go to step 4. The problem is solved. 
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Action Yes No 

Step 4 

Replace the imaging unit, and then 
resend the print job. 

  

Do shadow images still appear on 
prints? 

Contact technical support. The problem is solved. 

  

Gray background on prints 

 

Action Yes No 

Step 1 

1. From the Quality Menu on the printer control panel, decrease the toner 
darkness. 

Note: 8 is the factory default setting. 

2. Resend the print job. 

  

Did the gray background disappear from the prints? 

The problem 
is solved. 

Go to step 2. 
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Action Yes No 

Step 2 

Reinstall the imaging unit and the toner cartridge. 

1. Remove the toner cartridge. 

2. Remove the imaging unit. 

Warning—Potential Damage: Do not expose the imaging unit to direct light 
for more than 10 minutes. Extended exposure to light can cause print quality 
problems. 

3. Install the imaging unit, and then the cartridge. 

4. Resend the print job. 

  

Did the gray background disappear from the prints? 

The problem 
is solved. 

Go to step 3. 

Step 3 

Replace the imaging unit, and then resend the print job. 

  

Did the gray background disappear from the prints? 

The problem 
is solved. 

Contact 
technical 
support. 

  

Incorrect margins on prints 

 

Action Yes No 

Step 1 

1. Move the width and length guides in the tray to 
the correct positions for the paper size loaded. 

2. Resend the print job. 

  

Are the margins correct? 

The problem 
is solved. 

Go to step 2. 
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Action Yes No 

Step 2 

From the printer control panel, set the paper size in 
the Paper menu to match the paper loaded in the 
tray. 

  

Does the paper size match the paper loaded in the 
tray? 

Go to step 3. Do one or more of the following: 

• Specify the paper size from the tray 
settings to match the paper loaded in 
the tray. 

• Change the paper loaded in the tray to 
match the paper size specified in the 
tray settings. 

Step 3 

1. Depending on your operating system, specify the 
paper size from Printing Preferences or from the 
Print dialog. 

2. Resend the print job. 

  

Are the margins correct? 

The problem 
is solved. 

Contact technical support. 

  

Paper curl 

Action Yes No 

Step 1 

Move the width and length guides in the tray to the 
correct positions for the size of the paper loaded. 

  

Are the width and length guides positioned correctly? 

Go to step 2. Adjust the width and length guides. 

Step 2 

From the printer control panel, set the paper type and 
weight in the Paper menu to match the paper loaded in 
the tray. 

  

Do the paper type and weight match the type and weight 
of the paper in the tray? 

Go to step 3. Specify the paper type and weight from 
the tray settings to match the paper 
loaded in the tray. 
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Action Yes No 

Step 3 

1. Depending on your operating system, specify the 
paper type and weight from Printing Preferences or 
from the Print dialog. 

2. Resend the print job. 

  

Is the paper still curled? 

Go to step 4. The problem is solved. 

Step 4 

1. Remove the paper from the tray, and then turn it 
over. 

2. Resend the print job. 

  

Is the paper still curled? 

Go to step 5. The problem is solved. 

Step 5 

1. Load paper from a fresh package. 

Note: Paper absorbs moisture due to high humidity. 
Store paper in its original wrapper until you use it. 

2. Resend the print job. 

  

Is the paper still curled? 

Contact 
technical 
support. 

The problem is solved. 

  

Print irregularities 
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Action Yes No 

Step 1 

1. Move the width and length guides in the 
tray to the correct positions for the size 
of the paper loaded in the tray. 

2. Resend the print job. 

  

Do print irregularities still appear? 

Go to step 2. The problem is solved. 

Step 2 

From the printer control panel, set the paper 
size and type in the Paper menu to match 
the paper loaded in the tray. 

  

Do the printer settings match the type and 
weight of the paper loaded in the tray? 

Go to step 3. Specify the paper size and 
type from the tray settings to 
match the paper loaded in the 
tray. 

Step 3 

1. Depending on your operating system, 
specify the paper type and weight from 
Printing Preferences or from the Print 
dialog. 

2. Resend the print job. 

  

Do print irregularities still appear? 

Go to step 4. The problem is solved. 

Step 4 

Check if the paper loaded in the tray has 
texture or rough finishes. 

  

Are you printing on textured or rough paper? 

From the printer control panel, set 
the paper texture in the Paper 
menu to match the paper loaded in 
the tray. 

Go to step 5. 
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Action Yes No 

Step 5 

1. Load paper from a fresh package. 

Note: Paper absorbs moisture due to 
high humidity. Store paper in its original 
wrapper until you use it. 

2. Resend the print job. 

  

Do print irregularities still appear? 

Go to step 6. The problem is solved. 

Step 6 

Replace the imaging unit, and then resend 
the print job. 

  

Do print irregularities still appear? 

Contact technical support. The problem is solved. 

  

Repeating defects appear on prints 
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Action Yes No 

Step 1 

Measure the distance between the 
defects. 

Check for a distance between 
the defects that equals: 

- 97 mm (3.82 in.) 

- 47 mm (1.85 in.) 

- 38 mm (1.5 in.) 

  

Is the distance between defects 
equal to one of the listed 
measurements? 

Go to step 2. 1. Check if the distance between 
the defects equal to 80 mm 
(3.15 in.) 

2. Take note of the distance, and 
then contact technical support. 

Step 2 

Replace the imaging unit, and then 
resend the print job. 

  

Do the repeating defects still 
appear? 

Contact technical support. The problem is solved. 

  

Print is too dark 
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Action Yes No 

Step 1 

1. From the Quality menu on the printer 
control panel, reduce the toner 
darkness. 

Note: 8 is the factory default setting. 

2. Resend the print job. 

  

Is the print still too dark? 

Go to step 2. The problem is solved. 

Step 2 

1. From the printer control panel, set 
the paper type, texture and weight in 
the Paper menu to match the paper 
loaded in the tray. 

2. Resend the print job. 

  

Is the tray set to the type, texture, and 
weight of the paper loaded? 

Go to step 3. Do one or more of the following: 

• Specify the paper type, 
texture, and weight from the 
tray settings to match the 
paper loaded in the tray. 

• Change the paper loaded in 
the tray to match the paper 
type, texture and weight 
specified in the tray settings. 

Step 3 

1. Depending on your operating 
system, specify the paper type, 
texture and weight from Printing 
Preferences or from the Print dialog. 

2. Resend the print job. 

  

Is the print still too dark? 

Go to step 4. The problem is solved. 

Step 4 

Check if the paper loaded in the tray has 
texture or rough finishes. 

  

Are you printing on textured or rough 
paper? 

From the printer control panel, 
change the texture settings in the 
Paper Texture menu to match the 
paper you are printing on. 

Go to step 5. 
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Action Yes No 

Step 5 

1. Load paper from a fresh package. 

Note: Paper absorbs moisture due to 
high humidity. Store paper in its 
original wrapper until you use it. 

2. Resend the print job. 

  

Is the print still too dark? 

Go to step 6. The problem is solved. 

Step 6 

Replace the imaging unit, and then 
resend the print job. 

  

Is the print still too dark? 

Contact technical support. The problem is solved. 

  

Print is too light 

 

Action Yes No 

Step 1 

1. From the Quality menu on the 
printer control panel, increase 
the toner darkness. 

Note: 8 is the factory default 
setting. 

2. Resend the print job. 

  

Is the print still too light? 

Go to step 2. The problem is solved. 
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Action Yes No 

Step 2 

From the printer control panel, set 
the paper type, texture, and weight in 
the Paper menu to match the paper 
loaded in the tray. 

  

Is the tray set to the type, texture, 
and weight of the paper loaded? 

Go to step 3. Change the paper type, texture, and 
weight to match the paper loaded in 
the tray. 

Step 3 

1. Depending on your operating 
system, specify the paper type, 
texture, and weight from Printing 
Preferences or from the Print 
dialog. 

2. Resend the print job. 

  

Is the print still too light? 

Go to step 4. The problem is solved. 

Step 4 

Make sure that the paper has no 
texture or rough finishes. 

  

Are you printing on textured or rough 
paper? 

From the printer control panel, 
change the texture settings in the 
Paper Texture menu to match the 
paper you are printing on. 

Go to step 5. 

Step 5 

1. Load paper from a fresh 
package. 

Note: Paper absorbs moisture 
due to high humidity. Store 
paper in its original wrapper until 
you use it. 

2. Resend the print job. 

  

Is the print still too light? 

Go to step 6. The problem is solved. 
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Action Yes No 

Step 6 

1. Redistribute the toner in the 
imaging unit. 

a. Remove the toner cartridge, 
and then the imaging unit. 

b. Firmly shake the imaging 
unit. 

Warning—Potential 
Damage: Do not expose 
the imaging unit to direct 
light for more than 10 
minutes. Extended 
exposure to light may cause 
print quality problems. 

c. Install the imaging unit, and 
then the cartridge. 

2. Resend the print job. 

  

Is the print still too light? 

Go to step 7. The problem is solved. 

Step 7 

Replace the imaging unit, and then 
resend the print job. 

  

Is the print still too light? 

Contact technical support. The problem is solved. 

  

Printer is printing blank pages 
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Action Yes No 

Step 1 

1. Check if there is packing material left on the imaging unit. 

a. Remove the toner cartridge, and then the imaging unit. 

b. Check if the packing material is properly removed from the imaging unit. 

Warning—Potential Damage: Do not expose the imaging unit to direct 
light for more than 10 minutes. Extended exposure to light may cause 
print quality problems. 

c. Reinstall the imaging unit, and then the cartridge. 

2. Resend the print job. 

  

Is the printer still printing blank pages? 

Go to step 2. The problem 
is solved.  

Step 2 

1. Redistribute the toner in the imaging unit. 

a. Remove the toner cartridge, and then the imaging unit. 

b. Firmly shake the imaging unit. 

Warning—Potential Damage: Do not expose the imaging unit to direct 
light for more than 10 minutes. Extended exposure to light may cause 
print quality problems. 

c. Reinstall the imaging unit, and then the cartridge. 

2. Resend the print job. 

  

Is the printer still printing blank pages? 

Go to step 3. The problem 
is solved. 

Step 3 

Replace the imaging unit, and then resend the print job. 

  

Is the printer still printing blank pages? 

Contact 
technical 
support. 

The problem 
is solved. 
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Skewed print 

 

Action Yes No 

Step 1 

1. Move the width and length guides in the tray to the correct positions 
for the size of the paper loaded. 

2. Resend the print job. 

  

Is the print still skewed? 

Go to step 2. The problem is 
solved. 

Step 2 

1. Check if you are printing on a paper that is supported by the tray. 

2. Resend the print job. 

  

Is the print still skewed? 

Contact technical 
support. 

The problem is 
solved. 

  

Printer is printing solid black pages 
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Action Yes No 

Step 1 

1. Reinstall the imaging unit. 

a. Remove the toner cartridge, and then the imaging unit. 

Warning—Potential Damage: Do not expose the imaging unit to direct 
light for more than 10 minutes. Extended exposure to light may cause 
print quality problems. 

b. Install the imaging unit, and then the cartridge. 

2. Resend the print job. 

  

Is the printer printing solid black pages? 

Go to step 2. The problem 
is solved. 

Step 2 

Replace the imaging unit, and then resend the print job. 

  

Is the printer printing solid black pages? 

Contact 
technical 
support. 

The problem 
is solved. 

  

Transparency print quality is poor 

Action Yes No 

Step 1 

From the printer control panel, set the paper type in the Paper 
menu to match the paper loaded in the tray. 

  

Is the paper type for the tray set to Transparency? 

Go to step 2. Set the paper type to 
Transparency. 

Step 2 

1. Check if you are using a recommended type of transparency. 

2. Resend the print job. 

  

Is the print quality still poor? 

Contact technical 
support. 

The problem is solved. 
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Streaked horizontal lines appear on prints 

 

Action Yes No 

Step 1 

1. Depending on your operating system, specify the tray or feeder 
from Printing Preferences or the Print dialog. 

2. Resend the print job.  

  

Do streaked horizontal lines appear on prints? 

Go to step 2. The problem is solved. 

Step 2 

From the printer control panel, set the paper type and weight in the 
Paper menu to match the paper loaded in the tray. 

  

Do the paper type and weight match the type and weight of the 
paper in the tray? 

Go to step 3. Change the paper type and 
weight to match the paper 
loaded in the tray. 

Step 3 

1. Load paper from a fresh package. 

Note: Paper absorbs moisture due to high humidity. Store paper 
in its original wrapper until you use it. 

2. Resend the print job. 

  

Do streaked horizontal lines appear on prints? 

Go to step 4. The problem is solved. 
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Action Yes No 

Step 4 

1. Reinstall the imaging unit. 

a. Remove the toner cartridge, and then the imaging unit. 

Warning—Potential Damage: Do not expose the imaging 
unit to direct light for more than 10 minutes. Extended 
exposure to light may cause print quality problems. 

b. Install the imaging unit, and then the cartridge. 

2. Resend the print job. 

  

Do streaked horizontal lines appear on prints? 

Go to step 5. The problem is solved. 

Step 5 

Replace the imaging unit, and then resend the print job. 

  

Do streaked horizontal lines appear on prints? 

Contact 
technical 
support. 

The problem is solved. 

  

Streaked vertical lines appear on prints 

 

Action Yes No 

Step 1 

1. Depending on your operating system, specify the paper 
type, texture, and weight from Printing Preferences or 
from the Print dialog. 

2. Resend the print job. 

  

Do streaked vertical lines appear on prints? 

Go to step 2. The problem is solved. 
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Action Yes No 

Step 2 

From the printer control panel, set the paper texture, type, 
and weight in the Paper menu to match the paper loaded in 
the tray. 

  

Do the paper texture, type, and weight match the paper in 
the tray? 

Go to step 3. Do one or more of the following: 

• Specify the paper texture, type, 
and weight from the tray settings 
to match the paper loaded in the 
tray. 

• Change the paper loaded in the 
tray to match the paper texture, 
type, and weight specified in the 
tray settings. 

Step 3 

1. Load paper from a fresh package. 

Note: Paper absorbs moisture due to high humidity. 
Store paper in its original wrapper until you use it. 

2. Resend the print job. 

  

Do streaked vertical lines appear on prints? 

Go to step 4. The problem is solved. 

Step 4 

1. Reinstall the imaging unit. 

a. Remove the toner cartridge, and then the imaging 
unit. 

Warning—Potential Damage: Do not expose the 
imaging unit to direct light for more than 10 
minutes. Extended exposure to light may cause 
print quality problems. 

b. Install the imaging unit, and then the cartridge. 

2. Resend the print job. 

  

Do streaked vertical lines appear on prints? 

Go to step 5. The problem is solved. 

Step 5 

Replace the imaging unit, and then resend the print job. 

  

Do streaked vertical lines appear on prints? 

Contact 
technical 
support. 

The problem is solved. 
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Horizontal voids appear on prints 

 

Action Yes No 

Step 1 

1. Make sure your software program is using a correct fill pattern. 

2. Resend the print job. 

  

Do horizontal voids appear on prints? 

Go to step 2. The problem 
is solved. 

Step 2 

1. Load the specified tray or feeder with a recommended type of paper. 

2. Resend the print job. 

  

Do horizontal voids appear on prints? 

Go to step 3. The problem 
is solved. 

Step 3 

1. Redistribute the toner in the imaging unit. 

a. Remove the toner cartridge, and then the imaging unit. 

b. Firmly shake the imaging unit. 

Warning—Potential Damage: Do not expose the imaging unit to direct 
light for more than 10 minutes. Extended exposure to light may cause 
print quality problems. 

c. Reinstall the imaging unit, and then the cartridge. 

2. Resend the print job. 

  

Do horizontal voids appear on prints? 

Go to step 4. The problem 
is solved. 
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Action Yes No 

Step 4 

Replace the imaging unit, and then resend the print job. 

  

Do horizontal voids appear on prints? 

Contact 
technical 
support. 

The problem 
is solved. 

  

Vertical voids appear on prints 

 

Action Yes No 

Step 1 

1. Make sure your software 
program is using a correct fill 
pattern. 

2. Resend the print job. 

  

Do vertical voids appear on prints? 

Go to step 2. The problem is solved. 

Step 2 

1. From the printer control panel, 
set the paper type and weight in 
the Paper menu to match the 
paper loaded in the tray. 

2. Resend the print job. 

  

Do vertical voids appear on prints? 

Go to step 3. The problem is solved. 
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Action Yes No 

Step 3 

Check if you are using a 
recommended type of paper. 

1. Load the indicated tray or feeder 
with a recommended type of 
paper. 

2. Resend the print job. 

  

Do vertical voids appear on prints? 

Go to step 4. The problem is solved. 

Step 4 

1. Redistribute the toner in the 
imaging unit. 

a. Remove the toner cartridge, 
and then the imaging unit. 

b. Firmly shake the imaging 
unit. 

Warning—Potential 
Damage: Do not expose 
the imaging unit to direct 
light for more than 10 
minutes. Extended 
exposure to light may cause 
print quality problems. 

c. Reinstall the imaging unit, 
and then the cartridge. 

2. Resend the print job. 

  

Do vertical voids appear on prints? 

Contact technical support. 

Note: The laser scanning unit may 
be defective. 

The problem is solved. 

  

Toner specks appear on prints 

Action Yes No 

Replace the imaging unit, and then resend the print job. 

  

Do toner specks appear on prints? 

Contact technical support. The problem is solved. 

  



User's Guide 

 
- 205 - 

Toner fog or background shading appears on prints 

 

Action Yes No 

Step 1 

Reinstall the imaging unit. 

1. Remove, and then install the imaging unit. 

2. Resend the print job. 

  

Does fog or shading appear on prints? 

Go to step 2. The problem is solved. 

Step 2 

Replace the imaging unit, and then resend the print job. 

  

Does fog or shading appear on prints? 

Contact technical support. The problem is solved. 

  

Toner rubs off 
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Action Yes No 

Step 1 

From the Paper menu on the printer 
control panel, check the paper type 
and weight. 

  

Do the paper type and texture match 
the paper loaded in the tray? 

Go to step 2. Specify the paper type and weight 
from the tray settings to match the 
paper loaded in the tray. 

Step 2 

Check if you are printing on paper 
with texture or rough finishes. 

  

Are you printing on textured or rough 
paper? 

From the Paper menu on the printer 
control panel, set the paper texture. 

Contact technical support. 

  

Uneven print density 

 

Action Yes No 

Replace the imaging unit, and then resend the print job. 

  

Is the print density uneven? 

Contact technical support. The problem is solved. 
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Embedded Web Server does not open 

Action Yes No 

Step 1 

1. Turn on the printer. 

2. Open a Web browser, and then type the printer IP address. 

3. Press Enter. 

  

Does the Embedded Web Server open? 

The 
problem is 
solved. 

Go to step 2. 

Step 2 

Make sure the printer IP address is correct. 

1. View the printer IP address: 

- From the TCP/IP section in the Network/Ports menu 

- By printing a network setup page or menu settings page, and then finding 
the TCP/IP section 

Note: An IP address appears as four sets of numbers separated by 
periods, such as 123.123.123.123. 

2. Open a Web browser, and then type the IP address. 

Note: Depending on the network settings, you may need to type “https://” 
instead of “http://” before the printer IP address to access the Embedded 
Web Server. 

3. Press Enter. 

  

Does the Embedded Web Server open? 

The 
problem is 
solved. 

Go to step 3. 
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Action Yes No 

Step 3 

Check if the network is working. 

1. Print a network setup page. 

2. Check the first section of the network setup page and confirm that the status 
is Connected. 

Note: If the status is Not Connected, then the connection may be intermittent, 
or the network cable may be defective. Contact your system support person 
for a solution, and then print another network setup page. 

3. Open a Web browser, and then type the printer IP address. 

4. Press Enter. 

  

Does the Embedded Web Server open? 

The 
problem is 
solved. 

Go to step 4. 

Step 4 

Check if the cable connections to the printer and print server are secure. 

1. Connect the cables properly. For more information, see the setup 
documentation that came with the printer. 

2. Open a Web browser, and then type the printer IP address. 

3. Press Enter. 

  

Does the Embedded Web Server open? 

The 
problem is 
solved. 

Go to step 5. 

Step 5 

Temporarily disable the Web proxy servers. 

Proxy servers may block or restrict you from accessing certain Web sites 
including the Embedded Web Server.  

  

 Does the Embedded Web Server open? 

The 
problem is 
solved. 

Contact your 
system support 
person. 
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Contacting technical support 

When you contact technical support, describe the problem you are experiencing, the message on the 
printer display, and the troubleshooting steps you have already taken to find a solution. 

You need to know your printer model type and serial number. For more information, see the label on the 
inside top front cover or at the back of the printer. The serial number is also listed on the menu settings 
page. 

KONICA MINOLTA Web site at http://www.konicaminolta.com. 

http://www.konicaminolta.com/
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11—Notices 

Copyright notice 

Copyright © 2012 KONICA MINOLTA, INC., JP Tower, 2-7-2 Marunouchi, Chiyoda-ku, Tokyo, 100-7014, 
Japan. All Rights Reserved. This document may not be copied, in whole or part, nor transferred to any 
other media or language, without written permission of  
KONICA MINOLTA, INC.  

Edition notice 

KONICA MINOLTA, INC. reserves the right to make changes to this guide and to the equipment 
described herein without notice. Considerable effort has been made to ensure that this guide is free of 
inaccuracies and omissions.  
However, KONICA MINOLTA, INC. makes no warranty of any kind including, but not limited to, any 
implied warranties of merchantability and fitness for a particular purpose with regard to this guide. 
KONICA MINOLTA, INC. assumes no responsibility for, or liability for, errors contained in this guide or for 
incidental, special, or consequential damages arising out of the furnishing of this guide, or the use of this 
guide in operating the equipment, or in connection with the performance of the equipment when so 
operated. 

Trademarks 

KONICA MINOLTA and the KONICA MINOLTA logo are trademarks or registered trademarks of  
KONICA MINOLTA, INC. 

bizhub and PageScope are trademarks or registered trademarks of  
KONICA MINOLTA, INC. 

Mac and the Mac logo are trademarks of Apple Inc., registered in the U.S. and other countries. 

PCL® is a registered trademark of the Hewlett-Packard Company. PCL is Hewlett-Packard Company’s 
designation of a set of printer commands (language) and functions included in its printer products. This 
printer is intended to be compatible with the PCL language. This means the printer recognizes PCL 
commands used in various application programs, and that the printer emulates the functions 
corresponding to the commands. 

The following terms are trademarks or registered trademarks of these companies: 

Albertus The Monotype Corporation plc 

Antique Olive Monsieur Marcel OLIVE 

Apple-Chancery Apple Computer, Inc. 

Arial The Monotype Corporation plc 
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CG Times Based on Times New Roman under license from The Monotype Corporation plc, is a product 
of Agfa Corporation 

Chicago Apple Computer, Inc. 

Clarendon Linotype-Hell AG and/or its subsidiaries 

Eurostile Nebiolo 

Geneva Apple Computer, Inc. 

GillSans The Monotype Corporation plc 

Helvetica Linotype-Hell AG and/or its subsidiaries 

Hoefler Jonathan Hoefler Type Foundry 

ITC Avant Garde 
Gothic 

International Typeface Corporation 

ITC Bookman International Typeface Corporation 

ITC Mona Lisa International Typeface Corporation 

ITC Zapf Chancery International Typeface Corporation 

Joanna The Monotype Corporation plc 

Marigold Arthur Baker 

Monaco Apple Computer, Inc. 

New York Apple Computer, Inc. 

Oxford Arthur Baker 

Palatino Linotype-Hell AG and/or its subsidiaries 

Stempel Garamond Linotype-Hell AG and/or its subsidiaries 

Taffy Agfa Corporation 

Times New Roman The Monotype Corporation plc 

Univers Linotype-Hell AG and/or its subsidiaries 

  

All other trademarks are the property of their respective owners. 
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Software License Agreement 

This package contains the following materials provided by KONICA MINOLTA, INC. (KM): software 
included as part of the printing system (“Printing Software”), the digitally-encoded machine-readable 
outline data encoded in the special format and in the encrypted form (“Font Programs”), other software 
which runs on a computer system for use in conjunction with the Printing Software (“Host Software”), and 
related explanatory written materials (“Documentation”). The term “Software” shall be used to describe 
Printing Software, Font Programs and/or Host Software and also include any upgrades, modified versions, 
additions, and copies of the Software. 
The Software is being licensed to you under the terms of this Agreement. 
KM grants to you a non-exclusive sublicense to use the Software and Documentation, provided that you 
agree to the following: 

1. You may use the Software and accompanying Font Programs for imaging to the licensed output 
device(s), solely for your own internal business purposes. 

2. In addition to the license for Font Programs set forth in Section 1 above, you may use Roman Font 
Programs to reproduce weights, styles, and versions of letters, numerals, characters and symbols 
(“Typefaces”) on the display or monitor for your own internal business purposes. 

3. You may make one backup copy of the Host Software, provided your backup copy is not installed or 
used on any computer. Not with standing the above restrictions, you may install the Host Software 
on any number of computers solely for use with one or more printing systems running the Printing 
Software. 

4. You may assign its rights under this Agreement to an assignee of all of Licensee’s right and interest 
to such Software and Documentation (“Assignee”) provided you transfer to Assignee all copies of 
such Software and Documentation Assignee agrees to be bound by all of the terms and conditions of 
this Agreement. 

5. You agree not to modify, adapt or translate the Software and Documentation. 

6. You agree that you will not attempt to alter, disassemble, decrypt, reverse engineer or decompile the 
Software. 

7. Title to and ownership of the Software and Documentation and any reproductions thereof shall 
remain with KM and its licensor. 

8. Trademarks shall be used in accordance with accepted trademark practice, including identification of 
the trademark owner’s name. Trademarks can only be used to identify printed output produced by 
the Software. Such use of any trademark does not give you any rights of ownership in that trademark. 

9. You may not rent, lease, sublicense, lend or transfer versions or copies of the Software Licensee 
does not use, or Software contained on any unused media, except as part of the permanent transfer 
of all Software and Documentation as described above. 
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10. IN NO EVENT WILL KM OR ITS LICENSOR BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 
INCIDENTAL INDIRECT, PUNITIVE OR SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS 
OR LOST SAVING, EVEN IF KM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PARTY. KM OR ITS LICENSOR DISCLAIMS 
ALL WARRANTIES WITH REGARD TO THE SOFTWARE, EXPRESS OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS. SOME 
STATES OR JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY 
NOT APPLY TO YOU. 

11. Notice to Government End Users: The Software is a “commercial item,” as that term is defined at 48 
C.F.R.2.101, consisting of “commercial computer software” and “commercial computer software 
documentation,” as such terms are used in 48 C.F.R. 12.212. Consistent with 48 C.F.R. 12.212 and 
48 C.F.R. 227.7202-1 through 227.7202-4, all U.S. Government End Users acquire the Software with 
only those rights set forth herein. 

12. You agree that you will not export the Software in any form in violation of any applicable laws and 
regulations regarding export control of any countries. 

Noise emission levels 

The following measurements were made in accordance with ISO 7779 and reported in conformance with 
ISO 9296. 

Note: Some modes may not apply to your product. 

1-meter average sound pressure, dBA 

Printing (Simplex / Duplex) 55dBA / 54dBA 

Ready 15dBA 
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For EU member states only 

 

This symbol means: Do not dispose of this product together with your household waste! 

Please contact the Local Authority for appropriate disposal instructions. In the case of a new device being purchased, 
the used one can also be given to our dealer for appropriate disposal. Recycling of this product will help to conserve 
natural resources and prevent potential negative consequences for the environment and human health caused by 
inappropriate waste handling. 

 
This product complies with RoHS (2002/95/EC) directive. 

Product disposal 

Do not dispose of the printer or supplies in the same manner as normal household waste. Consult your 
local authorities for disposal and recycling options. 

ENERGY STAR 

 

As an ENERGY STAR® Partner, we have determined that this machine meets the ENERGY STAR 
Guidelines for energy efficiency. 

What is an ENERGY STAR product? 

An ENERGY STAR product has a special feature that allows it to automatically switch to a “low-power 
mode” after a period of inactivity. An ENERGY STAR product uses energy more efficiently, saves you 
money on utility bills and helps protect the environment. 
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Temperature information 

Ambient temperature 15.6 to 32.2°C (60 to 90°F) 

Shipping and storage temperature -20 to 40°C (-4 to 104°F) 

  

Power consumption 

Product power consumption 

The following table documents the power consumption characteristics of the product. 

Note: Some modes may not apply to your product. 

Mode Description Power consumption (Watts) 

Printing The product is generating hard-copy output from electronic 
inputs. 

600 W (bizhub 4000P); 640 W 
(bizhub 4700P) 

Copy The product is generating hard-copy output from hard-copy 
original documents. 

N/A 

Scan The product is scanning hard-copy documents. N/A 

Ready The product is waiting for a print job. 10 W 

Sleep 
Mode 

The product is in a high-level energy-saving mode. 5 W 

Hibernate The product is in a low-level energy-saving mode. 0.5 W  

Off The product is plugged into an electrical outlet, but the power 
switch is turned off. 

0.0 W 

  

The power consumption levels listed in the previous table represent time-averaged measurements. 
Instantaneous power draws may be substantially higher than the average. 
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Sleep Mode 

This product is designed with an energy-saving mode called Sleep Mode. The Sleep Mode saves energy 
by lowering power consumption during extended periods of inactivity. The Sleep Mode is automatically 
engaged after this product is not used for a specified period of time, called the Sleep Mode Timeout. 

Factory default Sleep Mode Timeout for this product (in minutes): 30 min. 

  

By using the configuration menus, the Sleep Mode Timeout can be modified between 1 minute and 120 
minutes. Setting the Sleep Mode Timeout to a low value reduces energy consumption, but may increase 
the response time of the product. Setting the Sleep Mode Timeout to a high value maintains a fast 
response, but uses more energy. 

Hibernate Mode 

This product is designed with an ultra-low power operating mode called Hibernate mode. When operating 
in Hibernate Mode, all other systems and devices are powered down safely. 

The Hibernate mode can be entered in any of the following methods: 

• Using the Hibernate Timeout 

• Using the Schedule Power modes 

• Using the Sleep/Hibernate button 

Factory default Hibernate Timeout for this product in all countries or regions except for EU countries and 
Switzerland 

Disabled 

Factory default value for this product in EU countries or regions and Switzerland 3 days 

  

The amount of time the printer waits after a job is printed before it enters Hibernate mode can be modified 
between one hour and one month. 

Off mode 

If this product has an off mode which still consumes a small amount of power, then to completely stop 
product power consumption, disconnect the power supply cord from the electrical outlet. 

Total energy usage 

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are 
provided in power units of Watts, the power consumption should be multiplied by the time the product 
spends in each mode in order to calculate energy usage. The total product energy usage is the sum of 
each mode's energy usage. 


	Contents
	1—Safety information
	2—Learning about the printer
	Finding information about the printer
	Selecting a location for the printer

	3—Additional printer setup
	Installing internal options
	Available internal options
	Accessing the controller board
	Installing an optional card
	Installing a memory card

	Installing hardware options
	Installing optional trays

	Setting up the printer software
	Installing the printer driver

	Networking
	Preparing to set up the printer on an Ethernet network
	Installing the printer on an Ethernet network
	Preparing to set up the printer on a wireless network
	Connecting the printer to a wireless network using the Wi-Fi Protected Setup
	Connecting the printer to a wireless network using the Embedded Web Server
	Verifying printer setup


	4—Using bizhub 4000P/4700P
	Learning about the printer
	Printer configurations
	Using the printer control panel
	Understanding the colors of the indicator and Sleep button lights
	Attaching cables
	Accessing the controller board

	Loading paper and specialty media
	Setting the paper size and type
	Configuring Universal paper settings
	Using the standard bin and paper stop
	bizhub 4000P Loading trays
	bizhub 4700P Loading trays
	Loading the multipurpose feeder
	Linking and unlinking trays

	Printing
	Printing a document
	Printing from a flash drive (For bizhub 4700P only)
	Printing confidential and other held jobs
	Printing information pages
	Canceling a print job

	Managing the printer
	Finding advanced networking and administrator information
	Checking the virtual display
	Configuring supply notifications from the Embedded Web Server
	Modifying confidential print settings
	Copying printer settings to other printers
	Creating a printer control panel PIN
	Printing a menu settings page
	Printing a network setup page
	Checking the status of parts and supplies
	Saving energy
	Restoring factory default settings
	Securing the printer


	5—Paper and specialty media guide
	Using specialty media
	Tips on using card stock
	Tips on using envelopes
	Tips on using labels
	Tips on using letterhead
	Tips on using transparencies

	Paper guidelines
	Paper characteristics
	Unacceptable paper
	Selecting paper
	Selecting preprinted forms and letterhead
	Storing paper

	Supported paper sizes, types, and weights
	Supported paper sizes
	Supported paper types and weights


	6—Understanding the printer menus
	Menus list
	Paper menu
	Default Source menu
	Paper Size/Type menu
	Configure MP menu
	Substitute Size menu
	Paper Texture menu
	Paper Weight menu
	Paper Loading menu
	Custom Types menu
	Universal Setup menu

	Reports menu
	Reports menu

	Network/Ports menu
	Active NIC menu
	Standard Network menus
	Reports menu
	IPv6 menu
	Wireless menu
	AppleTalk menu
	Standard USB menu
	SMTP Setup menu

	Security menu
	Confidential Print menu
	Security Audit Log menu
	Set Date and Time menu

	Settings menu
	General Settings
	Flash Drive (For bizhub 4700P only)
	Print Settings


	7—Saving the environment
	Saving paper and toner
	Using recycled paper
	Conserving supplies


	8—Maintaining the printer
	Cleaning the printer
	Cleaning the printer

	Ordering parts and supplies
	Using genuine KONICA MINOLTA parts and supplies
	Ordering toner cartridges
	Ordering an imaging unit

	Estimated number of remaining pages
	Storing supplies
	Replacing supplies
	Replacing the toner cartridge
	Replacing the imaging unit

	Moving the printer
	Before moving the printer
	Moving the printer to another location
	Shipping the printer


	9—Clearing jams
	Avoiding jams
	Understanding jam messages and locations
	[x]-page jam, open front door. [20y.xx]
	[x]-page jam, open rear door. [20y.xx]
	[x]-page jam, clear standard bin. [20y.xx]
	[x]-page jam, remove tray 1 to clear duplex. [23y.xx]
	[x]-page jam, open tray [x]. [24y.xx]
	[x]-page jam, clear manual feeder. [25y.xx]

	10—Troubleshooting
	Understanding the printer messages
	Cartridge, imaging unit mismatch [41.xy]
	Cartridge low [88.xy]
	Cartridge nearly low [88.xy]
	Cartridge very low, [x] estimated pages remain [88.xy]
	Change [paper source] to [custom type name] load [orientation]
	Change [paper source] to [custom string] load [paper orientation]
	Change [paper source] to [paper size] load [orientation]
	Change [paper source] to [paper type] [paper size] load [orientation]
	Close front door
	Complex page, some data may not have printed [39]
	Configuration change, some held jobs were not restored [57]
	Defective flash detected [51]
	Error reading USB drive. Remove USB.
	Error reading USB hub. Remove hub.
	Imaging unit low [84.xy]
	Imaging unit nearly low [84.xy]
	Imaging unit very low, [x] estimated pages remain [84.xy]
	Incorrect paper size, open [paper source] [34]
	Insert Tray [x]
	Insufficient memory to support Resource Save feature [35]
	Insufficient memory to collate job [37]
	Insufficient memory for Flash Memory Defragment operation [37]
	Insufficient memory, some Held Jobs were deleted [37]
	Insufficient memory, some held jobs will not be restored [37]
	Load [paper source] with [custom string] [paper orientation]
	Load [paper source] with [custom type name] [paper orientation]
	Load [paper source] with [paper size] [paper orientation]
	Load [paper source] with [paper type] [paper size] [paper orientation]
	Load manual feeder with [custom type name] [paper orientation]
	Load manual feeder with [custom string] [paper orientation]
	Load manual feeder with [paper size] [paper orientation]
	Load manual feeder with [paper type] [paper size] [paper orientation]
	Maintenance kit low [80.xy]
	Maintenance kit nearly low [80.xy]
	Maintenance kit very low, [x] estimated pages remain [80.xy]
	Memory full [38]
	Network [x] software error [54]
	Non-Printer Manufacturer [supply type], see User’s Guide [33.xy]
	Not enough free space in flash memory for resources [52]
	Printer had to restart. Last job may be incomplete.
	Reinstall missing or unresponsive cartridge [31.xy]
	Reinstall missing or unresponsive imaging unit [31.xy]
	Remove paper from standard output bin
	Replace cartridge, 0 estimated pages remain [88.xy]
	Replace cartridge, printer region mismatch [42.xy]
	Replace imaging unit, 0 estimated pages remain [84.xy]
	Replace maintenance kit, 0 estimated pages remain [80.xy]
	Replace unsupported cartridge [32.xy]
	Replace unsupported imaging unit [32.xy]
	Serial option [x] error [54]
	SMTP server not set up. Contact system administrator.
	Standard network software error [54]
	Standard USB port disabled [56]
	Too many flash options installed [58]
	Too many trays attached [58]
	Unformatted flash detected [53]
	Unsupported option in slot [x] [55]
	Weblink server not set up. Contact system administrator.

	Solving printer problems
	Basic printer problems
	Option problems
	Paper feed problems

	Solving print problems
	Printing problems
	Print quality problems

	Embedded Web Server does not open
	Contacting technical support

	11—Notices
	Copyright notice
	Edition notice
	Trademarks
	Software License Agreement
	Noise emission levels
	For EU member states only
	Product disposal
	ENERGY STAR
	What is an ENERGY STAR product?

	Temperature information
	Power consumption
	Product power consumption
	Sleep Mode
	Hibernate Mode
	Off mode
	Total energy usage



